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1 Introduction
1 Introduction

1.1 About this operating manual

This operating manual will help you to operate your CyFlow® Cube device. 
Emphasis is placed on the installation, start-up and safe operation of the 
device.

The basic principles of flow cytometry can be found in the medical literature 
(e.g. Howard M. Shapiro, Practical Flow Cytometry, Wiley 2003).

This operating manual comes with the device. Read this operating manual 
thoroughly before using the device. Please keep this operating manual for 
future reference.

This operating manual is divided in two parts. The first part, chapter 1–11, 
gives the user all necessary information for safe handling, scope of delivery, 
to set up the device and how to operate the device properly. The general use 
of the software and the typical workflows are described in chapter 6.5. This 
chapter also is suitable to get to know the functioning of your device.

In the second part, chapter 12, you will find a description of all software 
functions and a detailed description of the user interface. This chapter is for 
reference. 

There are product data sheets for the reagent kits and application notes 
available. Please also refer to these documents.

If you have any questions about the content of this operating manual or the 
use of the device, contact your local Sysmex representative.
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1 Introduction
1.2 Typographical conventions

In this operating manual, warnings are indicated by a signal word. Hazards 
are categorised into hazard levels with consequences of differing severity.

Type of hazard
This will result in death or have a serious impact on health.

 Information about avoiding the hazard.

Type of hazard
This could result in death or have a serious impact on health.

 Information about avoiding the hazard.

Type of hazard
This may have a minor impact on health.

 Information about avoiding the hazard.

Type of hazard
This could result in material damage.

 Information about avoiding the hazard.

All warnings are structured according to the same model. The type of hazard 
is stated after the signal word. Then the consequences that may result from 
the hazardous situation are described. And finally, how the hazardous 
situation can be avoided.
CyFlow® Cube 8 | Operating Manual | May 2018 | Revision 032 7



1 Introduction
1.3 General conditions

Ensure that the following conditions are met when working with the device:

 This operating manual must be read prior to using the device.

 Report any recurring faults or problems to your local Sysmex 
representative.

Sysmex Partec GmbH does not accept liability for any damage or personal 
injury arising from:

 Modifications or manipulation of the device;

 Improper use;

 Use of non-approved accessories;

 Improper handling;

 Non-compliance with this operating manual.

1.4 CE compliance

The device is marked with a CE mark of conformity, which confirms the 
compliance with the essential requirements of the following European 
Directives:

  2014/35/EC on electrical equipment designed for use within certain 
voltage limits;

 2014/30/EC on electromagnetic compatibility;

 2011/65/EC on the restriction of the use of certain hazardous substances 
in electrical and electronic equipment.

1.5
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2 Safety
2 Safety

2.1 Intended use

For Research Use Only. Not for use in diagnostic procedures.
The device is a flow cytometer, it offers automation for routine use and 
flexibility for research use in the field of flow cytometric applications.

The applications cover:

 Multi-colour analysis of immune cells for research purposes;

 Leukocyte counting/rare event analysis for research purposes;

 Microbiological analysis;

 Fermentation control;

 Bead-based assays for research purposes;

 Particle and cell concentration analysis based on True Volumetric 
Absolute Counting;

 Particle size and fluorescence distribution analysis.

2.2 Prohibited use

Never use the device with organic solvents as this can destroy the fluidic 
system. Only use particles with a diameter < 100 µm. Only use Sysmex 
approved fluids for sheath, cleaning and decontamination.

Never for use in diagnostic procedures.

2.3 Reasonably foreseeable misuse

Only use this device as a sensitive measuring device. It should:

 NOT be used as personal computer.

 NOT be used with chemicals harmful to the device (household sanitisers 
etc.).
CyFlow® Cube 8 | Operating Manual | May 2018 | Revision 032 9



2 Safety
2.4 User definition

The device may only be used by personnel properly instructed in its 
handling. The manufacturer, authorised distributor or a person authorised by 
the operator (and trained by either the manufacturer or an authorised 
distributor) must provide instruction in handling the device with the help of 
this operating manual.

The device is aimed for a large spectrum of users, from beginners to 
experts. In the best case an expert is around – so, if you are a beginner, let 
her/him help you.

Access to the device is not permitted to insufficiently qualified personnel.

2.4.1 User qualification groups

Instructed personnel
Instructed personnel have to be trained by qualified personnel or personnel 
authorised by Sysmex to operate the device within the scope of the intended 
use. They have to be able to assess if the device can be safely used and are 
proficient in handling hazardous substances.

Qualified personnel
Qualified personnel have in-depth knowledge of the device and the 
applications. They have been trained by personnel authorised by Sysmex to 
operate the device, to perform cleaning and certain maintenance operations. 
Qualified personnel have a scientific or technical education and several 
years of experience in flow cytometry and are proficient in handling 
hazardous substances.

Authorised service personnel
Personnel conducting technical service must be authorised by Sysmex. 
Please contact the service department of your local Sysmex representative.
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2 Safety
2.4.2 User qualification table

× = activity can be performed by the user

¹ = please refer to the maintenance table for detailed instructions (see 
chapter 9 Maintenance on page 44).

2.5 Environmental conditions

The device may only be used in laboratories. The specified ambient 
temperature and relative humidity conditions must be maintained at all times.

The laboratory environment must be clean. Direct sun light should be 
avoided.

 Relative humidity: between 20 % and 85 %, non-condensing.

Activity Instructed 
personnel

Qualified 
personnel

Authorised 
service 

personnel
Transport × ×
Installation ×
Operation × × ×
Cleaning × × ×
Decontamination × ×
Maintenance ×¹ ×¹ ×
Technical service ×
Uninstalling × ×
Packing × ×
Disposal × ×

CyFlow® Cube 8 
Configuration

Operating temperature range

V1, V2, V4, V5, V6, 
V7, V8, V9, V10, 
V11

15 °C to 30 °C

N1 15 °C to 30 °C
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2 Safety
2.6 Prohibition and warning signs on the device

The following prohibition and warning signs have been affixed to the device.

2.7 Personal protective equipment

The following personal protective equipment is recommended to operate the 
device.

Warning sticker Meaning

Laser radiation

Electrical hazards
Beware of electrical currents and electrical shocks

Additional laser labelling

Gloves must be worn at all times.

Lab coat must be worn at all times.
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2 Safety
2.8 Laser safety

The device is equipped with a class IIIb laser unit. If the housing of the 
device is closed, the laser class of the laser unit is classified as a laser 
class I (EN 60825-1:2015). 

Never open the housing of the device.

Laser light of laser class IIIb can be emitted if the housing of the device is 
damaged or the laser protection is removed. Serious injuries of the eyes and 
the skin are the results of emission of laser light of laser class IIIb.

2.9 Electrical safety

The main electrical source used must be grounded or earthed due to local 
specifications.

Please place the device in such a way that the electrical power cord can 
easily be unplugged. Removable power cords should not be replaced by 
inadequate wiring.

Beware of possible voltage when changing the fuse (T 4.0 A 250 V).

2.10 Alterations to the device

Unauthorised alterations to the device can result in risks and hazards. 
Therefore, unless expressly permitted by the manufacturer, no alterations 
may be made to the device.

If the device is altered, appropriate tests and trials must be performed to 
ensure the continued safe use of the device.

2.11
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3 Overview
3 Overview
Your CyFlow® Cube device is a fully equipped desktop Flow Cytometer 
(FCM). Which features a modular optical concept. This allows different 
lasers with different  wavelength ranges  be used as light sources and the 
detection of up to 8 optical channels (parameters).

The device allows the optics to be optimised for any application simply by 
exchanging optical filters and mirrors. The device runs with an internal PC. 
Data acquisition, device control, and data analysis are controlled and 
performed by the software.

Fig. 3.1 Front and left side of the device

1 On switch
2 Sample port
3 Ports for external devices

4 Sliding compartment
5 Display

5

1

2

3

4
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3 Overview
Fig. 3.2 Ports for external devices

Fig. 3.3 Rear side of the device

1 USB port
2 HDMI port
3 VGA port
4 Ethernet port
5 USB port
6 Ethernet port
7 Audio port
8 Audio port

9 USB port
10 USB port
11 USB port
12 DVI port
13 USB port
14 Keyboard port
15 Mouse port

1 Fuse insert (T 4.0 A 250 V)
2 Power switch
3 Connector socket for the power cord

15 7

1 3

1213 91011

2 4 5 6

814

2

1

3
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3 Overview
Fig. 3.4 Sample port at the right side of the device

1 Start electrode
2 Stop electrode
3 Sample tube

4 Sample holder
5 Sample port injection needle

5
1
2

4

3
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3 Overview
3.1 Components of the device

The device contains the flow cuvette, the optics, the fluidics, the computer 
unit and data acquisition electronics. No work steps inside the device are 
necessary.

The main components of the device are:

Control elements
The device is operated via keyboard and mouse. The On switch is located 
on the top, when the display of the device is lifted up. The power switch is 
located on the rear side of the device.

Computer interface ports
The computer interface ports connect the device with additional optional 
electronic devices. They are located on the left side of the device.

Sheath fluid bottle and waste bottle
The sheath fluid transports the sample flow during the measurement.

The connecting ports for the tubings of the sheath fluid bottle and waste 
bottle are located inside the device. The tubings are preinstalled. The sheath 
fluid bottle and waste bottle are located in the sliding compartment at the 
rear side of the device.

Sample port with electrodes
The sample port is located on the right side of the device.

The sample port holds the sample tube during the measurement. The start 
and stop electrodes of the sample port allow the independent determination 
of exact 200 μL volume for each sample. The method of True Volumetric 
Absolute Counting (TVAC) supported by CyFlow® Cube systems is based on 
the precise measurement of a fixed sample volume.
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3 Overview
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3.2 Type plate

The type plate is attached to the rear side of the device.

The content of the type plate varies according to the system configuration. 
The system configuration is represented by an addition to the REF number 
(e.g. CY-S-3068R_N1).

The following signs are part of the type plate which has been affixed to the device.

Symbol Meaning

For Research Use Only

Manufacturer

Certification mark

Reference Number

Serial Number

Manufacturing date

Waste of Electrical and Electronic Equipment

Operating manual

Indicates the temperature limits to which the device can be 
safely exposed

No direct sunlight at the installation location

Indicates the range of relative humidity to which the device 
can be safely exposed

Caution

RUO



3 Overview
3.3 Scope of delivery

Fig. 3.5 Scope of operation

The scope of delivery includes:

 1 CyFlow® Cube device;

 1 Power cord;

 1 Software dongle;

 1 Operating manual;

 1 Laboratory bottle, 1 litre, labeled with sheath;

 1 Laboratory bottle, 1 litre, labeled with waste;

1 CyFlow® Cube device
2 Keyboard and mouse

3 Waste bottle
4 Sheath fluid bottle with inline filter for 

sheath fluid

2

1

4 3
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3 Overview
 1 Blue cap with electrodes, cabling and tubing for sheath including inline 
filter;

 1 Red cap with electrodes, cabling and tubing for waste.

The scope of operation includes:

 1 CyFlow® Cube device;

 1 Power cord;

 1 Software dongle;

 1 Operating manual;

 1 Keyboard and 1 mouse;

 1 Laboratory bottle, 1 liter, labeled with sheath;

 1 Laboratory bottle, 1 liter, labeled with waste;

 1 Blue cap with electrodes, cabling and tubing for sheath;

 1 Red cap with electrodes, cabling and tubing for waste.
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3 Overview
3.4 Accessories and spare parts

Additional available application accessories and spare parts:

Additional available upgrades:

 CyFlow® Robby 8 Autoloading Station

 CyFlow® Sorter for CyFlow® Cube

Visit our website http://www.sysmex-partec.com or contact your local 
Sysmex representative for further information about our products.

3.5

Product name Content Order No.
Sheath fluid 5000 ml 04-4007_R
Sheath fluid tap 1 piece 04-4006
Cleaning solution 250 ml 04-4009_R
Decontamination 
solution

250 ml 04-4010_R

Hypochlorite solution 250 ml 04-4012_R
Count Check Beads 
(low, medium, high)

50 tests 05-4010

Calibration Beads 1 µm 
Concentrate

1 ml 05-4007

Calibration Beads 
3 µm, ready-to-use

30 ml 05-4018

DNA Control PI 25 ml 05-7303
DNA Control UV 25 ml 05-7302
Sheath fluid bottle 1l 1000 ml empty bottle 04-200-1041
Waste bottle 1l 1000 ml empty bottle 04-200-1042
Cap for 1 l glass 
sheath fluid bottle

1 piece 04-200-1056

Cap for 1 l glass 
waste bottle

1 piece 04-200-1057

Sample tube 3.5 ml 500 pieces 04-2000
Keyboard 1 piece 06-500-1040
Mouse 1 piece 06-500-1041
Spare fuses T 4,0 A 5 pieces 06-7-8006
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4 Transport and storage
4 Transport and storage

Warning! The weight of the device is about 40 kg.

Always have at least two people carry or lift the device.

In order to transport the device to a different location all external data and 
supply connections have to be disconnected.

The device should be carried in an upright position.

The device is supplied in packaging that protects it against damage and 
contamination. Please retain the packaging. Place the device in the 
packaging for transport and storage.

The storage environment must be dry, clean and dust-free:

 Storage temperature: between 5 °C and 50 °C;

 Relative humidity: between 20 % and 85 %, non-condensing.

4.1
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5 Installation
5 Installation

5.1 Positioning the device

Heavy weight
When moving the device (packed or unpacked) or removing it from its 
packaging, a person is exposed to a high risk of damaging his or her body 
due to the heavy weight of the device.

 At least two persons are required for transport and installation.

Carefully select the place where to position and operate the device. Comply 
with the following criteria when positioning the device:

 Place the device on a solid, dry and clean horizontal surface.

 Avoid smoke, dust, vibrations, direct sunlight and any source of direct 
heat.

 Leave a minimum distance of 15 cm between the back of the device and 
a wall to keep the ventilation effective.

 Do not block the ventilation grid at the back of the device.

 Do not place any objects on the device.

5.2 Installation and uninstallation

Installation, connection, disconnection and uninstallation may only be 
performed by authorised service personnel and in conformity with the 
applicable national rules and regulations.

5.3
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6 Operation
6 Operation
Due to heavy use of software-related content in the following chapter please 
also refer to chapter 12 Software description on page 50.

6.1 Inserting the Software dongle

Procedure
1. Insert the included Software dongle into an open USB port of the device.

Result
 The software will check automatically in regular intervals if the dongle is 

plugged in. If the dongle is not plugged in, the software will not be 
functional.

6.2 Start-up procedure

Old sheath fluid
Old sheath fluid affects the sample flow through the flow cuvette.

 Replace the sheath fluid at least once a week or before any daily use.

6.2.1 Switching on the device

Before switching on the device make sure the sheath fluid bottle is filled with 
800 ml of clean, filtered and degassed sheath fluid and is closed with the 
blue screw cap. It is recommended to replace the sheath fluid at least once a 
week or before any daily use.

Requirements
 The sheath fluid bottle is filled and connected to the device.

 The waste bottle is empty and connected to the device.

Procedure
1. Switch on the device using the power switch on the rear side of the 

device.

2. Lift up the display of the device.

3. Push the On switch on the top of the device.

– The device is switched on.
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6 Operation
4. Start the software by double click the CyFlow® Software icon.

– The log-in dialogue is displayed.

– The device is, by default, set in a standard mode.

6.2.2 Logging in and logging out

Each user is assigned to a user role. Each user role has specific privileges. 
Some functions of the software are not available for each user role and 
availability depends on the assigned privileges.

User management

Logging in

Requirements
 The log-in dialogue is displayed.

 User access must be set up and the user name and password must be 
known to log into the software.

Procedure
1. Enter the user name.

2. Enter the password.

3. Click the Log-in button.

– The log-in dialogue closes.

– The user role dialogue will be displayed.

Role Privileges
Service operator User administration

Worklist creation
Worklist management
Sample analysis
Manage Workspace and settings
Create comp setup

User administrator User administration
Parameter properties

Assay developer Manage Workspace and settings
Worklist creation
Worklist management
Sample analysis
Create comp setup
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6 Operation
4. Select the respective user role.

5. Click the OK button.

– If the log-in was successful the start screen is displayed.

After a specified number of unsuccessful login attempts (default 3), the 
account will be locked. If the account is locked, please contact a user with 
the "user administration" privilege in its user role, e. g. a user administrator.

The default settings for logins can be changed in the user management.

Logging out

Procedure
1. On the File tab of the Ribbon (see chapter 12.4.1 File tab on page 58) 

click the Log-out button.

– The current user is logged out.

– The log-in dialogue is displayed. 

6.2.3 Performing a Prime

A Prime mode is available as a start-up process for the device. This process 
includes cleaning, filling the tubes with sheath fluid and controlling the device 
set-up.

The Prime should be performed in the following cases:

 Starting the device for the first time of the day,

 After the sheath fluid bottle has been filled,

 As a trouble-shooting procedure (no/bad signals, blocking, etc.).

Requirements
 Sample tube with 1.6 ml Decontamination Solution (Order No. 

04-4010_R) connected.

Procedure
1. On the Cytometer tab of the Ribbon (see chapter 12.4.10 Cytometer tab 

on page 105) or on the Acquire pane (see chapter 12.5.4 Acquire pane 
on page 140) click the Prime button.

– The instruction dialogue for the Prime procedure is displayed.

2. Follow the instructions until the finish message is displayed. 

– The device is ready for the sample measurements.

3. Remove emptied sample tube.
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6 Operation
6.3 Performing a measurement

Requirements
 The device is primed.

 The respective Worklist is loaded.

 A Worklist item is active with a defined Workspace.

 The Worklist contains at least one defined item that does not contain a 
listmode file.

 The sample is prepared for the measurement.

 The sheath fluid is not low.

 The waste level is not high.

Procedure
1. Fill the sample tube with the sample fluid.

2. Insert the sample tube into the sample port of the device until the sample 
tube audibly clicks.

3. On the Acquire pane (see chapter 12.5.4 Acquire pane on page 140) 
click the Start button.

– Data acquisition starts. Progress is displayed in the status bar.

4. If a stop condition is set, wait until acquisition stops. 

If no stop condition is set, click the Stop button on the Acquire pane to 
stop acquisition.

– A measurement is performed.

5. Remove emptied sample tube.
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6 Operation
6.4 Performing an intermediate cleaning

A cleaning mode is available to clean the device when a different sample 
type is to be measured.

Requirements
 Log-in as a user with the respective role.

 The respective Worklist is loaded.

 Sample tube with 1.6 ml Cleaning Solution (Order No. 04-4009_R) 
connected.

Procedure
1. On the Cytometer tab of the Ribbon (see chapter 12.4.10 Cytometer tab 

on page 105) click the Clean button.

– An instruction dialogue is displayed.

2. Follow the instructions until the finish message is displayed.

– An intermediate cleaning was performed.

– The device is ready for the next sample measurement.
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6 Operation
6.5 Shutdown procedure

6.5.1 Cleaning for shutdown

Perform the shutdown cleaning procedure to close the software.

Requirements
 No acquisition is in progress.

 Sample tube with 1.6 ml Decontamination Solution (Order No. 
04-4010_R) connected.

Procedure
1. On the File tab of the Ribbon (see chapter 12.4.1 File tab on page 58) 

click the Exit CyFlow Software button.

– If the Worklist or Playlist is currently open and has been modified, a 
save changes dialogue appears.

– A dialogue asking for a shutdown cleaning procedure appears.

2. Select Yes in the dialogue.

– The dialogue closes and initiates the shutdown cleaning procedure. 

– After the cleaning procedure is complete the software closes.

3. Remove emptied sample tube.

6.5.2 Switching off the device

Requirements
 The shutdown cleaning procedure was successful and the software is 

closed.

Procedure
1. In the Windows menu, click the Shut down button.

– The device shuts down.

2. Switch off the device using the power switch on the rear side of the 
device.

– The device is switched off.
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6 Operation
6.6 Software operation

The software can be run in two different modes:

 In Worklist mode, data can be acquired. The hardware and software 
settings for each measurement are predefined and organised in a list 
called Worklist.

 In Playlist mode, acquired data can be analysed and settings for future 
measurements can be prepared. Files are organised and edited in a 
Playlist.

This chapter describes how to use a Worklist for preparing sample 
measurements and how to use a Playlist to analyse data. For a detailed 
description of software functions, see chapter 12 Software description on 
page 50.

6.6.1 Preparing measurements using the Worklist

This chapter describes the typical sequence of steps when preparing a 
Worklist for future measurements.

A Worklist contains the predefinitions of hardware and software settings for 
data acquisition (see chapter 12.6 Worklist pane on page 146). These 
predefinitions are set prior to measurements when preparing the Worklist.

Preparing the Worklist includes:

 Defining the Workspace that contains the plots, regions and gates to 
represent the cell populations of interest;

 Defining and adapting the instrument settings to reduce background and 
to position the populations of interest properly into the plots;

 Performing a manual compensation to compensate for fluorescence 
spillover as appropriate.

These settings can be preset prior to acquiring data and adapted while 
measuring samples.
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Creating a new Worklist

Requirements
 To create a Worklist for future measurements, login as an assay 

developer is necessary.

Procedure
1. On the File tab of the Ribbon (see chapter 12.4.1 File tab on page 58) 

select "File > New > New Worklist".

In Worklist mode, a new Worklist can also be created by clicking the New 
button in the Worklist pane (see chapter 12.6 Worklist pane on 
page 146).

– A new default Worklist containing 400 blank Worklist items is created 
and displayed in the Worklist pane.

– The software is in Worklist mode.

Defining a new Workspace
A Workspace contains the plots, regions and gates of interest (see chapter 
12.8 Workspace on page 160). To prepare a new measurement, a 
Workspace can be prepared before acquiring data and further adapted while 
measuring a sample.

Procedure
1. Double-click a Worklist item to open it in the Workspace.

2. In the Worklist, enter a Lab # and sample ID for the Worklist item as 
desired.

3. Define which plots to be displayed in the Plots area of the Workspace:

On the Home tab of the Ribbon (see chapter 12.4.2 Home tab on 
page 65), click the Density Plot button or the Histogram Plot button to 
add a corresponding plot to the Workspace.

Alternatively, select the desired plots by double-clicking on the plots in 
the Previews area of the Workspace.

4. To change the parameter for an axis of a plot, right-click on the axis and 
select the parameter from the drop-down list.

Alternatively, select the parameter from the Parameters group of the 
Home tab of the Ribbon (see chapter Parameters group on page 66).

5. To change the scaling of the axes, select a plot, then select the scaling 
(linear or logarithmic) on the Parameters group of the Home tab.

6. To change the plot title, double-click the current plot title and enter a new 
title.

– A new Workspace is defined.
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Presetting instrument settings

Procedure
1. Select the Settings pane (see chapter 12.5.3 Settings pane on 

page 139).

2. To select a parameter as trigger parameter, set a parameter to "ON" in 
the "Logic" column (only available if all other parameters are set to 
"OFF").

Data of this parameter are acquired.

If desired, combine other parameters for trigger by setting them to "AND" 
or "OR".

3. To predefine threshold values, enter a value in the "Threshold" column 
for the relevant parameters.

4. To predefine the signal intensity to be displayed for each parameter, 
enter a value in the "Voltage" column for the relevant parameters.

5. Select the Acquire pane (see chapter 12.5.4 Acquire pane on page 140).

6. Select the flow rate for the measurement by clicking the Low, Medium or 
High button or by using the flow rate slider.

– The selected flow rate is displayed next to the flow rate slider.

– The instrument settings are preset.

Starting measurement of the sample

Requirements
 The device is primed.

 A Worklist item is active with a defined Workspace.

Procedure
1. Insert the sample tube containing the sample into the sample port of the 

device until the sample tube audibly clicks.

2. On the Acquire pane (see chapter 12.5.4 Acquire pane on page 140) 
click the Start button.

To refresh the view, click the Restart button on the Acquire pane.

– Data acquisition starts. Progress is displayed in the status bar.

– In the Plots tab of the Workspace (see chapter 12.8.1 Plots tab of the 
Workspace on page 160) the plots display the acquired data. 
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Adapting instrument settings during data acquisition

Procedure
1. Select the Settings pane (see chapter 12.5.3 Settings pane on 

page 139).

2. In the "Voltage" column, adapt the voltage until the desired cell 
populations are displayed in the proper range in the plots and can be 
clearly separated.

When measuring an unstained control, edit the values for all 
fluorescence parameters until the auto-fluorescence signals display 
within the first/between the first and second decade of log scale.

3. In the "Threshold" column, adapt the threshold values to reduce 
background for each parameter triggered. Increase or decrease the 
threshold settings if the background is still too high or if the cell 
population of interest is cut off.

– The instrument settings are adapted.

– The plots will automatically refresh according to the new instrument 
settings.

Creating a region
To select the events of interest, regions can be created on the plots.

Procedure
1. Select the Home tab of the Ribbon (see chapter 12.4.2 Home tab on 

page 65).

2. To preselect creating an elliptical region, a rectangular region, a 
polygonal region, a linear region or a quadrant region, click the 
corresponding button on the Region group (see chapter 12.4.2 Home tab 
on page 65).

– The button is highlighted in orange.

3. For elliptical, rectangular or linear regions (on single-parameter plots), 
draw out the region on the plot.

For a polygonal region, click on a plot to determine the first point of the 
region, then click to define additional points. Complete the polygon by 
clicking on the start point or by right-clicking.

For a quadrant region, click on the plot at the point you wish the 
quadrant’s intercept point to appear.

4. To assign a name to the region, select the region and double-click the 
region name on the plot. Enter a region name in the edit field or select a 
name from the drop-down list.

Alternatively, select the region, select the Region Format tab of the 
Ribbon (see chapter 12.4.15 Region Format tab on page 128) and use 
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the "Region Name" box to enter a name or to select a name from the 
drop-down list.

– A region is created.

Setting a parent gate
A region that contains all events of interest can be applied as a parent gate 
to the other plots so that only the relevant events are displayed on these 
plots. This gating will allow to focus on a subpopulation of cells only.

Procedure
1. In the Plots area of the Workspace, select the desired plot.

To select several plots, hold the Ctrl key while selecting or draw a 
selection rectangle.

2. On the Home tab of the Ribbon (see chapter 12.4.2 Home tab on 
page 65) click the arrow on the "Gate" box to expand a drop-down list 
and select the desired region to be applied as a parent gate.

– A parent gate will be automatically created for the selected region.

– The parent gate will be applied to the selected plots, indicated by a 
gate-coloured frame around the plots.

Stopping the measurement
If all described settings on the sample are set up, the measurement can be 
stopped. When the sample is empty (the stop electrode is reached) or if a 
stop condition is defined, measurement will stop automatically.

Procedure
1. On the Acquire pane (see chapter 12.5.4 Acquire pane on page 140) 

click the Stop button.

– The measurement is stopped.

After finishing a measurement a dialogue box will appear. Press OK button 
to proceed with an intermediate cleaning step. Please note that the 
remaining sample will be aspirated during the cleaning step. Alternatively, 
remove sample tube and press OK button. The cleaning step will be 
performed with air. To skip the intermediate cleaning step press Cancel 
button. The device is ready for the next sample measurement.
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Performing a manual compensation
A manual compensation can be performed online (during the measurement) 
or offline (after data acquisition).

Procedure
1. On the Compensation tab of the Ribbon (see chapter 12.4.6 

Compensation tab on page 84) click the Manual Compensation button 
and the Plot Compensation button.

2. On the plot, draw the desired population of events into the required area 
of the plot.

If using a quadrant, statistics are displayed on the Compensation tab of 
the Ribbon and can be used to arrange the population. Negative events 
are displayed in the lower left quadrant. A population negative for a 
parameter on Y scale should be placed in the lower right quadrant to the 
same height as the negative events. A population negative for a 
parameter on X scale should be placed in the upper left quadrant to the 
same range as the negative events.

For fine adjustment of compensation, use the arrow buttons on the 
Compensation tab of the Ribbon. The direction of the arrow icons 
indicates the way the plot populations move rather than the way the 
compensation values change.

– A manual compensation is performed.

Saving the Workspace and the instrument settings
On completion of a sample measurement, an FCS file is automatically saved 
containing the acquired data, the Workspace, the instrument settings and the 
compensation. Workspace and instrument settings can additionally be saved 
in separate files to use them independently.

Procedure
1. To save the Workspace of a Worklist item, select the File tab of the 

Ribbon (see chapter 12.4.1 File tab on page 58) and select "File > Save 
> Save Workspace" or "File > Save > Save Workspace As".

Alternatively, right-click the Worklist item in the Worklist to open the 
context menu and select "Workspace > Save Workspace (As)".

– The Workspace is saved.

2. To save the instrument settings of a Worklist item, right-click the Worklist 
item in the Worklist to open the context menu and select "Instrument 
Settings > Save Instrument Settings".

– The instrument settings are saved.
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Defining the Worklist for remaining samples
Defining a Worklist for future measurements includes defining the 
Workspace, instrument settings and stop conditions. Instrument settings and 
stop conditions are loaded from the Workspace by default but can be 
changed in the Worklist.

Procedure
1. In the Worklist, enter a Lab # and sample IDs for the Worklist items as 

desired.

2. To apply the Workspace developed from the sample to all Worklist items, 
right-click the Worklist item to open the context menu and select 
"Workspace > Apply To".

– A dialogue appears.

3. Select whether to apply the Workspace to the current panel or to the 
entire Worklist.

4. If differing instrument settings are to be used, click into the "Instrument 
Settings" cell of the Worklist item, select "Load from file" and select the 
desired instrument settings file.

5. To apply the differing instrument settings to other Worklist items, 
right-click the "Instrument Settings" cell to open the context menu and 
select "Apply to Panel".

6. To define differing stop conditions for the remaining samples, select the 
desired stop conditions from the Stops pane (see chapter 12.5.6 Stops 
pane on page 144).

Or right-click the "Stop Conditions" and "Stop Value" columns in the 
Worklist to open the context menu and select the desired stop conditions.

– The Worklist for remaining samples is defined.

Saving the Worklist
The FCS data are saved automatically on completion of sample 
measurement. The Worklist can be saved separately.

Procedure
1. To save the Worklist, select the File tab of the Ribbon (see chapter 

12.4.1 File tab on page 58) and select "File > Save > Save Worklist" or 
"Save Worklist As".

– The Worklist is saved.
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6.6.2 Analysing data and creating reports using the Playlist

Data can be analysed offline by using a Playlist (see chapter 12.7 Playlist 
pane on page 154).

All data created for analyses, including plots, statistics, compensation 
matrices and overlays, can be summarised in a page-based report that can 
be printed.

Analysing data using the Playlist

Procedure
1. To create a new Playlist, select the File tab of the Ribbon (see chapter 

12.4.1 File tab on page 58) and select "File > New > New Playlist".

In Worklist mode, a new Playlist can also be created by clicking the New 
button in the Worklist pane (see chapter 12.6 Worklist pane on 
page 146).

Alternatively, drag and drop a Playlist file from the Windows Explorer into 
the Workspace or the Playlist pane.

– A new blank Playlist is opened and displayed in the Playlist pane (see 
chapter 12.7 Playlist pane on page 154).

– The software is in Playlist mode.

2. To open a Playlist item in the Playlist, select the File tab of the Ribbon 
and select "File > Open > Open Listmode".

Alternatively, click the Open Listmode button on the Quick Access 
Toolbar, or click the Open Listmode button on the Home tab of the 
Ribbon (see chapter 12.4.2 Home tab on page 65), or drag and drop an 
FCS file from the Windows Explorer into the Playlist, or press Ctrl + O.

3. Plots, regions and gates can be edited in the Plots tab of the Workspace 
as desired (see chapter 12.8.1 Plots tab of the Workspace on page 160).

4. Statistics can be displayed and edited in the Results tab of the 
Workspace (see chapter 12.8.2 Results tab of the Workspace on 
page 171).

5. In Playlist mode, for setting compensations, the Compensation Wizard 
from the Compensation tab of the Ribbon can be used (see chapter 
12.4.6 Compensation tab on page 84).

6. To save the compensation, select the File tab of the Ribbon and select 
"File > Save > Save Compensation As".

7. For comparing plots to each other, overlay plots can be created manually 
(see chapter 12.8.3 Overlays tab of the Workspace on page 174).

In Playlist mode, the Overlay Wizard on the Overlay tab of the Ribbon 
can be used (see chapter 12.4.11 Overlay tab on page 109).

– The data are analysed.
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Creating a report
A report can be created manually in the Reports tab of the Workspace (see 
chapter 12.8.4 Reports tab of the Workspace on page 179). Alternatively, in 
Playlist mode, the Report Wizard from the Report tab of the Ribbon can be 
used (see chapter 12.4.12 Report tab on page 114). When using the Report 
Wizard, first select the page orientation, page size and header and footer 
information (steps 1 to 4 in the following procedure).

Procedure
1. Select the Reports tab of the Workspace.

– A blank report page is displayed.

– The Ribbon switches to its Report tab.

2. From the Page Setup group on the Report tab of the Ribbon (see chapter  
Pages group on page 119), select the desired page orientation (portrait 
or landscape) and page size (A4 or letter).

3. From the Insert group on the Report tab of the Ribbon (see chapter  
Insert group on page 120select the items to be shown in the report.

4. Click on the desired section of the report page (header, body, footer) to 
insert the selected item in a default size or draw an insertion rectangle to 
get a custom size.

If using the Report Wizard, select the items to be shown in the header 
and footer sections of all pages of the report here before starting the 
Wizard.

5. Use the options provided in the Report tab of the Ribbon to insert and 
organise pages, to edit text and other items and to arrange items.

– A report is created.

6.7
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7 Troubleshooting
If no data are displayed in the plots or histograms after acquisition process, 
air bubbles or contaminations may have blocked the flow cuvette.

To solve this problem perform a de-bubble or de-clog procedure. 

7.1 Performing a de-bubble procedure

Requirements
 Log-in as a user with the respective role.

Procedure
1. On the Cytometer tab of the Ribbon, click the De-bubble button.

– An instruction dialogue is displayed.

2. Follow the instructions until the finish message is displayed. 

– After successful de-bubble process the device is ready for the sample 
measurements.

– If the de-bubble process was not successful, please contact your local 
Sysmex representative.

7.2 Performing a de-clog procedure

Requirements
 Log-in as a user with the respective role.

Procedure
1. On the Cytometer tab of the Ribbon, click the De-clog button.

– An instruction dialogue is displayed.

2. Follow the instructions until the finish message is displayed. 

– After a successful de-clog process the device is ready for the sample 
measurements.

– If the de-clog process was not successful, please contact your local 
Sysmex representative.
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7.3 Sheath fluid, waste and fluids

Observation Possible solution
Sample flow is very 
slow or is not 
running.

Check that the waste bottle is closed properly and 
that the bottle is not cracked.
Check all visible tubes and make sure that they are 
not pinched.
Make sure that no air bubbles are trapped in the 
yellow inline filter of the sheath fluid bottle.
Check the connection of the sample tube to the 
sample port. Decant sample to another tube and 
measure again.
Perform a priming procedure.
Perform a cleaning procedure.
Shut down the device, including the main switch on 
the back side of the device. Wait 3–5 minutes and 
re-start the system.
Check the speed settings.

Sample flow is very 
fast even with low 
speed.

Change the yellow inline filter (50 µm) of the sheath 
fluid bottle.
Check if the visible sheath tube is pinched or 
blocked.
Shut down the device, including the main switch on 
the back side of the device. Wait 3–5 minutes and 
re-start the system.
Check the speed settings.
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7.4 Calibration and Count Check Beads (low, medium, high)

7.5 Measurements and data acquisition

7.6

Observation Possible solution
The results of the 
Count Check Beads 
(low, medium, high) 
measurements are 
not within ± 10% 
range of the 
lot-specific 
concentration stated 
on the bottle.

Shake the bottle vigorously (e.g. by vortexing) and 
repeat the measurement.
Check the date of expiry of the Count Check Beads 
(low, medium, high).
Perform a priming procedure.
Perform a cleaning procedure.

The results of the 
Calibration Beads  
measurements are 
not in the 
preselected regions 
of the original 
configuration script.

Check in software if you have loaded the correct 
configurations for your measurement.
Shake the bottle vigorously (e.g. by vortexing) and 
repeat the measurement.
Check the date of expiry of the Calibration Beads.
Perform a priming procedure.
Perform a cleaning procedure.

Observation Possible solution
The device emits an 
unusual / noisy 
sound after starting 
the measurement.

Check that the waste bottle is closed properly and 
that the bottle is not cracked.
Check all visible tubes and make sure that they are 
not pinched.
Check that liquid (sheath fluid and sample) is 
dropping into the waste bottle after starting the 
measurement.
Clean the two electrodes of the sample port 
carefully by wiping them with a soft tissue soaked in 
decontamination solution.
Perform a de-clog procedure.

There is no data 
acquisition visible 
(peaks/dots in 
histogram/dot plot) 
during the RUN 
phase

Check in software if the laser/s is/are switched on.
Check if the right trigger parameter has been 
selected (choose FSC trigger as default setting, 
select SSC for very small cells, e.g. bacteria).
Check gain values and the threshold.
Increase the flow rate.
Perform a de-clog procedure.
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Contaminated sheath fluid bottle
A contaminated sheath fluid bottle disturbs the proper operation.

 Clean the sheath fluid bottle regularly. 

Using incorrect cleaning solvents
Using incorrect cleaning solvents when cleaning the casing and screen could 
damage the device. 

 Do not use any organic solvents, nitro thinner, benzol, alcohol or highly 
concentrated bleach.

 Only use special screen cleaner.

8.1 Cleaning the device

The following list gives an overview of the various essential cleaning work on 
the device. 

 Clean the device casing with a soft cloth on a regular basis carefully. 
Water should not enter the device or peripheral devices or come into 
contact with electric connections and switches.

 Clean the screen with a soft cloth. Always use special screen cleaner. 

 Clean the sheath fluid bottle with distilled water and a brush. Flush with 
clean distilled water several times.

 Empty the waste bottle after and before each user session. When using 
biohazardous samples, a volume of 50 ml of Hypochlorite Solution 
(Order No. 04-4012_R) should be introduced into the waste bottle after 
measurement or before emptying the waste.

If the device will not be used for longer periods, clean the flow system with 
distilled water. Put a sample tube half-way filled with distilled water in the 
sample port. Clean the waste bottle and the sheath fluid bottle, wipe top dry.
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8.2 Performing a cleaning procedure

The device can be cleaned between sets of samples using a Cleaning 
Solution (Order No 04-4009_R) followed by a sample tube with sheath fluid. 
This procedure will allow you to significantly reduce cross contamination and 
reduce the background. There are three different levels of intensity available 
that can be set: Default, quick or deep.

Requirements
 Log-in as a user with the respective role.

Procedure
1. On the Cytometer tab of the Ribbon, click the Clean button.

– An instruction dialogue is displayed.

2. Follow the instructions until the finish message is displayed. 

– The device is ready for the sample measurements.

8.3
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Servicing is to be performed by an authorised service engineer. Please 
contact your local Sysmex representative for further instructions.

9.1

Sequence Activity Minimum 
user qualifi-
cation level

Daily 
maintenance

Prime the device by using the Prime 
function (see chapter 6.2.3 Performing a 
Prime on page 26).
Priming should be performed:
– After starting the device;
– After the sheath fluid was changed;
– After the waste bottle was emptied.

Instructed 
personnel

The system should not be left electrical 
switched on for several days without using 
it. Shut down the system completely each 
day.

Instructed 
personnel

Weekly 
maintenance

Clean the device according to cleaning 
instructions (see chapter 8 Cleaning on 
page 42).

Instructed 
personnel

Quarterly 
maintenance

Inline filter exchange according to 
instructions.

Instructed 
personnel

Preventive 
maintenance

A preventive maintenance procedure needs 
to be performed on a regularly basis. Please 
contact the service department of your local 
Sysmex  representative for further 
instructions.

Authorised 
service 
personnel
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10 Disposal
Service life of the device is limited by aging of mechanical components. 
Regular cleaning, maintenance and service ensure high-quality function and 
prevent any premature end-of-life.

The device was developed and manufactured with high-quality materials and 
components which can be recycled. 

Contamination of the environment
Electronic and electrical waste can contaminate the environment.

 Decontaminate the device.

 Dispose of electronic and electrical equipment separately opposed to 
regular waste according to local regulations and laws.

 Dispose of this product by taking it to your local collection point or 
recycling centre for such equipment.

Electrical and electronic equipment must be disposed of separately from 
normal waste.

Dispose of this product by taking it to your local collection point or recycling 
centre for such equipment. This will help to protect the environment.

For further information, please contact your local Sysmex representative.

10.1
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Heavy weight
When moving the device (packed or unpacked) or removing it from its 
packaging, a person is exposed to a high risk of damaging his or her body 
due to the heavy weight of the device.

 At least two persons are required for transport and installation.

This is a Class A product. In a domestic environment, this product may 
cause radio interference in which case the user may be required to take 
adequate measures.

Hardware data
Dimensions Width: 500 mm

Depth: 470 mm
Height: 370 mm (670 mm with open display)

Weight 40 kg
Maximum sound <70 dBA
Power 100 to 240 V AC

50/60 Hz
200 VA

Fuse  T 4.0 A 250 V
Overvoltage 
category

2/II

EMC class Class A
Degree of protection IP 20
46 CyFlow® Cube 8 | Operating Manual | May 2018 | Revision 032



11 Technical data
Operating 
environment

Temperature:
Operation: 15 °C to 30 °C
Transport and storage: 5 °C to 50 °C
Relative humidity:
Operation: 20 % to 85 %, non-condensing
Transport and storage: 20 % to 85 %, 
non-condensing
Room:
Clean environment. Direct sun light should be 
avoided

Operation specifications
Setup time Max. 5 minutes
Parameters detected Up to 8 optical parameters: FSC, SSC, FL1, FL2, 

FL3, FL4, FL5, FL6
Particle size range 0.1 μm to 100 μm
Maximum data 15000 events/second
Data acquisition Max. 15000 events/second
Acquisition stop 
condition

Event-based or volume-based

Trigger On all parameters, on multiple parameters or on 
single trigger parameter, selectable in software

Data resolution 16 bit

Application specifications
Application Immunophenotyping, DNA analysis, apoptosis, 

microbiology, industrial applications, 3 to 6 colour 
analysis.
True Volumetric Absolute Counts = counting per 
volume

True Volumetric 
Absolute Counting

Based on precise counting and mechanical fluid 
volume measurement no need for reference sample 
or beads.

Hardware data
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Optics (dependent on system configuration)
Laser output V1: Blue laser 488 nm 50 mW 

V2: Blue laser 488 nm 50 mW, Red laser 638 nm 
25 mW 
V4: Blue laser 488 nm 50 mW, Red laser 638 nm 
25 mW, UV-LED 365 nm
V5: Violet laser 405 nm 100 mW, Blue laser 488 nm 
50 mW, Red laser 638 nm 25 mW 
V6: UV laser 375 nm 60 mW, Blue laser 488 nm 50 mW, 
Red laser 638 nm 25 mW 
V7: Blue laser 488 nm 50 mW, Yellow laser 561 nm 
100 mW, Red laser 638 nm 25 mW 
V8: Blue laser 488 nm 50 mW, Red laser 640 nm 
40 mW
V9: Blue laser 488 nm 50 mW, UV-LED 365 nm 
V10: Blue laser 488 nm 50 mW, Orange laser 594 nm 
50 mW, Red laser 638 nm 25 mW 
V11: Violet laser 405 nm 100 mW, Blue laser 488 nm 
50 mW 
N1: Blue laser 488 nm 50 mW, Red laser 640 nm 
40 mW

Laser class Laser class I
(Laser class IIIb if device is opened and laser protection 
is removed)

Detectors V1: 1 to 5 (FSC, SSC, FL1, FL2, FL3) 
V2: 1 to 6 (FSC, SSC, FL1, FL2, FL3, FL4) 
V4: 1 to 8 (FSC, SSC, FL1, FL2, FL3, FL4, FL5, FL6) 
V5: 1 to 8 (FSC, SSC, FL1, FL2, FL3, FL4, FL5, FL6) 
V6: 1 to 8 (FSC, SSC, FL1, FL2, FL3, FL4, FL5, FL6) 
V7: 1 to 8 (FSC, SSC, FL1, FL2, FL3, FL4, FL5, FL6) 
V8: 1 to 7 (FSC, SSC, FL1, FL2, FL3, FL5, FL6) 
V9: 1 to 6 (FSC, SSC, FL1, FL2, FL3, FL5) 
V10: 1 to 8 (FSC, SSC, FL1, FL2, FL3, FL4, FL5, FL6) 
V11: 1 to 8 (FSC, SSC, FL1, FL2, FL3, FL4, FL5, FL6) 
N1: 1 to 6 (FSC, SSC, FL1, FL2, FL3, FL4) 

Filters Standard setup and filters for all parameters according 
to laser configuration

Optical coupling Standard objective mount with high numerical aperture 
objective, high numerical aperture immersion gel 
coupling, e.g. for detection of weak cytokines (option)

Excitation optics Elliptical 15 μm × 100 μm at 488 nm, other beam 
geometries upon request
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11.1

Fluids
Fluid system Completely closed system for sheath fluid and 

sample volumes;
no fluid droplets or aerosols generated nor released 
from the device

Flow cuvette Synthetic quartz flow cuvette with small centric flow 
channel (capillary diameter 350 µm x 250 µm) for 
laminar sample transport with sheath fluid.

Sample delivery Computer controlled precision syringe pump for 
contamination-free sample transport.
Built-in vacuum pump for waste bottle; vacuum 
pressure is adjustable (computer controlled)

Sample volume Continuous up to 1200 μl
Minimal content of sample volume 850 μl
200 μl for electrode based precision absolute 
counting (other counting volumes upon request)
Minimal sampling volume 10 μl
5 µl to 1000 μl for syringe-based precision absolute 
counting

Flow rates Sample volume speed adjustable continuously 
between 0.1 µl/s and 20 μl/s)
Sheath fluid flow continuously adjustable in expert 
mode

Fluids volume 2 glass bottles (each litre) for sheath fluid and waste
Bio safety system Avoids sample droplets and sample cross 

contamination (computer controlled)
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12 Software description
The device is operated by means of the CyFlow® software. This chapter 
describes the software functions. Performing routine tasks using the 
software is described in chapter 6.6 Software operation on page 30.

12.1 Overview

Data acquisition, device control and data analysis are controlled and 
performed by the integrated software.

The software can be run in two different modes:

 In Worklist mode, data can be acquired. The hardware and software 
settings for each measurement are predefined and organised in a list 
called Worklist.

 In Playlist mode, acquired data can be analysed and settings for future 
measurements can be prepared. Files are organised and edited in a 
Playlist.

Opening a Playlist sets the software to Playlist mode. Opening a Worklist 
sets the software to Worklist mode. Only one Worklist or Playlist can be 
open at a time.

When starting the device, the software is opened in Worklist mode.

1 Quick Access Toolbar
2 Ribbon
3 Workspace

4 Worklist pane
5 Status bar
6 Panes

4

3
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The default view of the software window contains the following elements:

 Quick Access Toolbar: The Quick Access Toolbar provides quick 
access to some of the most commonly used options in the software.

 Ribbon: The Ribbon provides access to the main functionality groups of 
the software. The Ribbon is organised into a set of tabs.

 Workspace: The Workspace contains four tabs for creating and editing 
plots, results, overlays and reports.

 Worklist pane: In the Worklist pane, a Worklist can be created or 
opened. The Worklist then can be edited.

 Status bar: The status bar displays status information. On the right, it 
contains functions for resizing objects in the Workspace.

 Panes: This area of the software window contains a set of panes for 
editing instrument settings, for acquiring data and for displaying 
information on FCS files.

If a Playlist is opened, the software changes to Playlist mode. The Worklist 
pane is no longer displayed. A Playlist pane is displayed on the left-hand 
side of the Workspace and nested with the other panes.
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12.2 Views of the software window

The software window view can be adapted by displaying or hiding the panes 
and by docking and undocking the panes. Undocked panes can be 
positioned and docked as required.

The view settings are persisted between sessions.

Displaying and hiding the panes
By default, the panes are open and pinned to the left-hand side of the 
software window. The tabs of the panes are located at the bottom of the 
panes.

To hide the panes, click the pin-shaped Auto Hide button. 

The panes are hidden and the tabs of the panes appear on the left-hand side 
of the software window.

1 Auto Hide button

1
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To re-expand a pane, click the desired tab. The pane is visible as long as the 
cursor is over the pane.

To refix the panes in this open position so they are always visible, click the 
Auto Hide button on the expanded pane.

1 Tabs of the panes

1
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Undocking and positioning the panes
The panes, including the Worklist pane and the Playlist pane, can be 
positioned and docked as required.

To undock a pane, the following options are available:

 Click the title bar and relocate the pane by dragging and dropping. When 
a pane is selected, its title bar is highlighted in orange.

 Double-click the title bar.

 Click the Float button.

The pane can then be dragged to the desired position.

To dock the pane to the previous position, double-click the title bar again or 
click the Dock button.

The pane can be docked to other positions by using the blue relocation 
arrows that are displayed while dragging the pane. To dock the pane to 
bottom, top, right or left of the software window, drag the cursor onto the 
corresponding relocation arrow. When the cursor is over a relocation arrow, 
the position where the pane will be located on dropping is highlighted in blue.

1 Title bar of docked pane
2 Float button
3 Relocation arrows

4 Title bar of undocked pane
5 Dock button

1

3 4 3

5

3

3

3
2
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The Worklist pane can be docked and nested with the other panes by 
dragging it and placing the cursor in the centre of the relocation arrows on 
the left-hand side of the software window.

The size of docked panes can be adjusted by dragging the splitter bar to the 
desired position.

To get back to the default view of the software window, select the Views tab 
of the Ribbon and click the Default Position button.

1 Centre of the relocation arrows

1
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12.3 Quick Access Toolbar

The Quick Access Toolbar provides quick access to some of the most 
commonly used options in the software.

By default, the Quick Access Toolbar contains an Open Listmode button, 
an Undo button and a Redo button.

You can customise the Quick Access Toolbar. To do this, click on the arrow 
next to the buttons in the Quick Access Toolbar. A drop-down list appears.

Adding a button to the Quick Access Toolbar
The Open Listmode, Undo, Redo and Print menu items in the drop-down 
list allow you to add or remove the respective buttons. Check the menu item 
to add the corresponding button to the Quick Access Toolbar.

The More Commands… menu item allows you to add more buttons to the 
Quick Access Toolbar. When you select the menu item, a dialogue box 
appears. In this dialogue box you can choose further buttons for the Quick 
Access Toolbar.

Removing a button from the Quick Access Toolbar
Uncheck the Open Listmode, Undo, Redo or Print menu item in the 
drop-down list to remove the corresponding button from the Quick Access 
Toolbar.

If you want to remove a different button from the Quick Access Toolbar, use 
the More Commands… menu item.

Alternatively, right-click the button you wish to remove and select the 
Remove from Quick Access Toolbar menu item from the context menu.

Showing the Quick Access Toolbar below the Ribbon
Usually the Quick Access Toolbar is located above the Ribbon in the top left 
corner of the software window.

To place the Quick Access Toolbar below the Ribbon, click the Show Below 
the Ribbon menu item in the drop-down list.

When the Quick Access Toolbar is displayed below the Ribbon, the menu 
item in the drop-down list is named Show Above the Ribbon.
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Minimising the Ribbon
Usually the Ribbon is fully visible. But if you need more place on the display, 
you have the possibility to minimise the Ribbon. Then, only the tabs are 
visible. 

Check or uncheck the Minimize the Ribbon menu item in the drop-down list 
to toggle the Ribbon between minimised and restored.

Changing to another tab restores the Ribbon temporarily.
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12.4 Ribbon

The Ribbon is the area at the top of the software window that presents an 
easy-to-browse main set of commands.

The Ribbon is organised into a set of tabs which represent the main 
functionality groups of the software.

12.4.1 File tab

The File tab contains file open, printing and export options. The File tab also 
provides access to the user management and to the software options.

Recent documents
When clicking on the File tab, a list of recently used documents is displayed. 
In Worklist mode, recently used Worklist files are shown. In Playlist mode, 
the list comprises of recently used listmode, Workspace and Playlist files. A 
maximum of 10 files can be presented in this list.

Click a file name to open the file.

New
The New menu contains the following options:

 New Playlist: Click the menu item to create a new Playlist. Selecting this 
option will clear the current Playlist or Worklist, and a new blank Playlist 
will be displayed in the Playlist pane.

 New Worklist: Click the menu item to create a new Worklist. Selecting 
this option will clear the current Worklist or Playlist.

A new Worklist with 400 blank Worklist items is created.
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Open
The Open menu contains the following options:

 Open Worklist…: Click the menu item to open a Worklist file (XMLWL 
file). Only one Worklist file can be open at a time.

 Open Listmode…: This menu item is only displayed in Playlist mode. 
Click the menu item to open one or more listmode files (LMD or FCS 
files) and select the desired files to add them to the Playlist. The Playlist 
item of the first added listmode file will be activated automatically in the 
Playlist.

 Open Workspace…: This menu item is only enabled if a listmode file of 
a Playlist is open in the Workspace. Click the menu item to open a 
Workspace file (XMLW file) and select the desired file to load it with the 
currently open listmode file.

 Open Playlist…: Click the menu item to open a Playlist file (XMLP file). 
Only one Playlist file can be open at a time.

 Open Compensation File…: This menu item is only enabled if a 
compensable listmode file of a Playlist is open in the Workspace. Click 
the menu item to open a compensation file (XMLC file) and select the 
desired file to load it into the currently open Playlist item. If a new 
compensation file is selected, this will replace the one currently loaded. 
Only one compensation file can be opened at a time and compensation 
is only available on high-resolution data files.

Save
In Worklist mode, the Save menu contains the following options:

 Save Worklist: Click the menu item to save the current Worklist with the 
current Worklist file name.

When saving a Worklist, Workspace file paths and file extensions (if 
present) are removed and the Workspace files are saved within the 
associated panel within the Worklist file. If there are multiple Workspace 
files present within a panel with the same name, a unique identifier is 
added to the Workspace file name to differentiate the Workspace files.

 Save Worklist As…: Click the menu item to save the current Worklist 
with a new file name and an XMLWL extension.

 Save Workspace: Click the menu item to save the current Workspace 
with the current Workspace file name. A Workspace includes plots, 
regions, gates, colour precedence, selected statistics and displayed 
parameters. The Workspace file is always saved with an XMLW 
extension.

 Save Workspace As…: Click the menu item to save an untitled 
Workspace or the current Workspace with a new file name and an XMLW 
extension.
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In Playlist mode, the Save menu contains the following options:

 Save Workspace: Click the menu item to save the current Workspace 
with the current Workspace file name. A Workspace includes plots, 
regions, gates, colour precedence, selected statistics and displayed 
parameters. The Workspace file is always saved with an XMLW 
extension.

 Save Workspace As…: Click the menu item to save an untitled 
Workspace or the current Workspace with a new file name and an XMLW 
extension.

 Save Playlist As…: Click the menu item to save the current Playlist with 
a new file name and an XMLP extension. For each Playlist item, the 
listmode file path, the Workspace and the compensation are saved. If 
there are multiple Workspace or compensation files within the Playlist 
with the same name, a unique identifier will be added to the name of the 
respective file. The report, software version and build number are also 
saved in the Playlist.

If some of the listmode files in the Playlist have relative paths, a message 
indicating that the Playlist is an exported Playlist is displayed. You will 
have the option to export the Playlist or to save the Playlist as a regular 
Playlist.

 Save Compensation As…: This menu item is only enabled if a 
compensable listmode file is loaded. Click the menu item to save the 
current compensation settings with a new file name and an XMLC 
extension, or to apply the current compensation settings to other 
compensable files.

 Save Plot(s) As…: This menu item is only enabled if one or more plots 
are selected in the Plots area. Click the menu item to save these plots as 
image file. A dialogue box appears. Enter a name for the plot(s), select 
the file format (BMP, JPEG, GIF, TIFF or PNG), select the destination 
folder and click the Save button. The size of the plot in the Plots area will 
determine the size of the saved image. To increase the size of the saved 
image, increase the size of the plot using the resize slider in the status bar.

Print
The Print menu contains the following options:

 Print…: Click the menu item to print plots, statistics or reports. A 
dialogue box appears. Select the printer, define the print range and the 
number of copies and select what to print (plots and statistics for the 
current Workspace or the current report).

 Print Preview: Click the menu item to display a preview of the current 
plots in the Workspace or the current report to be printed. Modify the 
printing options if necessary and click the  Print… button. A dialogue box 
appears. Change the printing options if necessary and click the OK 
button.

 Print Setup…: Click the menu item to select the required default setup 
for your printer.
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Export
The Export menu is only available in Playlist mode except for the Export 
Report to PDF menu item which is also accessible in Worklist mode. 

The menu contains the following options:

 Export Statistics to CSV: This menu item is only enabled when there 
are results present in the results table. The results exported to a CSV file 
are the columns displayed in the results table in the Results tab of the 
Workspace. The format of the export is either single row per file or one 
row per result, depending on the selection in the software options (see 
chapter 12.10 CyFlow Options on page 187). Click the menu item to save 
a CSV formatted file containing the results of the currently open Playlist 
item only. A dialogue box appears. Enter a name for the export, select 
the destination folder and click the Open button.

If the entered file name already exists and the format of the exported 
data matches the formatting of the data in the file, the results are 
appended to those already in the file.

If the entered file name already exists but the headers in the two files do 
not match, you will have the option to overwrite the existing file. After the 
file has been saved, the Windows Explorer opens with the exported file 
highlighted.

 Export All Statistics to CSV: This menu item is only enabled when 
there are results present in the results table in the Results tab of the 
Workspace. Click the menu item to save a CSV formatted file containing 
the results of all files in the Playlist. A dialogue box appears. Enter a 
name for the export, select the destination folder and click the Open 
button.

If the entered file name already exists and the format of the exported 
data matches the formatting of the data in the file, the results are 
appended to those already in the file.

If the entered file name already exists but the headers in the two files do 
not match, you will have the option to overwrite the existing file. After the 
file has been saved, the Windows Explorer opens with the exported file 
highlighted.

 Export Playlist: This menu item is for exporting a Playlist for sharing 
with other users and colleagues or for archiving. Any modifications to the 
Playlist need to be saved before it can be exported. 

Click the menu item and select the destination folder for the export.

Click the OK button to perform the export. A folder with the same name 
as the current Playlist is created inside the destination folder. The 
exported Playlist is placed in it. The exported listmode files are placed in 
a subfolder called "LMD". The exported image files are placed in a 
subfolder called "Images". Worklist and compensation files are stored as 
part of the Playlist file (XMLP file).
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If the original Playlist (before export) contains the same LMD file in more 
than one of its items, only one copy of the file is in the export LMD folder. 
If the original Playlist (before export) contains LMD files that have the 
same name but are in different folders, they are all placed in the exported 
LMD folder with numbers in parenthesis appended to the file name, so 
they can be distinguished.

If a Playlist of the same name already exists in the selected folder, you 
will have the option to replace the existing Playlist. If you choose not to 
replace the existing Playlist, the new Playlist is saved with an appended 
number to the name to distinguish it from the existing one.

If some of the LMD or image files that are to be exported have the same 
name as the ones in the export LMD and images folders, the Windows 
Copy File dialogue is displayed and allows you to resolve the conflicts. 
When re-exporting a Playlist to the same folder it was exported before, 
you should use Copy & Replace in the Windows Copy File dialogue. 
Otherwise duplicate files will be created.

For an exported Playlist to open properly, the folder structure of the 
export folder has to be preserved.

 Export Statistics to XML: The menu item is enabled when a Playlist 
item containing a listmode file is active. Click the menu item to save an 
XML file containing the results of the currently open file only. A dialogue 
box appears. Enter a name for the export, select the destination folder 
and click the Open button.

If the entered file name already exists and the format of the exported 
data matches the formatting of the data in the file, the results are 
appended to those already in the file. If the entered file name already 
exists but the headers in the two files do not match, you will have the 
option to overwrite the existing file.

After the file has been saved, the Windows Explorer opens with the 
exported file highlighted.

 Export All Statistics to XML: The menu item is enabled if one or more 
Playlist items contain a listmode file. Click the menu item to save an XML 
file containing the results of all files in the Playlist. A dialogue box 
appears. Enter a name for the export, select the destination folder and 
click the Open button.

If the entered file name already exists and the format of the exported 
data matches the formatting of the data in the file, the results are 
appended to those already in the file. If the entered file name already 
exists but the headers in the two files do not match, you will have the 
option to overwrite the existing file.

After the file has been saved, the Windows Explorer opens with the 
exported file highlighted.

 Export Report to PDF: The menu item is enabled if there is an active 
item in the Worklist or the Playlist, the Reports tab of the Workspace is 
open and if acquisition is not in progress. Click the menu item to export a 
report as PDF file and select a name and a destination folder for the PDF.
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When in Worklist mode, reports are exported by panels. If a Worklist 
contains several panels, a corresponding message is displayed and you 
will have the option to export only the current panel report or all panel 
reports.

On exporting, the software creates a subfolder inside the destination 
folder with a name containing the Worklist name and a time stamp. Each 
panel will be exported in a PDF file. The name of each PDF file contains 
the panel name, an index range, the index of the first item and the index 
of the last item of that panel.

Tools
The Tools menu contains the following option:

 Listmode File Keywords...: This menu item is only enabled if a Worklist 
item or Playlist item containing a listmode file is open in the Workspace. 
Click the menu item to open the Keywords dialogue. The dialogue 
displays the keywords and values from the header of the active listmode 
file. Click the Copy Keywords button to copy the keywords and values 
displayed in the dialogue to the clipboard. This list can then be pasted 
into other applications (e.g. Microsoft® Excel).

User Management
Click the button to open the Task Pad. The Task Pad contains options to 
change your password, to lock the software or to view an Audit Log report.

If logged in with user administration privilege, the Task Pad contains options 
for administration of user accounts.

The table lists the current user accounts. 

The following buttons are provided to create and modify the user accounts:

 Create: Click the button to create a new user account.

 Modify: Select a user account in the table and click the button to modify 
the user account.
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 Accessible: Click the button to restore access for the selected user. 
Access is locked when a user enters a defined number of incorrect 
passwords consecutively. The number is defined in the "Log In Attempts" 
item.

 Password: Click the button to enter a temporary password for the 
selected user.

 Groups: Click the button to define the roles for the selected user. Click in 
the "Status" column to select or deselect the corresponding role for a 
user.

 Sort Order: Click the button to toggle the sorting order in the table 
between sorting by first name or sorting by last name.

 Refresh: Click the button to refresh the table.

The following options for system settings and reports are provided :

 Log In Attempts: Click the item to define the number of login attempts 
before the account will be locked (1 to 10 attempts).

 Password Expiry: Click the item to define the number of days before 
expiry of the passwords (1 to 90 days).

 Password History: Click the item to define the number of passwords 
that is stored in the password history (3 to 12 per user account).

 Audit Log: Click the item to view an Audit Log report.

Log Out
Click the button to log out. You are logged out, and a log-in dialogue is 
displayed.

If acquisition is in progress when logging out, a message is displayed and 
you will have the option to abort the acquisition.

CyFlow Options
Click the button to open the software options (see chapter 12.10 CyFlow 
Options on page 187).

Exit CyFlow Software
Click the button to close the software. If changes have been made, you will 
be prompted to save the Playlist or Worklist before closing the software.

If acquisition is in progress, you will be prompted to stop the acquisition 
before exiting the software.

If acquisition is not in progress, a message is displayed, and you will have 
the option to perform a shutdown cleaning procedure. Click the Yes button to 
start the shutdown cleaning procedure. Once started, the software guides 
you through the process.
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12.4.2 Home tab

The Home tab is the default tab and provides all the essential controls for 
analysing files in one convenient place. Here, files can be selected, regions 
created and plots created and gated.

Load group
The Load group contains controls for opening listmode files and 
Workspaces.

The Load group contains the following options:

 Open Listmode: The button is only enabled in Playlist mode. Click the 
button to open one or more listmode files (LMD or FCS files) and select 
the desired files to add them to the Playlist. The Playlist item of the first 
added listmode file will be activated automatically in the Playlist.

 Open Workspace: The button is only enabled if a listmode file of a 
Playlist is open in the Workspace area. Click the button to open a 
Workspace file (XMLW file) and select the desired file to load it with the 
currently open listmode file.

 Most recently used: The small button at the bottom right of the group is 
only enabled if a Playlist is open. Click the button to open a dialogue that 
lists the 10 most recently used listmode files and Workspace files.

Select a listmode file listed under "Most Recent Listmode Files" to add 
that file to the end of the Playlist and open that file.

Select a Workspace file listed under "Most Recent Workspaces" to 
assign that Workspace to the currently open file in the Playlist. This 
option is only available when a listmode file is open.

Region group
The Region group contains controls for creating and editing regions. You can 
create a maximum of 256 regions per Workspace. Once this number is 
reached, the region creation buttons in the Region group become disabled.

The Region group contains the following options:

 Elliptical Region: Click the button to preselect creating an elliptical 
region on a dual parameter plot.

 Rectangular Region: Click the button to preselect creating a rectangular 
region on a dual parameter plot.

 Polygonal Region: Click the button to preselect creating a polygonal 
region on a dual parameter plot.
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 Linear Region: Click the button to preselect creating a linear region on a 
single parameter plot.

 Quadrant Region: Click the button to preselect creating a quadrant 
region on a dual parameter plot.

 Region Color: The button is only enabled if a region is selected on a 
plot. Click the button to display a colour control and select the desired 
colour for the region.

The region colour on the plot will update. If the region has an associated 
gate, changing the region colour will not change the gate colour. The 
gate colour can be changed using the Edit Gates button in the Analyze 
tab (see chapter  Gate group on page 69).

For further information on defining and editing regions (see chapter  Creating 
regions on page 165).

Add Plot group
The Add Plot group contains controls for creating plots in the Workspace. 
The buttons are only available if a Playlist item or a Worklist item is open in 
the Workspace area.

The Add Plot group contains the following options:

 Density Plot: Click the button to add a dual parameter density plot 
displaying the first two parameters of the current listmode file. This will 
normally display a plot showing Forward Scatter against Side Scatter.

 Histogram Plot: Click the button to add a single parameter histogram 
plot displaying the first parameter in the current listmode file. This will 
normally display the Forward Scatter.

 Duplicate Plot: Click the button to add another copy of the selected plot 
to the current Workspace. If the current plot has cell cycle mode enabled, 
the duplicate plot will display only the raw histogram with cell cycle 
disabled.

Parameters group
The controls in the Parameters group are used to change the X and Y 
parameters of the currently selected plots in the Workspace area. The 
scaling of parameters can be changed.
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The Parameters group contains the following options:

 X and Y Parameter Selection:
The X and Y parameter for the currently selected plots can be set using 
these boxes. Click the arrow to expand a drop-down list and select the 
desired parameter. All parameters enabled in the current file are 
available for selection.

If all the selected plots have the same parameters, the boxes will be 
populated with the current parameter name. If all the selected plots do 
not have the same parameters, the boxes will be empty.

 X and Y Parameter Scale Selection (Lin/Log):
This option allows changing the scaling of the chosen parameters for all 
selected plots. Click the arrow to expand a drop-down list and select the 
desired scaling. Lin, Log and V-Log options are available for selection. 
This option will not be available if the opened file is a low-resolution data 
file.

If all the selected plots have the same parameter scaling, the boxes will 
be populated with the current parameter scale name. If all the selected 
plots do not have the same parameter scaling, the boxes will be empty.

Gate group
The Gate group options allow the selection of gating for the currently 
selected plots.

The Gate group contains the following option:

 Gate: To select a gate for the currently selected plot(s), click the arrow to 
expand a drop-down list and select the desired gate. All existing gates 
and regions are available for selection. If a region or quadrant is 
selected, a gate will be automatically created for that region or quadrant. 
Gates can be edited using the Edit Gates button in the Analyze tab (see 
chapter  Gate group on page 69).

Select the "Ungated" option to set selected plots to be ungated.
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12.4.3 Analyze tab

The Analyze tab provides controls for analysing and modifying the plots in 
the Plots area of the Workspace.

Region group
The Region group contains options for creating and editing regions. You can 
create a maximum of 256 regions per Workspace. Once this number is 
reached, the region creation buttons in the Region group become disabled.

The Region group contains the following options:

 Elliptical Region: Click the button to preselect creating an elliptical 
region on a dual parameter plot.

 Rectangular Region: Click the button to preselect creating a rectangular 
region on a dual parameter plot.

 Polygonal Region: Click the button to preselect creating a polygonal 
region on a dual parameter plot.

 Linear Region: Click the button to preselect creating a linear region on a 
single parameter plot.

 Quadrant Region: Click the button to preselect creating a quadrant 
region on a dual parameter plot.

For further information on defining and editing regions, see chapter  Creating 
regions on page 165.

Plots group
The Plots group contains options for adding a specific selection of plots to 
the Plots area of the Workspace.

The Plots group contains the following buttons:

 Histograms: Click the button to add all the single parameter histogram 
plots displayed in the Previews area of the Workspace to the Plots area. 
The plots are gated with the same gate as the preview plots. All the 
added plots are colour-coded to illustrate the gating applied to the 
Previews area.

 Dual Parameter: Click the button to display a drop-down list of available 
parameters. Select a parameter from the drop-down list to add all the 
dual parameter combinations against this parameter to the Plots area. 
The selected parameter is fixed as the Y-axis. The plots are gated with 
the same gate as the preview plots. All the added plots are colour-coded 
to illustrate the gating applied to the Previews area.
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 Upper Triangle: Click the button to add all the dual parameter plots that 
are displayed within the upper right triangle of the Previews area. All the 
added plots are colour-coded to illustrate the gating applied to the 
Previews area.

 Lower Triangle: Click the button to add all the dual parameter plots that 
are displayed within the lower left triangle of the Previews area. All the 
added plots are colour-coded to illustrate the gating applied to the 
Previews area.

 Backgated Plots: When you select the button, the software will assess 
the gate equation of the currently selected plot and identify the regions 
and parameters involved. The software then creates new plots with the 
parameters used by the regions within the gate equation, and gates 
these plots on the gate equation of the currently selected plot.

For example, if a plot gated on B is selected and its expanded gate 
equation is A AND B, clicking the Backgated Plots button creates two 
plots gated on B, one for events in region A and one for events in region 
B.

Gate group
The Gate group contains options for creating and managing the gates in the 
current Workspace.

Using the Precedence Order button, you can edit the colour precedence 
order used when events are displayed on plots. You can also choose which 
gates are active within the precedence system.
CyFlow® Cube 8 | Operating Manual | May 2018 | Revision 032 69



12 Software description
In the Precedence Order dialogue, a gates list displays all gates in the 
current Workspace. The text colour corresponds to their gate colour.

Adjacent to each gate name is a check box. Select the check boxes to 
include the corresponding gates in the colour precedence.

Gates positioned at the top of the list have higher precedence than the gates 
positioned at the bottom of the list. The precedence defines the appearance 
of the gates in the plots in the Workspace. The plots will display events in the 
top gate of the list on top of all other events in the plot. If a new gate is 
created, it will be added to the top of the preference list by default, and 
events associated with it will be painted on top of events in any other gates. 
To change the precedence, use the Precedence Order dialogue.

The Precedence Order dialogue contains the following options:

 Move to top, Move up, Move down, Move to: Select a gate and use 
these buttons to move the selected gate to the desired position within the 
gates list.

 Check all, Uncheck all: Use these buttons to select or unselect all gates 
in the list.

 Most Gated order: Click the button to place the selected gates in the 
precedence order ranked by the number of unique regions in each gate, 
using the expanded gate equations.

 Ungated Event Color: To change the current colour for ungated events 
on precedence plots. Click the arrow to display the colour control and 
select the desired new colour.

When the gate order is modified, always check the selected precedence 
order works as intended and no populations are masked by a colour of lower 
priority.

Always ensure that the colours assigned to the populations in the 
precedence system can be clearly distinguished from each other.
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Using the Edit Gates button, you can create, edit and delete gates. In 
addition, you can view the Parent Gate and Expanded Equation information.

The Edit Gates dialogue displays a Gates list containing all the currently 
existing gates. In the Gates tab, you can rename and delete gates. In the 
Derived Gates tab, you can rename, delete and change the gate equation of 
derived gates. To edit a gate, first select it in the Gates list.

In the Gates tab, the Gates list contains the following columns:

 The "Gate name" column displays the name of the gate. The colour of 
the font is the colour of the gate.

 The "Parent Gate" column displays the parent gate for the gate. If the 
gate has no parent gate, this field displays "Ungated".

 The "Expanded Equation" column displays the full expanded equation for 
the gate. The parent gate equation is shown in full.
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In the Derived Gates tab, the Gates list contains the following columns:

 The "Gate name" column displays the name of the gate. The colour of 
the font is the colour of the gate.

 The "Equation" column displays the equation for the gate. The contents 
of this field are added to the parent gate equation to create the expanded 
equation.

 The "Expanded Equation" column displays the full expanded equation for 
the gate. The parent gate equation is shown in full.

The Edit Gates dialogue contains the following options:

 New Gate: Click the button to add a new gate. A gate with a default 
name is added to the bottom of the gate list.

 Delete: Click the button to delete the currently selected gate. The 
deletion of the gate will be aborted if you press the Cancel button on the 
dialogue.

 Gate Name: To change the gate name, type in the new name in the field. 
You should use gate names that are significantly different.

 Parent Gate: The Parent Gate drop-down list is populated with the 
names of all available gates. To change the parent gate of the currently 
selected gate, click the arrow to expand the drop-down list and select a 
new parent gate from it.

When creating a new gate, the Parent Gate field can be used to simplify 
gate equation creation. The field contains a list of all current gate names 
and you can select one of these gate names rather than having to specify 
the complete gate equation. If you wish to enter a full equation without 
using a parent gate, you should select "Ungated" as the parent and then 
enter the full equation into the Gate Equation field.

 Gate Equation: In this field, you can edit the gate equation. To display a 
larger Gate Equation dialogue, press the ... button at the right of the field.

The operators AND, OR, NOT, XOR can be used to help define a gate 
equation. The order of processing of these operators is NOT, AND, XOR, 
OR. Use parentheses () to change the order of processing. Region 
names and these operators are used to define a gate.

Quotation marks ("") must be used around region names that include 
spaces, e.g. "CD4 Count" and around region names that use any of the 
shortcut symbols or words that are listed above, e.g. "A XOR B" and 
"A!B". The gate equation can include a maximum of 28 regions and 6000 
characters.

 Gate Color: To change the gate colour, click the arrow to display the 
colour control and select the desired new colour.

Always ensure that the colours assigned to the gates can be clearly 
distinguished from each other. You should avoid using system colours as 
they can be changed outside of the software.
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View group
The View group contains options to modify the way in which plots are 
displayed in the Plots area of the Workspace.

The View group contains the following options:

 Gallery: Click the button to choose the Gallery plot view. The plots in the 
Plots area are displayed next to each other.

 Hierarchy: Click the button to choose the Hierarchy plot view. The plots 
in the Plots area are displayed in a family tree style hierarchy format.

 % Events: To reduce the number of events displayed on screen, enter a 
value or use the up/down arrows to define the desired percentage of 
events to be displayed. The actual number of events displayed is shown 
in the "Max:" field below. Adjusting this value does not affect statistical 
calculations which are always performed on all events within a file.

Edit group
The Edit group contains options for copying images of the currently selected 
plots and statistics for pasting into other applications. These controls are 
also used for copying, cutting and pasting items within reports. Additionally, 
the fonts of text items in the current Workspace can be edited.

The buttons are only available if a Playlist item or a Worklist item is open in 
the Workspace area.

The Edit group contains the following buttons:

 Paste: Click the button to paste previously copied or cut report items 
back into the report. The button is only enabled on the Reports tab of the 
Workspace, after a report item has been copied or cut.

 Cut: Click the button to cut the selected report item and place it on the 
clipboard for pasting into the report. Report items cannot be pasted into 
other applications. The button is only enabled on the Reports tab of the 
Workspace, after a report item has been selected.

 Copy: When on the Plots tab of the Workspace, click this button to copy 
an image of the currently selected plot(s) or statistics. You can then 
paste the item into other applications (Microsoft® Word, PowerPoint, 
etc.).

If you want to maintain the hierarchy view when copying and pasting 
plots displayed in the Hierarchy format, first select all plots in the 
hierarchy and then click the Copy button. If all plots in the hierarchy are 
not selected, when pasted, plots will be pasted in the standard Gallery 
format.
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When on the Report tab of the Workspace, click the Copy button to copy 
the selected report objects for pasting into the report. Report items 
cannot be pasted into other applications.

 Delete: Click the button to delete the currently selected plots or region. If 
the deleted plot has a region applied, deleting the plot also deletes the 
region and removes the region from any gating logic. In this case, a 
corresponding message box is displayed and you will have the option to 
confirm or abort deleting the plot.

 Select: Click the button to select groups of plots from a drop-down list:

Click the Select All option to select all the plots in the Plots area. 

Click the Select Plots with Same Gate option to select all the plots that 
have the same gate applied as the selected plot in the Plots area. 

Click the  Invert Selection option to select all the plots that are currently 
not selected in the Plots area. 

Click the Select Dual Parameter Plots or Select Histogram Plots 
option to select all dual parameter plots or all histogram plots, 
respectively.

 Fonts: Click the button to open the Edit Fonts dialogue. In the pages of 
this dialogue, you can change the font typeface and size for region 
labels, plot titles, cell cycle and parameter names and scale labels in the 
current Workspace. The pages are the same as in the software options 
(see chapter  Font pages on page 192).

12.4.4 Preview tab

The Preview tab provides controls for modifying the plots displayed in the 
Previews area of the Workspace.

Preview group
The Preview group contains viewing options for the Previews area. The 
buttons in this group are only available if a Worklist item or a Playlist item is 
open in the Workspace. Selected buttons are highlighted in orange.

The buttons in the lower row of the Preview group contain filter options. 
Filters affect which parameters, and therefore plots, are displayed in the 
Previews area. The filters are used to selectively reduce the number of plots 
displayed in the Previews area.

The Preview group contains the following buttons:

 Show Previews: By default the button is selected, and previews of all 
parameters are displayed in the Previews area. Clicking the button 
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switches between hiding and showing the previews. The setting of this 
button will be persisted between sessions.

 Previews Topmost: By default, the Plots area is positioned above the 
Previews area in the Workspace. Clicking the button switches between 
displaying the Previews area above and below the Plots area.

 Quadrants on Previews: Clicking the button switches between 
displaying and hiding a quadrant region on all of the dual parameter 
preview plots. Only one quadrant can be displayed on each plot.

 Unfiltered: Click the button to show preview plots for all currently 
selected parameters. The Previews area is unfiltered by default.

 FL only: Click the button to only show preview plots of fluorescence 
parameters. Scatter and other parameters will not be displayed. Click the 
Unfiltered button to re-show all preview plots.

 Gate Filter: When this filter is applied, any preview plots containing 
parameters that are being used as a part of the gate equation for the 
selected plot or region are excluded from the preview. This can be used 
to reduce the number of preview plots. Click the Unfiltered button to 
re-show all preview plots.

 Show Lower Triangle: Click the button to show or hide the plots 
displayed on the lower left triangle of the Previews area.

 Show Upper Triangle: Click the button to show or hide the plots 
displayed on the upper right triangle of the Previews area.

Scaling group
The Scaling group contains options to specify the scaling for parameters in 
the Previews area. When no LMD file is open, or if a low-resolution file is 
open, the controls in the Scaling group are disabled.

The Scaling group contains the following options:

 Display as Log: The parameters displayed in the Previews area can be 
shown with either linear or logarithmic scaling. Click the arrow to expand 
a drop-down list and select the parameters to be displayed as 
logarithmic.

 V-Log: V-Log is an axis transformation that is similar to logarithmic for 
the upper three decades, but has a linear section around the axis and 
allows compensated events that have a "negative" fluorescence value to 
be better visualised. Click the button to change all the logarithmic 
parameters of the preview plots to V-Log scaling.

The V-Log scaling properties can be changed from the Scales group on 
the Parameters tab of the Ribbon (see chapter  Scales group on 
page 80).
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 Display Zoomed: If zoom levels are set for individual parameters, click 
the button to select or deselect displaying those parameter zoom settings 
in the Previews area. The default is to display parameters in the 
Previews area zoomed. For details on setting parameter zoom values, 
see chapter  Scales Properties dialogue on page 81.

View group
The View group contains options for selecting the preview plot type.

The View group contains the following control:

 Preview Plot Type: The dual parameter preview plots can be displayed 
in a choice of three formats: as density plots, colour precedence plots or 
precedence density plots (see chapter  Types of plots on page 161). 
Click the arrow to expand a drop-down list and select the desired preview 
format. The three choices are mutually exclusive.

12.4.5 Parameters tab

The Parameters tab provides controls for selecting the parameters 
displayed. The number of available parameters depends on the configuration 
of your device.

Some files contain a large number of parameters. Each parameter may be 
present with multiple signal types. To simplify parameter selection, the 
software provides options to select parameters by signal type (area, height 
and width) and further classifies parameters into "Scatter", "Fluorescence" 
and "Other" groups based on the signal source. The software will 
automatically assign parameters to these groups. If the classification is 
incorrect, you can manually reclassify parameters in the Classification tab of 
the Parameter Properties dialogue (see chapter  Parameter Properties on 
page 76).

Parameter Properties
The Parameter Properties dialogue provides the custom naming and 
parameter classification functionality of the software. To open the dialogue, 
click the Parameter Properties button or double-click the parameter name 
area of a plot in the Plots area of the Workspace.
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The Parameter Properties dialogue contains two tabs:

 On the Customize tab, you can select which parameters are displayed in 
the Previews area. You can also choose a display name and assign 
custom names to individual parameters.

 On the Classification tab, you can re-classify the group and type of a 
parameter.

When the Parameter Properties dialogue is launched, the Customize tab is 
displayed by default.

The Customize tab contains the following columns:

 The "In Use" column contains check boxes. Select a check box to display 
the corresponding parameter in the Previews area or deselect it to hide 
the parameter. Selecting and deselecting parameters here does not 
affect plots already present in the Plots area.

 The "Parameter" column displays the parameter name for each of the 
parameters available in the currently loaded listmode file.

 The "Stain" column displays the stain name for each parameter.

 The "Display Name" column allows you to select whether parameter 
name, stain name, parameter - stain name combination or a custom 
name is used as the display label for the parameter. Double-click in the 
cell or press F2 to open a drop-down list and select the desired display 
name. Once the dialogue closes, the display label is used throughout the 
system. When a new LMD file is loaded, the custom display label will be 
used only if both the parameter name and stain name for the new file 
match those in the Workspace. If they don’t match, the stain name from 
the new file is used as the display label.
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 The "Displayed Label" column displays the name as selected in the 
"Display Name" column. In the "Displayed Label" column, you can also 
enter a custom label for the parameter. The default used for the custom 
name is the Stain name ($PnS). The custom name has to be unique. It 
cannot start with a space, and it has to be a minimum of 1 character and 
can be a maximum of 50 characters.

The Customize tab contains the following buttons:

 Select All: Click the button to select all parameters.

 Select None: Click the button to de-select all parameters.

 Default Names: Click the button to reset the display names for all 
parameters to Stain.

On the Classification tab of the Parameter Properties dialogue, you can 
re-classify the group and type of a parameter. This classification is based on 
cytometer type. Modifications made here will be stored for future use of files 
from that cytometer type.

The Classification tab contains the following columns:

 The "Parameter" column displays the parameter name for each of the 
parameters available in the currently loaded listmode file.

 The "Stain" column displays the stain name for each parameter.

 The "Group" column allows you to select whether the parameter belongs 
in the Scatter, Fluorescence or Other group. Double-click in the cell or 
press F2 to open a drop-down list and select the desired group for the 
parameter.
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 The "On" column allows you to select whether the parameter belongs in 
the Height (Peak), Width (Time of Flight), Area (Integral) or Other type. 
Double-click in the cell or press F2 to open a drop-down list and select 
the desired type for the parameter.

Click the Reset to default button to reset all parameters for the currently 
loaded file to their default values.

View group
The View group contains options to select all parameters of a specific signal 
type for display in the Previews area.

The View group contains the following buttons:

 Area (Integral): The button toggles the selection of all Area / Integral 
parameters, i.e. parameters that represent the area under the curve from 
a pulse.

 Height (Peak): The button toggles the selection of all Height / Peak 
parameters, i.e. parameters that represent the peak height of a pulse. If 
the file does not contain this type of signal or if the software is unable to 
determine the signal type, this button will be disabled.

 Width (Time Of Flight): The button toggles the selection of all Width / 
Time Of Flight parameters, i.e. parameters that represent the width of a 
pulse. If the file does not contain this type of signal or if the software is 
unable to determine the signal type, this button will be disabled.

Scatter group, Fluorescence group and Other group
Individual parameters are classified into three groups: Scatter, Fluorescence 
and Other. A parameter that is selected here will appear within the plots in 
the Previews area. A parameter that is deselected will not appear within the 
plots in the Previews area. Plots already displayed in the Plots area are not 
affected by selections made here.

Parameter and stain names must be unique. If this is not the case, the 
software will automatically append either the stain or parameter name to 
ensure uniqueness.

Parameters deselected here are hidden from other parts of the software. 
You should be careful when hiding parameters which have compensation 
values applied as these values will not be visible in the compensation 
matrix.
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Hovering the cursor over a check box will open a tooltip containing the 
display name followed by the stain name for the parameter if a stain name is 
available.

The Scatter group lists the scatter parameters, forward scatter (FSC) and 
side scatter (SSC).

The Fluorescence group lists all fluorescence parameters.

If a file has a large number of fluorescence parameters, they will not all fit on 
the Ribbon. In this case, a Fluorescence drop-down arrow is displayed. Click 
the arrow to display a window listing all the available fluorescence 
parameters.

The Other group lists parameters that are not scatter or fluorescence 
parameters. Examples of parameters that would belong to this group are 
TIME and RATIO. The displayed parameter names are the parameter name, 
stain name or custom as selected in the Customize tab of the Parameter 
Properties dialogue (see  Parameter Properties on page 76).

Scales group
The Scales group contains options for adjusting the scaling and zooming of 
parameters. The Scales group is only enabled if a Worklist item or a Playlist 
item is open in the Workspace.

If you change the zoom status on a plot with a region, the region position 
does not change. You may need to reposition any regions set on zoomed 
parameters.

The Scales group contains the following options:

 The Scaling button opens the Scales Properties dialogue that is used for 
presetting scaling of parameters for display in the Workspace (see 
chapter  Scales Properties dialogue on page 81).
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 The Zoom tool allows you to modify the zoom level for parameters of a 
plot. To set or change a zoom level for parameters of the selected plot, 
select the tool and then use it to define a zoom region. On a single 
parameter plot, the tool draws a linear zoom region. On a dual parameter 
plot, the tool draws a rectangular zoom region.

The button is not available when a low-resolution LMD file is currently 
opened in the Workspace. The button is only enabled when at least one 
plot is added to the Plots area of the Workspace.

Any change in scale via the Zoom tool will update the settings in the 
Parameter Zoom tab of the Scales Properties dialogue. Any plots in the 
Plots and Previews areas that are already zoomed will update 
accordingly.

 Display Zoomed: If zoom values are defined with the Zoom tool or in the 
Parameter Zoom tab of the Scales Properties dialogue, clicking the 
button toggles between the zoomed and un-zoomed view of the currently 
selected plots.

Scales Properties dialogue
The Scaling button opens the Scales Properties dialogue that is used for 
presetting scaling of parameters for display in the Workspace.

The Scales Properties dialogue contains two tabs:

 In the Default Scaling tab, you can modify the Linear, Logarithmic and 
V-Log scaling options for parameters in the Workspace

 In the Parameter Zoom tab, you can edit the displayed scale values for 
each parameter.
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The Default Scaling tab provides the following options:

 Full Range: Select this option to scale all linear parameters in the 
Workspace and reports to the full range of data.

 1024 Channels: Select this option to scale all linear parameters in the 
Workspace and reports to 1024 channels, regardless of their full range.

When you change the linear scale, all associated statistics and results 
will be updated so they are calculated on the selected range of the linear 
scale.

For FC500 format files, the default is 1024 channels. For all other file 
types, the default selection is determined by the $PnR Keyword in the 
LMD file.

 Set Log Decades with Auto Labeling Offset: Select this option to scale 
all logarithmic parameters in the Workspace and reports to a scale based 
on the number of decades set and the resolution of data within the file.

 Set Log Decades and Label Offset: Select this option to scale all 
logarithmic parameters in the Workspace and reports to a scale based on 
the offset and number of decades specified.

 Number of Decades: This drop-down list is disabled for low-resolution 
data (less than 12-bits). For low-resolution files, the log parameter 
scaling is set according to the $PnE keyword. Click the arrow to expand 
the drop-down list and select the desired number of decades. You can 
also enter a numerical value into the input field.

When 4 Decades or 5 Decades is selected, the data for all logarithmic 
scaled parameters in the Workspace and reports will scale to display 4 or 
5 decades down from the highest value in the LMD file, respectively. 
When Full Range is selected, the data for all logarithmic scaled 
parameters in the Workspace and reports will scale to the full range of 
the data in the LMD file. Statistics and results will update accordingly.

 Offset: The number entered in this field determines the offset of the data. 
The number is converted to a Log scale when displayed on the plots e.g. 
0.1 in dialogue = 10-1 on Log scale; 10 in dialogue = 101 on Log scale; 
100 in dialogue = 102 on Log scale.

 Linearity (%): This control is used to enter a value for the linear section 
of the V-Log scale as a percent. The default value is read from the 
scaling in the software options (see chapter  Scaling page on page 189).

Enter the desired value or use the arrows to increase or decrease the 
value in the field. For example, when the linearity is set at 0%, the V-Log 
scale has a minimal linear part around 0. When the linearity is set at 50% 
half of the V-Log scale is linear. The value changes the number of data 
channels which appear within the linear section of the V-Log scale.

 Negative Section (%): This control is used to enter a value which 
determines the range of data displayed in the negative section of the 
scale. By default, the value is read in from the software options (see 
chapter  Scaling page on page 189).
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Enter the desired value or use the arrows to increase or decrease the 
value in the field. For example, when set at 100%, the number of 
decades displayed on the negative section of the scale will be the same 
as the number of decades displayed on the positive side of the scale. 
When set at 0% the number of decades displayed on the negative 
section of the scale will be 0.

 OK: Click the button to apply the changes made in the dialogue to the 
Workspace and to close the dialogue.

 Apply: Click the button if you wish to apply the changes made without 
closing the dialogue.

 Cancel: Click the button to close the dialogue and cancel all changes. 
Note that only changes made after the Apply button was clicked will be 
cancelled.

The Parameter Zoom tab lists all the parameters in the current file and 
allows you to edit the displayed scale values for each parameter in order to 
optimise the way in which your data is displayed. The selected range is only 
applied to the selected scale type (Lin, Log or V-Log). The selected zoom 
values are only applied to plots that have been selected to display zoomed 
parameters.

The Parameter Zoom tool is not available when a low-resolution LMD file is 
currently opened in the Workspace.

If you change the zoom status on a plot with a region, the region position 
does not change. You may need to reposition any regions set on zoomed 
parameters.
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The Parameter Zoom tab contains the following columns:

 The "Parameter" column contains the display name for each parameter in 
the listmode file. This column has a tooltip detailing the acceptable range 
for the Scale Min and Scale Max with respect to the scale type selected.

 The "Scale Type" column contains a box that allows the selection of the 
scale type (Lin, Log or V-Log) to which the range will be applied. The 
default scale type is set from the current Workspace. For low-resolution 
LMD files, only the scale type specified in the LMD file header is 
available. It is displayed in the "Scale Type" column and the box is read 
only.

 The "Scale Min" and "Scale Max" columns display the current minimum 
and maximum values for the scaling of a parameter. You can manually 
change these values. The values allowed for Scale Min and Scale Max 
are limited to the range indicated by the settings in the Default Scaling 
tab. When editing the "Scale Min" and "Scale Max" fields, if an error 
occurs, the corresponding values will be highlighted in red. Hover over 
the value to display a tooltip indicating the reason for error.

The Parameter Zoom tab provides the following buttons:

 Reset Selected Parameters: Click the button to reset the values for the 
currently selected parameters to their defaults.

 Reset All Parameters: Click the button to reset the values for all 
parameters to their defaults.

12.4.6 Compensation tab

The Compensation tab provides controls allowing you to calculate 
fluorescence compensation.

The correct compensation for a file can be obtained in a number of ways. 
Compensation values can be restored from the LMD file header values if the 
values were stored with the file. You can also calculate the compensation 
within the software and save these calculated values for future use. By 
default, the software will automatically load compensation values from the 
listmode file header. The status of the compensation settings of the current 
file is displayed in the status bar.

In Worklist mode, compensation modifications are applied to the 
compensation settings stored in the Workspace.

Wizard group
The Compensation Wizard is only available in Playlist mode. The 
Compensation Wizard simplifies the process of generating a full 
fluorescence compensation matrix.

Before starting the Compensation Wizard, you need to load all of the single 
stained samples and (if appropriate) the negative control sample into the 
Playlist. For ease of use, you should order the files with the negative control 
first, followed by the single stained samples in parameter order, e.g. FL1, 
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FL2, FL3, etc. You will be able to reallocate files later if required. If a single 
LMD file contains more than one positive stain, you must load in the file once 
for each stain present. The Wizard will allocate files based on the Playlist 
starting from the first file. Additional files can be present in the Playlist but 
will not be recognised by the Wizard.

Once the Playlist contains the required compensation setup files, click the 
Compensation Wizard button to launch the Wizard.

The Compensation Wizard is made up of four types of pages:

 Configuration Page

 Background Fluorescent Page (only if a negative control file is used)

 Compensation Pages (one for each selected compensation parameter)

 Review Page

Compensation Wizard: Configuration Page
The first page of the Wizard, the Configuration page, is displayed when the 
Wizard is launched. On this page, you can select the parameters you wish to 
compensate and allocate an LMD file to each of them. You can specify how 
negative control values should be calculated. You can also define the plot 
type required for definition of positive and negative populations.

The page contains the following options:

 Parameters: The list displays all the parameters from the first LMD file in 
the Playlist in the format parameter name ($PnN) - stain name ($PnS). 
Parameters identified as fluorescence are automatically selected. You 
can deselect the ones you do not want to compensate. Parameters that 
are not recognised as fluorescence parameters cannot be selected. For 
details on parameter classification and how to reclassify parameters, see 
chapter  Parameter Properties on page 76.
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 Select the parameters for the gating plot: Select the parameters for 
the primary bead / cell gating plot using the "X parameter" and "Y 
parameter" boxes. They are populated with all the parameters shown in 
the "Parameters" list.

 Select background fluorescence mode: If no background fluorescence 
control is present, select the "No background fluorescence" option. If a 
separate background fluorescence control is being used, select the "Use 
negative control file" option. If you wish to use negative events within a 
positive sample to determine the background for each sample, select the 
"Use negative regions" option.

 Select the compensation plot type: Select whether histogram plots or 
dual parameter density plots should be used for the definition of positive 
and negative events for each parameter.

 Allocate compensation parameters to listmode files: The list allows 
you to allocate one of the parameters selected for compensation to each 
LMD file. The listmode files (left-hand) side of the list shows the files from 
the Playlist, in their current order, starting from the first file. The list 
contains one LMD file for each selected compensation parameter. If the 
"Use negative control file" option is selected, the list also contains a file to 
be used as the negative control file. When the selection of parameters 
changes, the list updates accordingly.

The allocated parameters (right-hand) side of the list shows the allocated 
compensation parameters. Each row consists of a drop-down list that 
contains all the fluorescence parameters from the "Parameters" list 
selected for compensation. Selecting an item from the drop-down list 
which is already selected for a different file clears the setting for that file. 
The default allocation will be the negative control file first (if selected) 
followed by the selected parameters in the order of the "Parameters" list. 
If the listmode files list is updated (parameters selection or changing the 
"Use negative control file" selection), the allocated parameters return to 
their default allocations.

 Next: Click the button to proceed to the next page of the Wizard. If the 
"Use negative control file" option is selected, the next page is the 
Background Fluorescence page, otherwise it is the first Compensation 
page. If the selections made on the Configuration page are incorrect, you 
will not be allowed to proceed to the next page, and an appropriate error 
message will be displayed.
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Compensation Wizard: Background Fluorescent Page
The Background Fluorescence page of the Compensation Wizard is only 
displayed if the "Use negative control file" option is selected on the 
Configuration page. On this page, you will define a default gate position for 
subsequent pages and then use a region to define the negative events for 
each parameter.

The page contains the following options:

 Negative control file: The field displays the name of the negative control 
LMD file that will be used for the background fluorescence computation.

 Adjust gating region: The gating region plot is an ungated dual 
parameter density plot. The X and Y parameters on the plot are those 
selected on the Configuration page. The plot contains a single 
rectangular blue coloured region that can be moved and resized as 
required to define the gating region. Any adjustment of the region 
automatically updates the background fluorescence plot.

 Adjust negative region: The negative region plot is gated on the gating 
region and used to define the negative population for the X parameter of 
the current plot. A region needs to be defined for each parameter to be 
compensated. The plot will be either a histogram or dual parameter 
density plot depending on the selection on the Configuration Page. The 
plot contains a single red coloured region that can be moved and resized 
as required to define the negative events.

 Select Y parameter: If the negative region plot is a dual parameter plot, 
you can change the Y parameter in this box.

 Parameters List: The list contains all fluorescence parameters that are 
selected for compensation on the Configuration page. The currently 
selected parameter is highlighted in the list. Parameters which have had 
the negative region configured are indicated by a tick in the check box.

 Next: If not all of the parameters listed in the Parameters list have been 
configured, clicking the button will select the next unconfigured 
parameter in the list. When all parameters have been configured, the 
button will proceed to the first Compensation page of the Wizard.
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Compensation Wizard: Compensation Pages
A  Compensation page will be displayed once for each selected 
compensation parameter.

The page contains the following options:

 Stain for compensation: The field displays the stain that is being 
currently compensated.

 Stain listmode file: The field displays the name of the listmode file used 
for the compensation calculation.

 Adjust gating region: The gating region plot is an ungated dual 
parameter density plot. The X and Y parameters on the plot are those 
selected on the Configuration page. The plot contains a single 
rectangular blue coloured region that can be moved and resized as 
required to define the gating region. Any adjustment of the region 
automatically updates the compensation plot and the calculated 
compensation matrix.

 Adjust compensation and negative regions: The compensation plot is 
a single or dual parameter plot depending on the selection on the 
Configuration Page. The plot is gated on the gating region plot. The X 
parameter on the plot is the current compensation parameter.

The compensation plot contains a green coloured region used to specify 
the positive population for that stain. If you have selected the "Use 
negative regions" option on the Configuration page, the compensation 
plot also contains a red coloured region which is used to specify the 
background fluorescence population. You can move and resize the 
regions. Adjusting the regions updates the calculated compensation 
matrix.

 Select Y parameter: If the compensation plot is a dual parameter plot, 
you can change the Y parameter in this box.

 Calculated compensation matrix: The matrix displays the currently 
calculated compensation coefficients. The top and bottom channels of 
the plot are excluded from the calculations.
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 Back: Selecting the button returns you to the previous page of the 
Compensation Wizard. The Back button on the first Compensation page 
is disabled if the "Use negative control file" option was not selected.

 Next: Selecting the button proceeds to the next Compensation page or to 
the Review page when on the last Compensation page.

Compensation Wizard: Review Page

 The page contains the following options:

 Compensation matrix: The matrix displays the completed matrix of 
compensation values.

 Print...: Click the button to print the compensation matrix.

 Compensation file: The field displays the destination path and file name 
for the compensation file. Click the Browse button to specify the 
destination and name for the compensation file. The compensation file is 
not saved at this time.

 Apply compensation file to playlist: Select the check box if you wish to 
replace the current compensation values in the Workspace with the 
newly calculated compensation coefficients.

 Finish: Click the button to complete the Compensation Wizard and save 
the compensation file with the specified name.

Plot Compensation group
The Plot Compensation group contains options to adjust the compensation 
on the current sample using plots in the Plots area. Populations can be 
dragged into position or accurately adjusted using the arrow buttons. Mean 
or Median values for the current plot can be used to help set the correct 
compensation.
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The Plot Compensation group contains the following options:

 Plot Compensation: To enable plot compensation, select a plot in the 
Plots area that contains the parameters required for compensation and 
then click the button. The button is highlighted, and the arrow buttons 
and manual dragging of populations on plots in the Plots area are 
enabled. The Plot Compensation button will be unavailable if a plot is 
selected which does not contain compensable parameters, for example 
Time or Scatter parameters.

When Plot Compensation is enabled, the selected plot shows a diagonal 
line from bottom left to top right to assist with drag/drop compensation. 
Then either click and drag a population into the correct position or use 
the arrow buttons to move the population to the required position.

 Comp %: The fields display the current compensation values for the pair 
of parameters present on the currently selected plot. The top (X) field 
shows the subtraction of the Y-parameter from the X-parameter. The 
bottom (Y) field shows the subtraction of the X-parameter from the 
Y-parameter. The fields allow the entry of compensation values. Up to six 
characters can be entered into the fields in the range 0.00 to 100.00. 
Entered values are rounded to 2 decimal places.

 Compensation Arrows: The arrow buttons allow the fine adjustments of 
compensation % values. Use the top row of arrows to increase/decrease 
the X compensation value by 0.1/by 0.01. Use the bottom row of arrows 
to increase/decrease the Y compensation value by 0.1/by 0.01. 
Compensation values are limited to the range 0.00 to 100.00. The 
direction of the arrow icons indicates the way the plot populations move 
rather than the way the compensation values change.

 Quadrant Region: Click the button and then click onto a dual parameter 
plot to insert a quadrant on a dual parameter plot. For information on 
quadrant regions, see chapter  Creating regions on page 165.

 Quadrant Statistics: Statistics are displayed when the current listmode 
file is compensable, a dual parameter plot displaying compensable 
parameters is selected, and the plot contains a quadrant region. If the 
statistic cannot be calculated due to insufficient events, the edit field will 
show "ERROR". If multiple quadrant regions are present on the plot, the 
statistics are only displayed for the quadrant region set created first.

1 Original plot (gated)
2 Plot after manual compensation

1 2
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Click the Mean/Median button to select whether the mean or median 
statistic is displayed for the quadrant region (default: "Median").

Click the X Stats/Y Stats button to select whether the displayed statistics 
are for the X parameter or the Y parameter (default: "X Stats").

Preview Details group
Controls in the Preview Details group contains options to manually adjust the 
compensation of the current sample using the preview plots and also to 
display the compensation percentage on the preview plots. The buttons in 
the group are only enabled when a compensable LMD file is loaded in the 
Workspace.

The Preview Details group contains the following option:

 Show Compensation %: Click the button to display or hide the 
compensation coefficients for each parameter combination on all dual 
parameter preview plots. Compensation coefficients are only displayed 
on preview plots that have two relevant fluorescence parameters.

Compensation group
The Compensation group contains options for displaying the compensation 
matrix, for clearing the current compensation matrix and for loading the 
compensation settings from the current file header.

The Compensation group contains the following options:

 Show Matrix: Click the button to display the Compensation Matrix 
dialogue. The dialogue shows the compensation matrix associated with 
the current file.

Click the Print button to print the compensation matrix. The default font 
size for printing the matrix is 10 pt. If the matrix does not fit in the printing 
area, the font size for the print out of the matrix will be reduced. If the 
minimum font size is reached and the matrix still cannot fit in the printing 
area, the printout switches layout (from portrait to landscape or vice 
versa) and the fitting procedure is applied again. If the matrix still cannot 
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fit, the printout of the matrix is cropped, and a corresponding message is 
displayed at the end of printing.

Click the Size to Fit button to resize the Compensation Matrix dialogue 
to fit the size of the current matrix. This is restricted by the screen size of 
your monitor.

 Clear Compensation: Click the button to clear the active compensation. 
All coefficients in the currently active matrix will be reset to 0.00%. This 
action will not clear the calculated compensation matrix stored in 
memory. The button is only enabled when a compensable listmode file is 
open in the Workspace.

 Load Compensation From Headers: Click the button to retrieve the 
compensation matrix from the current LMD file headers and apply it as 
the active compensation matrix. The button is only enabled when a 
compensable LMD file is loaded in the Workspace.

 Display Calculated Compensation: The button is only enabled when a 
compensation setup panel is active and acquisition is not in progress. 
Click the button to display the calculated compensation matrix.

12.4.7 Statistics tab

The Statistics tab provides controls for selecting which statistic is displayed 
on each plot in the Plots area and which statistic is presented in the 
associated results table in the Workspace.

The Statistics tab behaves differently depending on which tab in the 
Workspace area is selected:

 When in the Plots tab of the Workspace, only one statistic can be 
selected at any time. The currently selected statistic is displayed adjacent 
to the region for all regions on all plots in the Plots area. If you select a 
new statistic, the previously selected one is automatically cleared. By 
default, the %Gated statistic is displayed on plots. The controls in the 
General group and the DNA Statistics group are disabled as these 
statistics cannot be displayed on plots.

 When in the Results tab of the Workspace, any number of statistics can 
be selected and the statistical values for the selected statistics are 
displayed in the results table. For details of the display of statistics in the 
Results tab, see chapter 12.8.2 Results tab of the Workspace on 
page 171.

 When in the Reports tab of the Workspace, the Statistics tab is only 
enabled when a Stats Box is selected. Statistical values for the selected 
statistics are displayed in the Stats Box.
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Results Tables group

The Results Tables group provides options for working with tables on the 
Results tab of the Workspace.

The Results Table group contains the following options:

 Add Table: Click the button to create a new results table.

 Tables: To show an existing results table, click the arrow to expand a 
drop-down list and select the desired table.

 Delete Current Table: Click the button to delete the current results table.

 Send Table To...: Click the arrow to expand a drop-down list and select 
a destination to send the current results table to.

 Filter Table: Click the button to filter the current results table. The 
Listmode Files dialogue is displayed.

To filter by listmode files, select the file names of the listmode file(s) to 
filter the statistics.

To add a new filter, click the Add Filter button. The Add/Edit Filter 
dialogue is displayed. Select the statistics to filter on, select the type of 
filter and select or enter the desired filter value(s).

General group
The items selected in this group are displayed in the results table and in 
selected Stats Boxes on the reports.

The following items can be selected:

 X Parameter displays the X parameter of the plot containing the region.

 Y Parameter displays the Y parameter of the plot containing the region.

 Gate displays the name of the gate on which the region is gated.
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 Region displays the name of the region or the DNA plot name.

 Filename displays the LMD file name.

 File Path displays the LMD full path and file name.

 Plot Title displays the title of the plot.

 FCS Key 1 and FCS Key 2 displays the respective FCS keywords. The 
items are disabled in Worklist mode.

Events group
The items selected in this group are displayed on Plots, in the results table 
and in selected Stats Boxes on the reports.

The following items can be selected:

 Count displays the number of events in the region.

 % Gated displays the percentage of events in the region compared to all 
the events in the parent gate. Results will not be truncated, so any 
statistic that is too large to appear on a plot will be hidden. You can 
display just the region name by ensuring all check boxes are deselected.

 % Total displays the percentage of events in the region compared to all 
the events in the file.

Intensity group
The items selected in this group are displayed on Plots, in the results table 
and in selected Stats Boxes on the reports. The Intensity group displays 
statistical options that express the intensity of the generated populations.

The following items can be selected:

 X Peak displays the peak channel (mode) for the X-axis histogram of a 
region.

 Y Peak displays the peak channel (mode) for the Y-axis histogram of a 
region. Where the region is only a single parameter region, the entry on 
the results table is left blank.

 X Median displays the median average for the X-axis histogram of a 
region.

 Y Median displays the median average for the Y-axis histogram of a 
region. Where the region is only a single parameter region, the entry on 
the results table is left blank.
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 X Mean displays the mean average for the X-axis histogram of a region.

 Y Mean displays the mean average for the Y-axis histogram of a region. 
Where the region is only a single parameter region, the entry on the 
results table is left blank.

Variation group
The items selected in this group are displayed on Plots, in the results table 
and in selected Stats Boxes on the reports. The Variation group displays 
options that express the variation of populations.

The following items can be selected:

 X Var displays the variance for the X-axis histogram of a region.

 Y Var displays the variance for the Y-axis histogram of a region. Where 
the region is only a single parameter region the entry on the results table 
is left blank.

 X SD displays the standard deviation for the X-axis histogram of a region.

 Y SD displays the standard deviation for the Y-axis histogram of a region. 
Where the region is only a single parameter region the entry on the 
results table is left blank.

 X %CV displays the Coefficient of Variation for the X scale range of 
events. This allows comparison of the variation of populations that have 
significantly different mean values. The X %CV is calculated by dividing 
the standard deviation by the arithmetic mean and is displayed as a 
percentage.

 Y %CV displays the Coefficient of Variation for the Y scale range of 
events. This allows comparison of the variation of populations that have 
significantly different mean values. The Y %CV is calculated by dividing 
the standard deviation by the arithmetic mean and is displayed as a 
percentage.

 X %HP-CV displays the Half-Peak Coefficient of Variation for the X scale 
range of events. The X %HP-CV uses a standard deviation calculated 
from the scale width between the half peak points either side of the Peak. 
Once the standard deviation is calculated, it is divided by the arithmetic 
mean and displayed as a percentage.

 Y %HP-CV displays the Half-Peak Coefficient of Variation for the Y scale 
range of events. The Y %HP-CV uses a standard deviation calculated 
from the scale width between the half peak points either side of the Peak. 
Once the standard deviation is calculated it is divided by the arithmetic 
mean and displayed as a percentage.
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DNA Statistics group
The DNA Statistics group displays the statistical options associated with the 
DNA cell cycle plots.

The items selected in this group are displayed in the results table and in 
selected Stats Boxes on the reports. When a cell cycle plot is present in the 
Plots area, the statistics in the DNA Statistics group are selected by default.

The following items can be selected:

 DNA Stats: Select the check box to display all DNA statistics for all 
regions in the results table.

 Show Stats List: Click the button and open the "DNA Statistics" 
drop-down list to access the individual DNA statistic settings:

 %G1 displays events in the G1 phase, represented as a percentage of 
the total of events in G1, G2 and S phase.

 %S displays events in the S phase, represented as a percentage of the 
total of events in G1, G2 and S phase.

 %G2 displays events in the G2 phase, represented as a percentage of 
the total of events in G1, G2 and S phase.

 G1 %CV displays the Coefficient of Variation for the G1 phase. This is 
calculated by dividing the G1 phase standard deviation by the arithmetic 
mean and is displayed as a percentage.

 G2 %CV displays the Coefficient of Variation for the G2 phase. This is 
calculated by dividing the G2 phase standard deviation by the arithmetic 
mean and is displayed as a percentage.

 G1 Channel displays the position of the G1 calculated peak channel.

 G2 Channel displays the position of the G2 calculated peak channel.

 Est. Method displays the estimate method used. This can be Automatic 
or User.

 Sub G1 displays the number of events above the lower threshold divider 
and below the G1 phase.

 Above G2 displays the number of events below the upper threshold 
divider and above the G2 phase.

 Debris displays the number of DNA debris events. These are the events 
outside the threshold limits.

 G1 Events displays the number of events in the G1 phase.

 S Events displays the number of events in the S phase.

 G2 Events displays the number of events in the G2 phase.
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12.4.8 Worklist tab

The Worklist tab provides controls for modification of all aspects of a Worklist 
including Worklist items, panels, Workspace files and instrument settings.

The Worklist tab is only available in Worklist mode.

General group
The General group contains options to open, save and edit a Worklist.

The General group contains the following buttons:

 New Worklist: Click the button to create a new Worklist

 Open Worklist: Click the button to open an existing Worklist.

 Save: Click the button to save the current Worklist with the same name.

 Save As: Click the button to save the current Worklist with a new name.

 Select Columns: Click the button to open a dialogue to customise the 
Worklist:

To display or hide the columns in the Worklist, select or deselect the 
check boxes next to the columns. Some check boxes are disabled, the 
corresponding columns are always displayed.

Columns can be reordered by dragging and dropping except for the first 
three columns.

The "Lab #" and "Sample ID" columns can be renamed by 
double-clicking on the name and entering a new name of up to 30 
characters. A "locked" icon on the right of a column name indicates that 
the name cannot be changed.

To get back to the default settings, click the Defaults button in the 
dialogue.

For a description of the columns, see chapter 12.6 Worklist pane on 
page 146.

 Clear LMD: Click the menu item to clear the listmode data from the 
Worklist item. The check mark in the "Acquired" column is no longer 
displayed indicating that new data can be acquired on this Worklist item. 
This option is only available if data are acquired on this Worklist item.

 Clear Item: The option is only enabled if a single Worklist item is 
selected that is the first or last item of a panel. Click the menu item to 
clear all settings from the Worklist item. This option is only available if no 
data are acquired on this Worklist item.
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Panel group
The Panel group contains options to edit a panel of the Worklist.

The Panel group contains the following buttons:

 Save: Click the button to save the panel with the same name.

 Save as: Click the button to save the panel with a new name.

When saving a panel, the full path and file extension are stripped and the 
Workspace name is used as an identifier. If there are multiple Workspace 
files present within the panel with the same name, a unique identifier is 
added to the Workspace file name to differentiate the Workspace files.

 Replace: Click the panel to replace the panel. When replacing a panel, 
the selected panel in the Worklist will be removed, and the chosen panel 
will be inserted into the Worklist, with the first item of the panel at the 
same position the first item of the previous panel was at.

 Add Item: Click the button to add an item to the panel. The option will 
duplicate the last row in the panel. The option is only enabled when at 
least one undefined item is directly below the panel.

 Clear Panel: Click the button to clear the panel from the Worklist and to 
reset the corresponding Worklist items to an undefined state. The option 
is disabled if LMD files are present in any of the selected panels.

Workspace group
The Workspace group contains options to edit the Workspace.

The Workspace group contains the following buttons:

 New Workspace: Click the button to create a new Workspace file. The 
option will create a default Workspace file for the selected Worklist item. 
The option is disabled when more than one Worklist item is selected or 
when a compensation setup panel is active.

 Save: Click the button to save the Workspace file with the same name.

 Save As: Click the button to save the Workspace file with a new name.

 Replace: Click the button to replace a Workspace file.
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Instrument Settings group
The Instrument Settings group contains options to save or replace 
instrument settings files.

The Instrument Settings group contains the following buttons:

 Save: Click the button to save the instrument settings file with the same 
name. The threshold, threshold logic, voltages and compensation 
settings will be saved to the target file.

 Save As: Click the button to save the instrument settings file with a new 
name.

 Replace: Click the button to replace an instrument settings file.

Calculation group
The Calculation group contains options to switch between automatic 
background calculation and manually triggered calculation.

The Calculation group contains the following options:

 Background Calculation: Select the check box to turn on the automatic 
background calculation. All statistics in the Results tab and objects in the 
Reports tab of the Workspace are calculated in the background as the 
active panel is modified. This applies to all items within the active panel.

Deselect the check box to turn off the automatic background calculation. 
You may want to turn off background calculation when you are using a 
Worklist containing very large files which are taking a long while to 
process.

 Calculate Now: The button is enabled when the "Background 
Calculation" check box is deselected. Click the button to start calculation 
of statistics in the Results tab and objects in the Reports tabs of the 
Workspace for all items in the current panel.

The calculation progress is displayed in a corresponding message box. 
Closing the message will stop the calculations.

The calculation progress is indicated by the calculation indicator in the status 
bar (see chapter 12.9 Status bar on page 184).
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12.4.9 Playlist tab

The Playlist tab provides controls for modification of all aspects of a Playlist 
including Playlist items, Playlist files, Workspace files and compensation 
files.

The Playlist tab is only available in Playlist mode.

Listmode group
The Listmode group contains options to modify the listmode files in the 
Playlist.

The Listmode group contains the following buttons:

 Replace: The button is enabled when one or more Playlist items are 
selected in the Playlist. To replace the selected Playlist items, click the 
button and select the desired replacement listmode file(s).

If the number of selected items in the Playlist does not match the number 
of the selected replacement listmode files, a confirmation message is 
displayed. To replace as many files as possible, click the Yes button.

Check the Playlist after replacement to ensure all the selected files have 
been inserted into the expected positions.

If any of the selected Playlist items have modified compensation, a 
message is displayed and you will have the option to keep the modified 
compensation files in the Playlist. They are then applied to the replaced 
listmode files.

 Clear: The button is only enabled when one or more Playlist items are 
selected and at least one of them has an associated listmode file. Click 
the Clear button to replace the listmode files in the selected items with a 
blank listmode item. If the currently open listmode file is amongst the files 
selected for clearing, plot data will be removed. The Workspace and 
compensation files set in the Playlist are not affected.

When replacing listmode files, mismatches can occur leading to error notes:

 Parameter Mismatch: A parameter mismatch can occur between the 
listmode file and the Workspace file of an item. To successfully replace 
the listmode file, the parameter mismatch must be resolved. If the 
mismatch is not resolved, the listmode file is not replaced and the error 
state remains displayed in the Playlist.

If the Playlist item is open in the Workspace, the Parameter Resolver 
dialogue is displayed allowing you to resolve the mismatch.

If the Playlist item is not open in the Workspace, an error state is 
displayed in the Playlist for that Playlist item. The Playlist item text is 
displayed in red and contains a corresponding tooltip. Open the Playlist 
item in the Workspace to open the Parameter Resolver dialogue.
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 Scaling Mismatch: A mismatch between listmode and Workspace scale 
can occur. In this case, the LMD file is replaced, and the Workspace is 
modified to match the LMD file settings. Any zoom settings that have 
been applied are reset. A corresponding message is displayed as soon 
as the LMD file is opened in the Workspace. As long as mismatched 
LMD files are not open in the Workspace, they are coloured orange in the 
Playlist and contain a corresponding tooltip.

 Compensation Values When Replacing Listmode: If the Playlist item 
has no associated compensation file, compensation values will be 
obtained from the new listmode file. If the Playlist item has an associated 
compensation file, compensation values will be obtained from the 
compensation file.

If a parameter mismatch occurs, opening the LMD file will remove the 
compensation file applied from the Playlist. A corresponding message is 
displayed. Select Yes to replace the listmode and remove the 
compensation file applied. Select No if you do not wish to replace the 
listmode file.

If the Playlist item has a modified compensation, a corresponding 
message is displayed. Select Yes to keep all modified compensation files 
in the Playlist and apply them to the replaced LMD file. Select No to clear 
the modified compensation values. The compensation values in the 
replacement LMD file will be used instead. Select Cancel to cancel the 
replacement of the listmode file.

Workspace group
The Workspace group contains options to modify the Workspace file 
associated with Playlist items.

The Workspace group contains the following buttons:

 Replace: The button is enabled when one or more Playlist items are 
selected in the Playlist. To replace the Workspace for the selected 
Playlist items, click the button and select the desired replacement 
Workspace.

When replacing Workspace files, a parameter mismatch may occur 
between the listmode file of the Playlist item and the Workspace file. If 
the Playlist item is open in the Workspace, the Parameter Resolver 
dialogue is displayed allowing you to resolve the mismatch. If the Playlist 
item is not open in the Workspace, an error state is displayed in the 
Playlist for that Playlist item. The Playlist item text is displayed in red and 
contains a corresponding tooltip. Open the Playlist item in the Workspace 
to open the Parameter Resolver dialogue.

 Save as: The button is enabled when a single Playlist item containing a 
Workspace is selected in the Playlist. Click the button to save the current 
Workspace file with a new file name.
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 Clear: The button is enabled when one or more Playlist items are 
selected in the Playlist. Click the button to replace the Workspace files in 
the selected items with the default blank Workspace. The listmode and 
compensation files are not affected. Clearing the Workspace file of an 
open Playlist item will clear the Plots area only.

 Copy: The button is enabled when one or more Playlist items are 
selected and all of them contain a Workspace. Click the button to copy 
the Workspace files of the selected Playlist items to the clipboard. They 
can only be pasted to other Playlist items.

 Paste: The button becomes enabled when there is a Workspace file 
copied to the clipboard.

If a single Workspace file is copied, clicking the Paste button will paste 
the clipboard’s Workspace file into all selected items in the Playlist.

If multiple Workspace files are copied, clicking the Paste button will paste 
the clipboard’s Workspace files into the selected items in the Playlist. 
Pasted Workspace files will be pasted in the same order in which they 
appeared in the Playlist when copied. If you attempt to paste more items 
than are currently selected in the Playlist, as many items as possible will 
be pasted, any excess items will be ignored. If the target selection 
contains more Playlist items than the clipboard contains copied 
Workspace files, the pasted Workspace files will be repeated until all 
selected Playlist items are pasted a Workspace file.

After pasting Workspace files, make sure that the positions of regions are 
correct for the individual listmode files.

Compensation group
The Compensation group contains options to modify compensation files in 
the Playlist.

The Compensation group contains the following buttons:

 Replace: The button is enabled when one or more Playlist items are 
selected in the Playlist and at least one of the selected Playlist items is 
compensable. To replace the compensation file(s) of the selected items, 
click the button and select the desired replacement compensation file. If 
the Playlist item contains a low-resolution LMD file, the compensation file 
is not opened for this item, and a corresponding message is displayed.

If the compensation for the current file is replaced with a file that is not 
compatible with the listmode file (e.g. parameter mismatch), the 
compensation file is not opened, and a corresponding message is 
displayed.

If the compensation for a file not currently open is replaced with a file that 
is not compatible with the listmode file, the item turns red and contains a 
tooltip. If you open this Playlist item in the Workspace, a message is 
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displayed and you will have the option to abort opening the listmode file 
or to open the listmode file and remove the compensation file from the 
Playlist item.

 Save As: The button is enabled when a single compensable Playlist item 
is selected in the Playlist. Click the button to save the current 
compensation file with a new file name.

 Copy: The button is enabled when at least one of the selected items 
contains a compensable listmode file and/or compensation file. Click the 
button to copy the compensation files of the selected item(s) to the 
clipboard. They can then be pasted into the Playlist.

 Paste: The button becomes enabled when there is a compensation file 
from the Playlist copied into the clipboard and at least one of the selected 
items is compensable.

If a single compensation file is copied, clicking the Paste button will paste 
the clipboards’ compensation file into all selected items in the Playlist.

If multiple compensation files are copied, clicking the Paste button will 
paste the clipboards’ compensation files into the relevant selected items 
in the Playlist. Pasted compensation files will be pasted in the same 
order in which they appeared in the Playlist when copied. If you attempt 
to paste more items than are currently selected in the Playlist, as many 
items as possible will be pasted, any excess items will be ignored. If the 
target selection contains more Playlist items than the clipboard contains 
copied compensation files, the pasted compensation files will be 
repeated until all selected Playlist items are pasted a compensation file.

When pasting a single or multiple compensation files, the parameters in 
the compensation files may not match those in the listmode file. In this 
case, the copied compensation files will be applied to the compatible 
items in the Playlist but not to the incompatible ones, and a 
corresponding message is displayed.

If the parameters do not match and the item is not currently open, the 
message will only be displayed when you try to open the item containing 
the incompatible listmode and compensation files.

 Use listmode: The button is enabled when at least one of the selected 
Playlist items is compensable. 

Click the button to replace the compensation files of all items containing 
a high-resolution data file with the compensation settings stored in the 
FCS file headers. Any selected items that don’t contain high-resolution 
data will not be updated, and a corresponding message will be displayed.
CyFlow® Cube 8 | Operating Manual | May 2018 | Revision 032 103



12 Software description
Calculation group
The Calculation group contains options to switch between automatic 
background calculation and manually triggered calculation.

The Calculation group contains the following options:

 Background Calculation: Select the check box to turn on the automatic 
background calculation. All statistics in the Results and Reports tabs of 
the Workspace are updated constantly in the background as the Playlist 
is modified. Whilst the software calculates plots, statistics, compensation 
matrix and fields, the corresponding report item will display a question 
mark. As soon as the new or updated plots, statistics, compensation 
matrix and/or field are calculated, they will be displayed on the report. 
Uncalculated statistics do not appear on the results table. Any printing 
operations will wait for background calculation to be completed.

Deselect the check box to turn off the automatic background calculation. 
You may want to turn off background calculation when you are using a 
Playlist containing very large files which are taking a long while to 
process.

 Calculate Now: The button is enabled when the "Background 
Calculation" check box is deselected. Click the button to start calculation 
of all statistics in the Results tab and objects in the Reports tab of the 
Workspace. The calculation progress is displayed in a corresponding 
message box. Closing the message will stop the calculations.

The calculation progress is indicated by the calculation indicator in the status 
bar (see chapter 12.9 Status bar on page 184).
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12.4.10 Cytometer tab

The Cytometer tab provides controls to start cleaning procedures of the 
device, to sort cells if a cell sorter is connected, and to prepare 
compensation settings for measurements.

Cleaning group
The Cleaning group contains options for starting priming and cleaning 
procedures.

The Cleaning group contains the following options:

 Script Selection: In this box, the intensity of the cleaning procedure to 
be performed can be preselected. Click the arrow to expand a drop-down 
list containing the scripts specified for the level of cleaning functions and 
select the desired intensity. The "Default" option is the generally used 
cleaning level. The "Deep" option preselects a thorough procedure, the 
"Quick" option preselects a short cleaning procedure.

 De-bubble: Click the button to start a procedure to clear bubbles from 
the flow cuvette. Once started, the software guides you through the 
process.

 De-clog: Click the button to start a procedure to clear residual particles 
from the device lines when clogged. Once started, the software guides 
you through the process.

 Prime: Click the button to start a priming procedure. Once started, the 
software guides you through the process.

 Clean: Click the button to start a cleaning procedure. Once started, the 
software guides you through the process.

Sort group

The Sort  group is only displayed if the necessary sorter upgrade is 
connected and ready to use.
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Compensation Settings group
The Compensation Settings group contains options to create a fluorescence 
compensation setup panel in the Worklist. The options are only available if 
an empty Worklist item is selected but not opened in the Workspace.

Click the Create Comp Panel button and select a Workspace file (CyFlow 
acquisition Workspace files only) to use as a source for the compensation 
setup panel. From this Workspace file, the parameters and instrument 
settings (voltages, trigger logic and threshold information) are derived.

The Create Compensation Panel dialogue is displayed.

The Create Compensation Panel dialogue contains the following options:

 Select Parameters for Gating: Click the buttons to display drop-down 
lists and select the desired X and Y parameters for gating. These 
parameters will be used for the X-axis and Y-axis of gating plots within 
the negative control sample (if selected), the compensation calculation 
Workspaces and the verification tube (if selected). The drop-down lists 
contain all parameters in the selected Workspace file. By default, the first 
parameter of the list is used for the X-axis, the second parameter of the 
list is used for the Y-axis.
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 Compensation Control Workspaces: The option selected here defines 
the type of Workspaces that are created for the compensation setup 
panel.

The "No negative control" option is the default selection. This will create a 
compensation control Workspace for each of the classified fluorescence 
parameters present within the original Workspace selected.

The "Negative control sample" option will add a negative control Worklist 
item and Workspace within the compensation setup panel which will run 
a negative control for baseline background measurement.

The "Use negative regions" option will add a negative region to each of 
the fluorescence plots within the compensation control Workspaces.

 Verification Workspace: Selecting the "Include Verification Workspace" 
check box will add a verification item to the compensation setup panel. 
The verification item will include a verification Workspace and the 
instrument settings file of the compensation setup panel.

 Prefix Name and Save Location: If desired, enter a prefix name for the 
Workspace, panel and settings file created by the compensation setup 
procedure. The default name will be the name of the original Workspace 
file selected. The default save location will be the last location used. If 
desired, click the Browse button to select another file for the created 
compensation settings file to be saved.

On clicking the OK button, the required compensation setup panel, 
Workspaces and instrument settings file will be created. The created panel 
will be inserted into the Worklist.

The created files will be named as follows:

 Panel: <prefix name>-SetupPanel.xml

 Voltage adjust Workspace: <prefix name>voltage.xmlws

 Negative Control Workspace: <prefix name>negative.xmlws

 Compensation Workspace: <prefix name>compX.xmlws

 Compensation Workspace with negative regions: <prefix 
name>compXNegRegion.xmlws

 Verification Workspace: <prefix name>verification.xmlws Instrument

 Settings File: <prefix name>settings.xml

Compensation setup panel
The compensation setup panel will be created using the selections made in 
the Create Compensation Panel dialogue. The created Workspaces are 
placed in the compensation setup panel. The parameters selected will show 
scaling as dictated by the original Workspace file. The panel is set to load 
the instrument settings from the associated instrument settings file. The 
instrument settings file contains the voltages, trigger logic and threshold 
information from the selected source Workspace file.
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The compensation setup panel is made up of the following components and 
always appears in this order:

 Voltage adjust Workspace (always present):

 Negative control sample Workspace (optional):

 Compensation control Workspaces – one per fluorescence parameter 
(always present):
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 Verification Workspace (optional):

When acquisition is completed on the last compensation Workspace or, if 
existing, on the verification sample, the calculated compensation matrix is 
displayed.

12.4.11 Overlay tab

The Overlay tab provides controls for creating single and dual parameter plot 
overlays. Overlay plots can be used to compare plots. The overlay plots are 
displayed in the Overlays tab of the Workspace (see chapter 12.8.3 Overlays 
tab of the Workspace on page 174).

Wizard group
The Overlay Wizard is only available in Playlist mode. The Overlay Wizard 
simplifies the process of generating overlay plots from a Playlist of samples.

Before starting the Overlay Wizard, make sure Workspaces in the Playlist 
are the same for all files.

Click the Overlay Wizard button to launch the Wizard.

The Overlay Wizard is made up of four types of pages:

 Welcome Page,

 Plot Selection Page,

 Overlay Layout Page,

 Overlay Labels Page.
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Overlay Wizard: Welcome Page
The Welcome page introduces you to the Wizard’s functionality.

Click the Next button to proceed to the Plot Selection page of the Wizard.

Overlay Wizard: Plot Selection Page
The Plot Selection page contains options to select the required plots to 
create an overlay plot.

A list of the plots from the current Workspace is displayed. By selecting a 
line of the list, the line is highlighted and a preview of the corresponding plot 
is displayed.

For each plot, the list displays the item number for the Workspace containing 
the plot, the X and Y parameters and the gate.

To add a plot to the overlay plot, select the check box next to the relevant 
plot in the list.

The page contains the following options:

 Plot Order: Plots appear in the created overlay plot in the order they 
appear in the plot list. To change the order, click the up/down arrows to 
move selected plots up and down in the list. To reset the plot order, use 
the Reset button.

 Plot Selection: Click the Select All or Select None buttons to easily 
select or deselect all plots. To display only the plots which you have 
selected for the overlays, select the "Show only selected plots" check 
box.

 Next: Click the button to proceed to the Overlay Plot Selection page.
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Overlay Wizard: Overlay Layout Page
The Overlay Layout Page contains options to define how the plots you have 
selected will be added to the overlay plot.

The page contains the following options:

 Display all plots from all files together: Select the option to display all 
the selected plots from all the files in the Playlist on one overlay plot. If 
you have selected both single and dual parameter plots, these are 
arranged on separate overlay plots.

 Display all plots from the same file together: Select the option to 
display all the selected plots from each file in the Playlist on one overlay 
plot. Each file in the Playlist is displayed on a new overlay plot. If you 
have selected both single and dual parameter plots, these are arranged 
on separate overlay plots.

 Display the same plots from all files together: Select the option to 
display the same plot from all the files in the Playlist on one overlay plot. 
Different plots are displayed on separate overlay plots.

 Maximum number of plots in each overlay: Enter a maximum number 
of plots on one overlay plot. If the number of plots selected exceeds this 
number, additional overlay plots are created as required.

 Wizard Summary: This section displays the number of single parameter 
and the number of dual parameter plots selected and details how many 
overlay plots are created based on the selections made above.
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Overlay Wizard: Overlay Labels Page
This page contains options to define titles and legends to be displayed in the 
Overlays tab of the Workspace.

The page contains the following options:

 Overlay Title: Enter a title for the overlay plot.

 Gallery Title: Enter a title for the Galleries area of the Workspace.

 Overlay Legend: Select the "Show Overlay Legend" check box and 
enter a label to display a legend next to the overlay plot in the Overlays 
area of the Workspace.

 Reset to default: Click the button to reset the corresponding title or 
legend to its default name.

Region group
The Region group contains options for creating and editing regions. You can 
create a maximum of 256 regions per Workspace. Once this number is 
reached, the region creation buttons in the Region group become disabled.

The Region group contains the following options:

 Elliptical Region: Click the button to preselect creating an elliptical 
region on a dual parameter plot.

 Rectangular Region: Click the button to preselect creating a rectangular 
region on a dual parameter plot.

 Polygonal Region: Click the button to preselect creating a polygonal 
region on a dual parameter plot.

 Linear Region: Click the button to preselect creating a linear region on a 
single parameter plot.
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 Quadrant Region: Click the button to preselect creating a quadrant 
region on a dual parameter plot.

 Region Position: Select a region on a plot and click the button to modify 
the position of the selected region as described for the Region Format 
tab (see chapter  Position group on page 129).

For further information on defining and editing regions, see chapter  Creating 
regions on page 165.

Plots group
The Plots group contains options to insert plots from the Plots area of the 
Workspace into overlay plots.

The Plots group contains the following button:

 Insert Plot: The button is only enabled when an overlay plot is selected 
in the Overlays area of the Workspace. Click the button to display a 
drop-down selection of all the plots currently open in the Plots 
Workspace. The plots appear in the order they appear in the Workspace 
when in Gallery view. When hovering the cursor over a plot, plots that are 
not part of the current overlay plot will be highlighted. Click on the desired 
highlighted plot to insert it into the current overlay plot.

Plots that are not highlighted are already part of the current overlay plot 
and cannot be added again.

Galleries View group
The Galleries View group contains options to modify the way in which plots 
are displayed in the Galleries area.

The Galleries View group contains the following button:

 Wrap Galleries: The button controls the display of gallery plots for each 
overlay plot in single or multiple rows. Click the button to display the 
gallery plots on multiple rows if necessary to fit the current window width.

Edit group
The Edit group contains options to copy, delete and select plots in the Plots 
area and to edit the fonts of text items in the current Workspace.
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The Edit group contains the following buttons:

 Copy: Click the button to copy an image of the currently selected plot(s) 
onto the clipboard. You can then paste them into other applications 
(Microsoft® Word, PowerPoint, etc.).

 Delete: Click the button to delete the currently selected plots or region. If 
the deleted plot has a region applied, deleting the plot also deletes the 
region and removes the region from any gating logic. In this case, a 
corresponding message box is displayed and you will have the option to 
confirm or abort deleting the plot.

 Select: Click the button and select an option for selecting plots:

Click the Select All Overlay Plots option to select all the plots in the 
Overlays area.

Click the Select All Gallery Plots option to select all the gallery plots for 
the currently selected Overlay Plot. This option is only available when 
one overlay is active.

Click the Invert Selection option to select all the plots that are currently 
not selected in the Overlays area or the Galleries area. This option is 
only enabled if either a selection is made or when only one overlay is 
active.

Click the Select All Dual Parameter Overlay Plots or Select All 
Histogram Overlay Plots to select all dual parameter or all histogram 
overlay plots respectively.

 Fonts: Click the button to open the Edit Overlay Fonts dialogue. In the 
pages of this dialogue, you can change the font typeface and size for the 
region labels, plot titles, parameter names, legend/stats text and scale 
labels displayed in the Overlays tab of the Workspace. The pages are the 
same as in the software options (see chapter  Font pages on page 192).

12.4.12 Report tab

The Report tab provides controls for creating page-based reports from a 
Playlist or from a panel of a Worklist. The Report tab allows you to add and 
set up report pages, insert objects and text into the report and edit and 
organise the objects on the report. The reports are displayed in the Reports 
tab of the Workspace (see chapter 12.8.4 Reports tab of the Workspace on 
page 179).

Wizard group
The Report Wizard is only available in Playlist mode. The Report Wizard 
simplifies the process of creating a report.

When creating a report via the Wizard, the current report page size and 
orientation will be used, and any existing header and footer content will be 
retained. Therefore, before starting the Report Wizard, set the report page 
size and orientation using the Page Setup group of the Report tab and insert 
the desired header and footer content using the Insert group of the Report 
tab.
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The Wizard retains settings until you open or create a new Playlist.

Click the Report Wizard button to launch the Wizard. The button is disabled 
when there are no plots in the Workspace.

The Report Wizard is made up of five types of pages:

 Welcome Page,

 Plots Selection Page,

 Statistics Layout Page,

 Statistics Selection Page,

 Report Layout Page.

Report Wizard: Welcome page
The Welcome page introduces you to the Wizard’s functionality.

Click the Next button to proceed to the Plots Selection page of the Wizard.

Report Wizard: Plots Selection page
The Plots Selection page enables you to pick the required plots for the report 
that will be created by the Wizard.

A list of the plots of the current Workspace is displayed. By selecting a line of 
the list, the line is highlighted and a preview of the corresponding plot is 
displayed.
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For each plot, the list displays the item number for the Workspace containing 
the plot, the X and Y parameters and the gate.

To add a plot to the report, select the check box next to this plot. During a 
session of using the same Playlist when rerunning the Wizard, previously 
checked plots will be remembered. Changing the Playlist or closing the 
software loses these settings.

The page contains the following options:

 Plot Order: Plots appear in the report in the order they appear in the plot 
list. To change the order, click the up/down arrows to move selected 
plots up and down in the list. To reset the plot order, use the Reset 
button.

 Plot Selection: Click the Select All or Select None buttons to select or 
deselect all plots. To display only the plots which you have selected for 
the report, select the "Show only selected plots" check box.

 Next: Click the button to proceed to the Statistics Layout page.

Report Wizard: Statistics Layout page
The Statistics Layout page enables you to select the required statistics for 
the report and their layout on the report. A preview of the layout of the 
statistics on the page is displayed.

The page contains the following options:

 Display Statistics on Report: Select the check box to display statistics 
on the generated report.

 Per Plot: Select the option to display the statistics next to the associated 
plot. Select the desired position for the display of statistics (to the right, to 
the left, below or above the plot).

 Per Playlist: Select the option if you would like all statistics displayed 
together at the end of the Playlist report. To start statistics on a new page 
of the report, select the "Display statistics on a new page" check box.

 Next: Click the button to proceed to the next page of the Wizard.
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Report Wizard: Statistics Selection page
This page is only available if the "Display Statistics on Report" check box 
was selected on the Statistics Layout page. The Statistics Selection page 
enables you to select the required statistics and the order in which they are 
displayed on the report.

The page contains the following options:

 Select statistics types from: By default, all statistics are available for 
selection. Use the box to view a reduced group of statistics.

 Add: Click the button to add a selected statistic to the "Selected 
statistics" list. By default, the "Selected statistics" list is populated only 
with the statistics that are selected in the Results tab of the Workspace.

 Remove: Click the button to remove a selected statistic from the 
"Selected statistics" list. 

 Arrow buttons: Statistics appear in the generated report in the order 
they appear in the "Selected Statistics" list. To change the order, click the 
up/down arrows to move selected statistics up and down in the list.

 Reset: Click the button to reset the selected statistics to their state when 
the page was first displayed.

Report Wizard: Report Layout page
The Report Layout page enables you to select the required report layout.
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The page contains the following options:

 Plots per page: Use the drop-down list to specify the number of plots 
per page in the report. When not reporting statistics or when statistics are 
aggregated at the end of the report, you can have 1, 4, 9 or 20 plots per 
page. When reporting statistics, the options are 1, 2 or 3 plots per page.

 Display plots from the same file together: Select the option if you 
would like plots from the same file to be kept together in the report. Each 
section has all the plots belonging to the same file.

 Display the same plots from all files together: Select the option if you 
would like the same plots from all files displayed together. Each section 
has all the plots with the same parameters.

 Use separator: Select the check box to separate sections in the 
generated report and select whether to separate them with a line or 
starting on a new page.

 Finish: Click the button to complete the Wizard. The Wizard closes and 
the report is generated. If the report requires more than 800 pages, you 
are warned via a message box. Select OK to close the message. The 
Report Wizard remains open to enable you to make changes to the 
required report.

Edit group
The Edit group contains options to select and delete objects on the report.

The Edit group contains the following options:

 Delete: Click the button or press the Delete key on the keyboard to 
delete all currently selected objects.

 Select: Click the button to display a drop-down list and select the desired 
option:

Click the Select All menu item to select all objects from the body 
sections of all pages in the report. Objects in the headers and footers are 
not selected.

The Select All of Same Type menu item is only enabled when a single 
object is selected in the report. Click the menu item to select all objects of 
the same type as the currently selected item from the body sections of all 
pages in the report. If an object in the header or footer is selected, 
clicking the menu item will select all corresponding instances of that 
object in the body sections of all pages in the report. The object originally 
selected in the header or footer will no longer be selected.

Click the Select All Header and Footer menu item to select all objects in 
the header and footer sections of all pages in the report.
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Pages group
The Pages group contains options to add new pages to the report and to 
organise the pages of the report.

The Pages group contains the following options:

 Add New Page: Click the button to add a new blank page to the end of 
the report. All new pages are assigned a unique number, which is 
displayed at the top left-hand corner. All new pages display a "Page X of 
Y" in the bottom right-hand corner. Up to 800 pages can be added to the 
Report. When the maximum number of pages is reached, the Add New 
Page button is disabled.

 Organize Pages: Click the button to display the "Organize Report 
Pages" dialogue. A list of all pages is displayed. Select the desired page 
and click the corresponding button to insert a page before or after the 
selected page, to move the page up or down, to delete the page or to 
delete all pages.

A newly inserted page is given the next available unique number 
(between 1 and 800) and has the suffix "(new)" in the dialogue. The 
naming is a temporary name which will be updated when the dialogue is 
closed and reopened.

A maximum of 800 pages can be inserted into each report. When this 
limit is reached, the Insert Page Before button is disabled.

To preview a page in the Workspace, double-click on the page in the list.

Click the OK button to close the "Organize Report Pages" dialogue and 
accept the changes made to the report pages. Click the Cancel button to 
close the "Organize Report Pages" dialogue and cancel any changes 
made to the report pages.

Page Setup group
The Page Setup group contains options to change the orientation and size of 
the pages in the report.

The Page Setup group contains the following options:

 Orientation: Click the button to display a drop-down list and select the 
desired page orientation (portrait or landscape). The page orientation to 
all pages in the report is changed. All header, footer and body objects 
that lie outside the bounds of the new page are automatically resized to 
fit the new orientation. If the orientation is then switched back, any 
resized objects are not restored to their original size or position. In order 
to restore pages exactly as they were, click the Undo button in the Quick 
Access Toolbar.
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The option selected here will take precedence over that selected in the 
"Print Setup" dialogue.

 Size: Click the button to display a drop-down list and select the desired 
page size (A4 or letter). The page size for all pages in the report is 
changed. All header, footer and body objects that lie outside the bounds 
of the new page size are automatically resized to fit the new size. If the 
size is then switched back, any resized objects are not restored to their 
original size or position. In order to restore pages exactly as they were, 
click the Undo button in the Quick Access Toolbar.

If there is a mismatch between the paper size set in the "Print Setup" and 
the size selected here, the page will be automatically scaled to fit the 
paper when printing.

Insert group
The Insert group contains options to insert objects into the report. The 
controls are only enabled when you are on the Reports tab of the 
Workspace. To insert an object into the report, first select it with the buttons 
described below, then click on the report to insert the object in default size or 
draw out a rectangle of the desired size. For more information on inserting, 
resizing and moving objects in the report, see chapter 12.8.4 Reports tab of 
the Workspace on page 179.

The Insert group contains the following buttons:

 Plot: Click the Plot button to display a drop-down gallery of all the plots 
currently open in the Workspace. The order in which the plots appear 
matches the order they appear in the Workspace when in Gallery view. 
To select a plot for insertion into the report, click on the desired plot.

 Stats Box: Click the button to display a drop-down gallery of all the plots 
currently open in the Workspace. The order in which the plots appear 
matches the order they appear in the Workspace when in Gallery view. 
Click on a plot to select the corresponding statistics box for insertion into 
the report.

 Plot and Stats Box: Click the button to display a drop-down gallery of all 
the plots currently open in the Workspace. The order in which the plots 
appear matches the order they appear in the Workspace when in Gallery 
view. Click on a plot to select the plot and the corresponding statistics 
box for insertion into the report.

 Comp Matrix: The button is only enabled when an LMD file is open. 
Click the button to select the compensation matrix for insertion into the 
report.

 Field: The button is only enabled when an LMD file is open. Click the 
button to open a drop-down list and select a report item for insertion into 
the report.
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In the "Report Item" drop-down list, the page number, date and time, user 
name, file names and/or file paths with file names of the currently open 
files can be selected.

In the "Primary Keyword" and "Secondary Keyword" submenus, the 
primary and secondary keywords from the currently open LMD file can be 
selected.

 Image: Click the button and navigate to the desired folder to select an 
image file for insertion into the report. Only image files with the extension 
".jpg", ".gif", ".bmp" and ".png" are supported. If required, use the "Save 
as Type" drop-down list to display pictures of a viable file type.

Click the Open button or double-click on the image file to insert the 
selected image file into the report. If the inserted image lies outside the 
bounds of the page, it is automatically resized. Images are inserted into 
the body section of a page by default. They can, however, be moved into 
the header or footer.

 Text box: Click the button to select a text box for insertion. Click on the 
report page at the point where you wish to place the text box. Double 
click on the text box to enter the desired text. You may need to resize the 
text box.

 Line: Click the button to select a line for insertion. Click on the report 
page at the point where you wish to place the line.

Text group
The Text group contains controls for editing and organising of text.

Select a text box, statistics box, compensation matrix and/or field and use 
the options in the Text group to edit the font typeface, font size, font style 
(bold, italic, underlined) and colour of the selected object.

Select a text box and/or a field and use the alignment buttons (align left, 
centre, align right) to align the text.

Format group
The Format group contains options to format items in the report.

The Format group contains the following options:

 Line End Cap: The box is enabled when one or more line objects are 
selected in the report. Click the arrow to expand a drop-down list and 
select the desired option for the line end (uncapped, solid arrowhead or 
line arrowhead).
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 Line Colour: The button is enabled when one or more line objects are 
selected in the report. Click the button and select the desired colour for 
the currently selected lines.

 Sort Stats: The button is enabled when a statistics box is selected in 
reports. It is also enabled when multiple statistics boxes are selected 
provided the selected statistics boxes contain exactly the same statistics.

Click the button to display the "Sort Statistics" dialogue. Use the up/down 
arrows to define the left to right column order. Select the statistic to sort 
rows by and whether to sort rows in ascending or descending order as 
required.

 Dash Style: The box is enabled when one or more line objects are 
selected in the report. Click the arrow to display a drop-down list and 
select the desired dash style.

 Line Width: The control is enabled when one or more line objects are 
selected in the report. The default line width for inserted lines is 1.00 pt. 
Type in the desired width or use the up/down arrows to adjust the width. 
The line width must be between 0.25 pts and 50 pts.

 Edit Text: The button is only enabled when a single text box is selected 
in the report. Click the button and enter the desired text into the edit field. 
The maximum number of characters is 8000.

 Textbox Filled: The check box is only enabled when one or more text 
boxes or fields are selected in the report. Select the check box to show 
the selected text boxes filled.

Arrange group
The Arrange group contains options to move, align and resize report items.

The Arrange group contains the following options:

 Bring To Front: The button is enabled when one or more objects are 
selected on the same page and section (header, footer, body). Click the 
button to move the selected objects to the front of the view, making them 
appear on top of non-selected objects.

 Send To Back: The button is enabled when one or more objects are 
selected on the same page and section. Click the button to move the 
selected objects to the back of the view, making them appear behind 
non-selected objects.

 Align: The button is enabled when two or more objects on the same 
page and section are selected. Click the button to display a drop-down 
list and select how to align the selected objects. When aligning objects, 
they are subject to a bounds check. If an object lies outside the bounds 
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®

of the page after it has been aligned, it is automatically repositioned to fit 
on the page.

 Resize: The button allows for adjusting two or more objects to the same 
height, width or size. First select the object that displays the target size, 
then select the objects to resize. Click the button to display a drop-down 
list and select whether to make the objects the same height, the same 
width or the same size as the first selected object.

When plots are selected in the objects to resize, their aspect ratios are 
always maintained. Using the "Make Same Size" option, the plots are 
sized to the smallest dimension (height or width) of the first selected 
object.

Zoom
The Zoom group contains options to zoom in and out on the page using 
predefined and custom percentages.

Click the Zoom button to display a dialogue and use the dialogue options to 
zoom in and zoom out as required.

12.4.13 Views tab

The Views tab provides controls to define the panes that are available.

Click the corresponding button to select or deselect viewing the following 
panes:

 Acquire pane,

 Stops pane,

 Parameter Settings pane,

 Setup pane,

 FCS File Information pane,

 Results Hierarchy pane.

A button is highlighted in orange if the corresponding pane is available for 
viewing.

Default Position: Click the button to view all panes in their default position. 
The default position for the Worklist is docked to the bottom of the 
Workspace. The default position for the Playlist is docked and pinned to the 
left-hand side of the Workspace. The default position of the other panes is 
docked, pinned and nested together on the left-hand side of the Workspace.

The view settings selected here are persisted between sessions.
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12.4.14 Plot Format tab

The Plot Format tab is only available when at least one plot is selected in the 
Plots area of the Workspace (see chapter 12.8.1 Plots tab of the Workspace 
on page 160).

The Plot Format tab contains controls to adjust the settings of selected plots 
in the Plots area.

Plot Type group
The Plot Type group contains options to format dual parameter plots as 
density plots, colour precedence plots or precedence density plots. For 
information on the plot types, see chapter 12.8.1 Plots tab of the Workspace 
on page 160.

The group also contains options for formatting single parameter plots as 
histogram or cell cycle plots.

The Plot Type group contains the following options:

 Density: Select one or more dual parameter plots and click the button to 
display the selected plots as density plots. The dual parameter plots in 
the Plots area are density plots by default.

 Color Precedence: Select one or more dual parameter plots and click 
the button to display the selected plots as colour precedence plots.

 Precedence Density: Select one or more dual parameter plots and click 
the button to display the selected plots as precedence density plots.

 Histogram: Select one or more single parameter plots and click the 
button to display the selected plots as histograms. The single parameter 
plots in the Plots area are standard histogram plots by default.

 Cell Cycle: Select one or more single parameter plots and click the 
button to display the selected plots as DNA cell cycle plots (see chapter  
DNA cell cycle plots on page 169). Each cell cycle is identified 
numerically with the title "Cell Cycle #".

 Reset Cell Cycle: The button is only enabled when a cell cycle plot is 
selected. If the G1 and/or G2 markers have been manually adjusted, 
clicking the Reset Cell Cycle button returns the markers to their 
automatically calculated positions.
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Gate group
The Gate group contains an option to choose a gate to be applied to 
selected plots.

Click the drop-down arrow positioned on the Gate group to display a list of all 
the available gates. Click the desired gate from this list to apply the gate to 
selected plots.

X-Axis group
The X-Axis group contains options to change the X-axis of the selected plots 
to the linear, logarithmic or V-Log scale type.

If a low-resolution file is open, the axis parameters are set by the information 
within the LMD file header and cannot be changed. The X-axis buttons are 
disabled for low-resolution files and if cell-cycle plots have been selected.

For information on the available plot scaling types, see chapter  Scaling on 
page 168.

The X-Axis group contains the following options:

 Linear, Logarithmic, V-Log: Select the desired plots in the Plots area. If 
the selected plots have different axis types, multiple axis buttons will be 
highlighted. Click the desired button to apply the axis selection to the 
selected plots.

Y-Axis group
The Y-Axis group contains options to change the Y-axis of the selected plots 
to the linear, logarithmic or V-Log scale type.

If a low-resolution file is open, the axis parameters are set by the information 
within the LMD file header and cannot be changed. The Y-axis buttons are 
disabled for low-resolution files and if single parameter histogram plots have 
been selected.

For information on the available plot scaling types, see chapter  Scaling on 
page 168.

The Y-Axis group contains the following options:

 Linear, Logarithmic, V-Log: Select the desired plots in the Plots area. If 
the selected plots have different axis types, multiple axis buttons will be 
highlighted. Click the desired button to apply the axis selection to the 
selected plots.
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Histogram Scaling group
The Histogram Scaling group contains options for scaling of the selected 
histograms for optimal plot visualisation. By default, the software scales the 
histogram plots to the maximum value on the plot. The automatic scaling 
ignores events in the first and last sixteen channels, unless there are no 
events in the remaining channels.

The Histogram Scaling group contains the following option:

 Manual Scale: The check box is enabled if at least one histogram plot is 
selected. Check the check box to turn off the automatic scaling. For 
manual scaling, enter the desired scaling value into the edit field and 
press Enter. 

Histogram Smoothing group
The purpose of smoothing is to improve the visual display of histograms for 
presentation purposes. The underlying data and statistics are not altered. 
Smoothing can only be applied to single parameter histograms.

Two methods of smoothing are available: Bin Reduction and Moving 
Average. In the Bin Reduction method of smoothing, the values of 
consecutive bins are averaged to produce a histogram with a reduced 
number of bins. The software implements 4 levels of bin reduction. Each 
level has the number of bins displayed on the plot: Level 1 (bin count 1024; 
no smoothing), Level 2 (bin count 512), Level 3 (bin count 256), Level 4 (bin 
count 128).

In the Moving Average method of smoothing, the average value of a number 
of consecutive bins (window size) of the raw histogram is used in the first bin 
in the window. This is repeated for the next bin until the whole histogram has 
been covered. The process can be repeated a number of times to produce 
an increasingly smoothed graph. There are ten levels of smoothing available 
by this method. The level 1 setting is the same as no smoothing.

The Histogram Smoothing group contains the following options:

 Histogram Smoothing: The button is enabled when one or more single 
parameter plots are selected. The button displays the currently active 
smoothing method. To change the smoothing method, click the arrow to 
open the drop-down list and select the desired option (none, bin 
reduction, moving average). The selected method is applied to all 
currently selected plots. Plot smoothing is displayed on the reports, print 
preview and printout. The smoothing settings are saved as part of the 
Workspace whenever the Workspace or the Playlist are saved. Applying 
smoothing to plots does not affect statistical results.
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 Histogram Smoothing Level Selection Slider: The slider is only visible 
if a smoothing method (bin reduction, moving average) is selected.

When Bin Reduction is selected, the slider has 4 tick marks representing 
levels 1 – 4. Level 1 (1024 bins) is no smoothing. When Moving Average 
is selected, the slider has 10 tick marks, representing levels 1 – 10. Level 
1 is no smoothing, level 10 is the greatest level of smoothing. The 
currently selected level in the slider is marked by an arrow.

Click the "minus" button or to the left of the arrow on the slider to 
decrease the level by one. Click the "plus" button or to the right of the 
arrow on the slider to increase the level by one. The level can also be 
changed by dragging and dropping the arrow with the mouse.

The smoothing level selected is applied to all currently selected single 
parameter histograms and cell cycle plots. The default setting is level 1 
(No smoothing). The level setting for each method is persisted for each 
plot and saved in the Workspace.

Histogram Styles group
The Histogram Styles group contains options to choose colour and filling of 
the selected histograms. By default, histograms are displayed using the 
colour specified in the software options (see chapter  General page on 
page 187).

The Histogram Styles group contains the following options:

 Histogram Color: Click the button and select the desired colour to 
modify the line and fill colour of the selected histogram(s) in the Plots 
area.

 Draw Filled: Check the check box to fill the selected histograms of the 
current file with the colour set with the Histogram Color button. The 
"Draw Filled" selection is saved in the Workspace.
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12.4.15 Region Format tab

The Region Format tab is only available when a region is selected in the 
Plots area.

You can use the options on the Region Format tab to modify the appearance 
and type of a selected region. The region label can also be repositioned and 
regions can be tracked to other regions.

Appearance group
The Appearance group contains options to change region colour, rename a 
region and reselect the automatic positioning of region names.

The Appearance group contains the following options:

 Region Name: The box displays the name of the currently selected 
region. To change the region name, enter a name or select a name from 
the drop-down list. The region name on the plot and in the box will 
update.

The drop-down list is populated with the names provided on the Region 
page in the software options (see chapter  Region page on page 188). 

A region name can also be changed by double-clicking on the region 
name on the plot.

Try to avoid applying long region names. If a name is too long, the region 
label will not be displayed on the plot. You should use region names that 
are significantly different.

 Region Color: Click the button to display a colour control and select the 
desired colour for the region.

The region colour on the plot will update. If the region has an associated 
gate, changing the region colour will not change the gate colour. The 
gate colour can be changed using the Edit Gates button in the Analyze 
tab (see chapter  Gate group on page 69).

 Automatic Region Name Position: Once a region has been created, a 
unique name for the region is automatically generated. The region name 
and associated statistic are displayed adjacent to the region. You can 
position the name as desired within the limits of the plot. To return a 
region name to its default position, select the region and click the 
Automatic Region Name Position button.
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Type group
The Type group contains options to change the type of a selected region.

The region type of the currently selected region is highlighted. To change the 
region to another type (elliptical, rectangular or polygonal region), click the 
respective button.

Position group
The positioning of created elliptical, rectangular, linear and quadrant regions 
can be modified by selecting a region and clicking the Region Position 
button. The button is disabled if a polygonal region is selected.

A dialogue is launched that allows for precise definition of position and size 
of the region.

Depending on the type of the selected region, the corresponding dialogue is 
displayed:

 Ellipse: To position the centre of the elliptical region, use the "Center X" 
and "Center Y" input fields. A lower value positions the centre to the left 
or down, respectively. The values must be between -1500 and 1500.

To define the width of the X-axis of the ellipse, use the "Major Axis size" 
input field. To define the width of the Y-axis of the ellipse, use the "Minor 
Axis size" input field. The size values must fall between 0 and 1023.

To rotate the ellipse, enter the desired number of degrees into the 
"Rotation(degrees)" input field. Rotation limits are -360° to 360°.

 Rectangle: Use the input fields to define the positions of the left side 
("Lower X"), the bottom side ("Lower Y"), the right side ("Upper X") and 
the top side ("Upper Y") of the rectangle. A lower value positions the side 
of the rectangle to the left or down, respectively. The values must be an 
integer between 0 and 1023.

 Linear: Use the input fields to define the positions of the left point 
("Lower bound") and of the right point ("Upper bound") of the linear 
region. A lower value positions the respective point to the left. The values 
must be an integer between 0 and 1023.

 Quadrant: To choose between straight and bendy quadrant region, 
select the corresponding option (see chapter  Creating regions on 
page 165).

Use the "Center X" input field to position the quadrant intercept on the 
X-axis. Increase the value to shift the intercept to the right. Decrease the 
value to shift the intercept to the left.
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Use the "Center Y" input field to position the quadrant intercept on the 
Y-axis. Increase the value to shift the intercept upwards. Decrease the 
value to shift the intercept downwards.

The "Bendy X" and "Bendy Y" input fields are disabled when the 
"Straight" option is selected.

Use the "Bendy X" input field to position the ‘bent’ upper divider edge on 
the X-axis. Increase the value to shift the divider edge to the right. 
Decrease the value to shift the divider edge to the left. "Bendy X" values 
must be greater than the "Center X" value.

Use the "Bendy Y" input field to position the ‘bent’ right divider edge on 
the Y-axis. Increase the value to shift the divider edge upwards. 
Decrease the value to shift the divider edge downwards. "Bendy Y" 
values must be greater than the "Center Y" value.

All values must be an integer between 0 and 1023.

Tracking group
The Tracking group contains an option to link region positions on plots that 
display the same parameters. If one of the linked regions is changed, all the 
linked regions are adjusted simultaneously.

The Tracking group contains the following option:

 Region Tracking: To link one region to another, first select the region 
and then click the drop-down arrow of the box. If the currently selected 
region can’t be linked to any regions, the only option in the box is "(Not 
tracking)". If there are regions to which the currently selected region can 
be linked, the drop-down list displays them. Select the region you would 
like the currently selected region to be linked to. The selected region 
inherits its position from the "linked to" region and is now displayed in the 
"Region Tracking" field.

A region is only linked to one region and once it has been linked it will be 
removed from the "Region Tracking" list.

Moving any linked region will move all tracking regions.

To unlink linked regions, select each region and select "(Not Tracking)" 
from the "Region Tracking" list.
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The rules to link regions are:

 Only regions that are on plots that display the same parameters can be 
linked.

 A maximum of 256 regions can be linked for each opened Workspace.

 A linear region can only be linked to another linear region.

 For linked linear regions, only movement in a horizontal direction of the 
selected region is reflected in the rest of the region in the linked group, 
i.e. they can be set to different vertical positions.

 Elliptical, rectangular and polygonal regions can be linked to one another, 
however, if regions are of different types, linking them changes them to 
the same type as the "linked to" region.

 Quadrant regions cannot be part of a linked region.

 Once regions are linked, only the "linked to" region appears in the 
drop-down list when other compatible regions are selected.

 When a "linked to" region is deleted, the regions linked to it change to 
"(Not Tracking)". Deleting a linked region has no effect on the linked 
status of the remaining regions.

12.4.16 Overlay Format tab

The Overlay Format tab is only available when at least one plot is selected in 
the Overlays tab of the Workspace (see chapter 12.8.3 Overlays tab of the 
Workspace on page 174).

The Overlay Format tab provides controls to edit overlay plots.

Format group
The Format group contains options to adjust line and fill styles of overlay and 
gallery plots, also options for the display of plots, scaling and legend.

Use colour selection with caution as it is possible to choose the same colour 
for data, background and filling, most importantly if white is used.
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The Format group contains the following options:

 Background: Select this option to choose a background colour for all 
selected plots. If overlay plots are selected, this option also affects the 
corresponding gallery plots.

 Data Color: Select this option to choose a colour for all data displayed 
on the selected plots. If overlay plots are selected, this option also affects 
the corresponding gallery plots.

 Translucency: Select this option to choose a translucency percentage 
for all data on the selected plots. Translucency can improve the 
visualisation of overlapping populations. The option displays a 
translucency percentage selection control where 0% is non-translucent 
and 80% is the maximum level of translucency.

 Draw Filled: Click the button to show the selected plots filled.

 Fill Color: The option is available when filled plots are selected. Select 
this option to choose a fill colour for the selected plots.

 Gray Scale: The button toggles the colour display of selected plot(s) 
between the standard colour palette and a grey scale. When selected, 
the button is highlighted in orange. Then, the "Data Color" and "Fill Color" 
options display a grey scale palette instead of a colour palette. The 
"Background" option always displays a colour palette.

 Dash Style: Select this option to choose a dash style for the selected 
plots. If overlay plots are selected, this option also affects the 
corresponding gallery plots.

 Line Width: Enter a value or use the up/down arrows to adjust the line 
width in the selected plots. If overlay plots are selected, this option also 
affects the corresponding gallery plots.

 Stats on Plot: The button toggles between displaying the statistics on a 
gallery plot and at the side of the plot. If not all results appear in the 
legend, a warning icon is displayed.

 X-axis Ticks, Y-axis Ticks: Select the options to display the tick marks 
of the respective axis of the currently selected plot(s). Scale tick marks 
are only displayed on the overlay plot if the scaling is identical for all 
plots.

 X-axis label, Y-axis label: Select the options to display the labels of the 
respective axis of the currently selected plot(s).

 Legend: Select this option to display the plot legend at the side of the 
selected overlay plots. For each plot, the overlay line colour and a 
description are displayed. The default description is the X-axis label. Dual 
parameter overlay plots have both X- and Y-axis labels displayed.

To modify the legend label, double-click on the label and enter the 
required text or change the plot axis labels in the Galleries area. If there 
are too many items present in the legend and not all legend text appears, 
a warning icon is displayed.
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 Show Plot: The button is available when one or more plots are selected 
in the Galleries area. Select this option to display the selected plots in the 
overlay plot. Deselect this option to remove selected plots from the 
overlay plot. Any plots in the gallery which are not hidden will display a 
"Not Displayed" icon in the Galleries area. This icon is not visible in 
reports or copied and pasted images.

Overlays group
The Overlays group contains buttons to switch the available views for the 
overlay plot from overlay mode to 3D mode. The buttons are available when 
one or more plots are selected in the Overlays area. The highlighted button 
indicates the current mode of the selected plot(s). When different modes are 
present in the selected plots, no button will be highlighted.

The Overlays group contains the following options:

 Overlay Mode: Click the button to change all selected overlay plots to 
display in overlay mode.

 3D Mode: Click the button to change all selected overlay plots to display 
in 3D mode.

Histogram Scaling group
The Histogram Scaling group contains options to control the scale settings 
for histograms in both the Overlay and Galleries areas. These options are 
mutually exclusive. Select an overlay plot to apply the selected scale option 
to all gallery plots of the selected overlay plot. Select one or more gallery 
plots to apply the selected scale option to only the selected plots.

The Histogram Scaling group contains the following options:

 Scale to 100%: The option scales all selected plots to their maximum 
values. If a control plot is present in the Galleries area, the control and 
test histograms are each scaled to their maximum values.

 Peak Scaling: The option is only useful if a control plot is present in the 
Galleries area. When this option is selected, the control and test 
histogram are both scaled to the highest scale factor of either histogram. 
If no control plot is set, "Scale to 100%" and "Peak Scaling" have the 
same values.

 Manual Scaling: The option will apply the selected custom value to all 
selected plots. Enter a value and press Enter to apply that value to all 
selected plots.
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Controls group
The options in this group are available for single parameter overlay plots 
only. They allow one plot within a gallery to be displayed as control on all 
other plots within the gallery of the current overlay plot.

The Controls group contains the following options:

 Set Control: The button is available when a single gallery plot is 
selected. Click the button to display the plot as a control on all gallery 
plots of the current overlay plot. The gallery plot set as a control displays 
a dashed border.

If a control plot is already set, selecting another plot as a control will 
replace the currently set control with the new selection on all plots within 
the gallery.

 Remove Control: The button is available when a plot is set as a control 
for the gallery. This option removes the control plot from all plots in the 
gallery.

 Control Front: Select this option to display the control plot in front of the 
plot data. Deselect the option to display the control plot in the 
background of the plot data.

Calculations group
The buttons in this group are available when one or more single parameter 
plots are selected in either the Overlay or Galleries area and the current plot 
has a control already set.

When a control is set, two calculation options are available to compare test 
and control plots: Overton or K-S comparison statistics. The selected 
calculation will be applied to all plots within the selected overlay plot.

The Calculations group contains the following options:

 None: The button is highlighted by default indicating that no calculation is 
being displayed for the current plot.

 Overton mode: The option shows the positive result after subtraction of 
the control histogram from the test. The subtraction algorithm is a 
cumulative subtraction routine based on that published by Roy Overton in 
Cytometry 9:619-626 (1988).

 K-S: The Kolmogorov–Smirnov test (K–S test) is a nonparametric test 
method for comparing two samples, the control and test plots. The 
maximum vertical deviation between the two curves is reported as the 
statistic D.
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Histogram Smoothing group
The options in the Histogram Smoothing group are available when single 
parameter plots in a gallery or an overlay plot containing single parameter 
plots are selected.

The options allow smoothing to be applied to histogram plots to improve the 
visual appearance without affecting statistical results. For information on 
histogram smoothing options, see chapter  Histogram Smoothing group on 
page 126.

3D group

The 3D group contains the following option:

 Angle (deg.): The option is available when an overlay plot in 3D mode is 
selected. Enter a value or use the up/down arrows to rotate the 3D 
overlay plot between 5 and 85 degrees.
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12.5 Panes

In the panes of the software window, the functions for acquiring data are 
provided, and informations concerning the currently open Worklist item or 
Playlist item are displayed.

The panes that are available in the panes area can be selected and 
deselected in the Views tab of the Ribbon (see chapter 12.4.13 Views tab on 
page 123). To get back to the default view, click the Default Position button 
in the Views tab of the Ribbon.

The panes can be positioned on the screen as required (see chapter 12.2 
Views of the software window on page 52). To get back to the default view, 
click the Default Position button in the Views tab of the Ribbon.

The Playlist pane is only displayed in Playlist mode and is described in a 
separate chapter (see chapter 12.7 Playlist pane on page 154). The Playlist 
pane is displayed in the panes area by default.

The Worklist pane is only displayed in Worklist mode and is described in a 
separate chapter (see chapter 12.6 Worklist pane on page 146). The 
Worklist pane is docked to the bottom of the Workspace area by default.

The other panes are described in this chapter and comprise:

 FCS File Information pane,

 Results Hierarchy pane,

 Settings pane,

 Acquire pane,

 Setup pane.
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12.5.1 FCS File Information pane

This pane displays as a title the name of the currently active FCS file. In 
Worklist mode, the title is only displayed if an FCS file is present.

Beneath the title, the pane displays information on the currently open FCS 
file. The file information comprises file path, header, parameters, 
compensation and other information.

In Worklist mode, the "compensation" section displays the compensation 
matrix of the listmode file associated with the currently active Worklist item.

The pane contains the following option:

 Send to Report...: To send file information to the report, click the button 
to open a drop-down list. Select the desired information to be sent to the 
report: header, parameters, compensation, other information or all 
information.
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12.5.2 Results Hierarchy pane

This pane displays as a title the name of the currently active FCS file. In 
Worklist mode, the title is only displayed if an FCS file is present.

Beneath the title, the pane displays the count of ungated events and count 
and percentage of gated events in a hierarchical view.
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12.5.3 Settings pane

This pane displays a table of settings for the parameters. In Playlist mode, 
the table is empty and the options are disabled. In Worklist mode, the table 
entries can be edited for the samples to be measured. For samples already 
measured, the table is read only.

The table contains the following columns:

 Parameter: The column displays the default parameter name for each 
parameter.

 Name: The column displays the parameter name as selected in the 
Customize tab of the Parameter Properties dialogue (see chapter  
Parameter Properties on page 76). The name of a parameter can be 
manually edited by double-clicking on the manual entry field.

 Logic: The column defines which parameter data are triggered. By 
default, the first parameter (FSC) is selected ("ON"), the other 
parameters are deselected ("OFF").

To edit, click the desired row of the column and click the arrow to expand 
a drop-down list. Select one parameter to be triggered ("ON").

For the other parameters, select "AND" to record data of both the "ON" 
parameter and the current parameter. Select "OR" to trigger data of 
either the "ON" parameter or the current parameter. Select "OFF" to 
exclude data of the current parameter from the trigger.

 Threshold: The column defines the threshold value for an event to be 
recorded. The threshold allows cutting off background by setting a lower 
limit of the acquired data in the corresponding parameter. To edit, enter a 
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value or use the up/down arrows. Threshold limits are between 1 and 
2000. Threshold value can only be set when logic is not deactivated (off).

 Voltage: The voltage of the individual optical parameters defines the 
photomultiplier signal amplification and therefore the signal intensity to be 
displayed. To edit, enter a value or use the up/down arrows. Voltage 
limits are between 1 V and 1000 V.

12.5.4 Acquire pane

The Acquire pane displays the acquisition controls which run the flow 
cytometer and controls for priming and cleaning procedures.

The options within the Acquire pane are disabled in Playlist mode and when 
the software is offline. 

The Acquire pane contains the following buttons for acquiring data:

 Play: Click the button to start measuring a sample.

The acquisition will start.

 Pause: The button is only enabled if acquisition is in progress. Click the 
button to interrupt the acquisition process. The sample flow is interrupted 
while the sheath flow is continued. The data already acquired are held in 
memory but not saved until acquisition is completed or stopped. When 
clicked, the pause button is disabled.

To resume acquisition from the paused state and continue the collection 
of data, click the Play button.

To restart the acquisition discarding any previously held data for the 
sample, click the Restart button.
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To stop the acquisition process for that sample and save the acquired 
data, click the Stop button. Acquisition will move on to the next defined 
Worklist item to be acquired. If the current sample is the last in the 
acquisition sequence, acquisition will terminate.

 Restart: The button is only enabled if acquisition is in progress. Click the 
button to restart the acquisition process for that sample. The data 
acquired up to this point are discarded.

 Stop: The button is only enabled if acquisition is in progress. Click the 
button to stop the acquisition process for that sample. The data acquired 
up to this point are saved and acquisition will move on to the next defined 
Worklist item to be acquired. If the current sample is the last in the 
acquisition sequence, acquisition will terminate.

 Previous: The button is disabled if acquisition is in progress. Click the 
button to activate the previous Worklist item in the Worklist.

 Next: The button is disabled if acquisition is in progress. Click the button 
to activate the next Worklist item in the Worklist.

 Abort: The button is only enabled if acquisition is in progress. Click the 
button to stop acquisition and discard data from the current sample. You 
will have the option to clear the acquired data and proceed to the next 
Worklist item or to clear the acquired data and stop measuring.

The Acquire pane contains the following buttons for performing predefined 
procedures:

 Prime: Click the button to start a priming procedure. Once started, the 
software guides you through the process.

 De-bubble: Click the button to start a procedure to clear bubbles from 
the flow cuvette. Once started, the software guides you through the 
process.

 Clean: Click the button to start a cleaning procedure. Once started, the 
software guides you through the process.

The "Flow Rates" section of the Acquire pane contains the following controls:

 Above the flow rate slider, the acquisition flow rate (events per second) 
and the absolute event count are displayed during acquisition.

 Flow Rate Slider: The slider allows to adjust the sample injection speed 
into the flow cuvette. Low speed values result in a better precision and 
accuracy. A higher speed can be used when the particle concentration is 
measured and accuracy is of lower relevance. The scale ranges from 
0.1 μl/s to 19.8 μl/s. The value (µl/s) is displayed at the right-hand side of 
the slider.

The flow rate can be changed in the following ways:

Mouse drag and drop of the slider will increase/decrease the flow rate in 
steps of 0.1 μl/s.
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Using the PgUp and PgDn keys of the keyboard will increase/decrease 
the flow rate in steps of 0.5 μl/s.

Using the up/down arrow keys of the keyboard will increase/decrease the 
flow rate in steps of 0.1 μl/s.

Scrolling the mouse scroll wheel will increase/decrease the flow rate in 
steps of 0.3 μl/s.

 Low: Click the button to set a low flow rate (0.5 µl/s).

 Medium: Click the button to set a medium flow rate (2 µl/s).

 High: Click the button to set a high flow rate (5 µl/s).

The "Lasers" section of the Acquire pane can contain between 1 and 6 
buttons that represent the number of lasers detected in the connected 
device. The wavelengths of the lasers are displayed on top of the buttons.

Clicking a button toggles the on/off state which will switch the associated 
laser on or off. The current on/off state of the lasers is displayed below the 
buttons.

After switching on a non-active laser, it will be fully operational after booting 
for about 60 seconds. Switch on the desired lasers a few minutes before 
starting an acquisition.
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12.5.5 Setup pane

The Setup pane displays the setup options of the flow cytometer. You can 
select the number of events and the parameters to be displayed in the 
current Workspace.

The options within the Setup pane are disabled when the software is in 
Playlist mode.

The pane contains the following options:

 Setup Mode: Select the check box to store only the latest events in the 
buffer. Only these events are displayed in the Workspace.

If "Setup Mode" is selected during acquisition, the acquisition will restart 
in setup mode and any previously acquired data will be discarded.

If "Setup Mode" is deselected during acquisition, the acquisition will 
restart, not in setup mode, and any previously acquired data will be 
discarded.

 Events: This box displays the number of events to store in the buffer and 
to display in the Workspace. Click the arrow to expand a drop-down list 
and select the desired number of events to be displayed. The default 
value is 5,000 events, the available values range from 500 to 100,000 
events.

 Select Parameters: To display selected parameters only, click the 
button and select the desired parameters from the Parameter Selection 
dialogue.

Selecting the "Time" check box will create and enable a time parameter 
to be recorded during acquisition. This is an available parameter on the 
device, but is not listed within the parameter table.
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 The "TVAC" check box is selected when the TVAC stop condition has 
been set in the Stops pane. Using TVAC (True Volumetric Absolute 
Counting), a fixed volume of 200 µl between the start and stop electrodes 
in the sample is measured. This setting creates and enables the TVAC 
parameter to be recorded during acquisition. The TVAC parameter is not 
a parameter defined by the device configuration.

12.5.6 Stops pane

This pane provides options for setting stop conditions. In default mode, the 
sample is run until its level reaches the stop electrode.

 The sample analysis automatically stops when the sample is empty (the 
stop electrode is reached) even if the selected stop condition is not yet 
realised.

 If the Worklist contains differing stop conditions, the Worklist conditions 
will override the stop conditions set in the Stops pane.

The options within the Stops pane are disabled when the software is in 
Playlist mode.
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The pane contains the following options:

 Event count: Select the check box to measure a defined number of 
events. In the "Stop Condition" box, click the arrow to expand a 
drop-down list and select the desired condition (ungated or the required 
gate) to base the stop event count on. The default option is "ungated".

In the "Event Count" box, enter the desired number of events. During 
acquisition, once this entered acquisition event count is reached, 
acquisition will stop. The default event count is 5,000 events. The event 
count range is 1 to 100,000,000 events. 

 Time: Select the check box to define a stop time and enter the desired 
value (in seconds) for the acquisition stop time after which the acquisition 
of the sample is to be stopped. The default value for the stop time is 300 
seconds. The stop time range is 1 – 999,999 seconds.

 Volume: Select the check box to define a volume to be measured and 
enter the desired value (in µl) for the volume. During acquisition, once 
this stop volume is reached, acquisition will stop. For manual acquisition, 
the default stop volume is 200 µl and the range is 1 to 1200 µl.

 TVAC: The check box is only enabled for manual acquisition. Select the 
"TVAC" check box (True Volumetric Absolute Counting) to measure a 
fixed volume of 200 µl between the start and stop electrodes in the 
sample. When the TVAC check box is selected, all other Workspace stop 
settings will be ignored. The TVAC parameter in the Parameters list of 
the Setup pane will be checked automatically.

The TVAC parameter sorts events into two different channels for the 
different stages of TVAC: All events acquired prior to the sample passing 
the start electrode will be placed in the "preTVAC" channel of the TVAC 
parameter. All events acquired proceeding the sample passing the start 
electrode will be placed in the "TVAC events" channel of the TVAC 
parameter. Acquisition will be stopped when the sample passes the stop 
electrode.
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12.6 Worklist pane

The Worklist pane is displayed in Worklist mode and by default docked to 
the bottom of the Workspace.

A Worklist contains the predefinitions of hardware and software settings for 
data acquisition. Each Worklist item contains the definitions for a single 
sample measurement. These definitions comprise information on 
Workspace, regions, compensation, instrument settings, stop conditions and 
stop values.

The Worklist is used to define a set of samples for acquisition and to acquire 
the data. Up to 400 Worklist items can be provided in the Worklist.

When measuring a sample is completed, the Worklist item information is 
stored in an FCS file and can be opened in a Playlist.

The Worklist can be saved as a Worklist file.

Worklist title bar
The Worklist title bar displays the name of the Worklist file.

Worklist buttons

The Worklist buttons are disabled during acquisition except for the 
Expand/Restore button.

The functionality of the New, Open, Save and Save as buttons is the same 
as on the File tab of the Ribbon.

1 Worklist title bar
2 Worklist buttons
3 Worklist

2

1

3
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The Worklist buttons are:

 New: Click the button to create a new Worklist or a new Playlist.

 Open: Click the button to open an existing Worklist or Playlist.

 Save: Click the button to save the current Worklist with the same name.

 Save As: Click the button to save the current Worklist with a new name.

 Select Columns: Click the button to open a dialogue to customise the 
Worklist:

To display or hide the columns in the Worklist, select or deselect the 
check boxes next to the columns. Some check boxes are disabled, the 
corresponding columns are always displayed.

Columns can be reordered by dragging and dropping except for the first 
three columns.

The "Lab #" and "Sample ID" columns can be renamed by 
double-clicking on the name and entering a new name of up to 30 
characters. A "locked" icon on the right of a column name indicates that 
the name cannot be changed.

For a description of the columns (see chapter  Worklist rows and 
columns on page 147).

To get back to the default settings, click the Defaults button in the 
dialogue.

 Previous Sample: Click the button to activate the previous sample in the 
Worklist.

 Next Sample: Click the button to activate the next sample in the 
Worklist.

 First Sample: Click the button to activate the first sample in the Worklist.

 Last Sample: Click the button to activate the last sample in the Worklist.

 Expand/Restore: The button is disabled if the Worklist is undocked. 
Clicking the Expand button sets the Worklist pane to the expanded 
position which fills the current Workspace area. The button changes its 
name to Restore. Clicking the Restore button resets the Worklist pane 
to the previous docked position.

Worklist rows and columns
Each row of the Worklist is a Worklist item and represents one prepared test 
from a given sample.

In the columns, the definitions for acquisition can be edited. The columns 
displayed in the Worklist can be customised using the Select Columns 
button.

If the column width does not allow the contents of a cell to be displayed in 
full, the text will be truncated and ellipses ("…") will be displayed at the end 
of the text. When hovering over this, the full name will show as a tooltip.
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The columns are width adjustable. To adjust the width, drag the column 
divider to the right of the column. If you double-click a column divider, the 
column will resize to display its contents optimally.

The Worklist contains the following columns and associated context menus:

 Active: A green arrow displayed in this column indicates the currently 
active Worklist item.

 Acquired: A check mark displayed in this column indicates that the 
Worklist item has been acquired and has associated listmode data. No 
more data can be acquired on this Worklist item.

 Index: This column displays the sequential number representing the 
Worklist order. The column is automatically filled and cannot be changed.

 Run Number: The run number is an updating incremental cycle count 
per system. The column is automatically filled when acquisition begins. 
When acquisition is aborted by the user and a new acquisition has been 
started for that Worklist item, the run number is incremented.

 Location: This column specifies the location of a sample within the 
source type (plate or tube rack) if an autoloader is used. In manual mode, 
the column is blank.

 Panel: To combine several Worklist items, they can be organised in a 
panel. This is typically used for series of measurements of the same 
sample with different settings.

The column displays the panel name for defined Worklist items. When a 
Workspace is defined within the Worklist, a panel name is created. The 
default names will ascend numerically ("Panel 1", "Panel 2", etc.) and are 
unique to the Worklist.

In the context menu of the "Panel" column, options are provided to save 
the panel, to insert or replace a panel, to add an item to the panel and to 
clear the panel, i.e. to delete all Worklist items associated with this panel.

 Workspace: The column displays the name of the Workspace file 
associated with the Worklist item.

When a Workspace is defined within the Worklist, a Workspace name is 
created. The default names will ascend numerically ("Workspace 1", 
"Workspace 2", etc.) and are unique to the Worklist.

If a Workspace has been modified since its last save, an asterisk is 
displayed in front of the Workspace name indicating that the 
corresponding file contains unsaved changes.

In the context menu of the "Workspace" column, options are provided to 
open a new Workspace file, to save the Workspace file, to replace the 
Workspace file or to apply the Workspace file to a panel or to the 
complete Worklist.

 Lab #: This column is provided for entering the laboratory barcode 
number or blood tube identification number. When data acquisition is 
finished, the column is disabled.
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 Sample ID 1 to Sample ID 12: These columns are provided for entering 
sample or patient information. When data acquisition is finished, the 
column is disabled.

 Regions: This column displays the source of the region positions for 
Worklist item containing a Workspace. By default, the region information 
is loaded from the Workspace file.

From a drop-down list in the cell, the "Carry" option can be selected 
instead. Then, the region information will be loaded from the Workspace 
file of the row above at the point of acquisition. The "Carry" option will 
only work if the previous Worklist item has acquired data. Otherwise, the 
Worklist item will be reset to "load from Workspace". In case a region is 
carried across to a different Workspace and the regions do not match the 
new Workspace, information on which regions could not be carried is 
displayed prior to acquisition.

 Instrument Settings: This column displays the source of the instrument 
settings for the Worklist item.

To edit, click into the cell, click the arrow to expand a drop-down list and 
select the desired option:

Load from Workspace: By default, the instrument settings information is 
loaded from the Workspace file. At the point of acquisition, the threshold, 
voltage, compensation and threshold logic instrument settings will be 
applied.

Load from file...: This option is disabled when creating a Worklist offline. 
Click the option to select an instrument settings file (XMLIS file). At the 
point of acquisition, the Workspace instrument settings for the Worklist 
item will be updated to match those in the selected file.

Carry: This option is disabled for use in a compensation setup panel. 
Select this option to carry the instrument settings information from the 
Workspace file of the row above at the point of acquisition. The "Carry" 
option will only work if the previous Worklist item has acquired data. 
Otherwise, the Worklist item will be reset to "load from Workspace".

In the context menu of the "Instrument Settings" column, options are 
provided to save or replace the instrument settings and to apply the 
instrument settings to the panel.

 Stop Conditions: In this column, stop conditions can be set. The default 
option is to load the stop conditions from the Workspace that are set in 
the Stops pane.

By clicking into the "Stop Conditions" cell, a deviating stop condition can 
be chosen. This setting will override the setting in the Stops pane. If the 
"TVAC" check box in the Stops pane is checked, the column will display 
"TVAC" and be read only. For information on stop conditions (see 
chapter 12.5.6 Stops pane on page 144).

In the context menu of the "Stop Conditions" column, the option is 
provided to apply the stop condition to the panel.
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 Stop Value: If a deviating stop condition is set in the "Stop Conditions" 
column, the stop value can be entered here.

 LMD File Name: This column displays the LMD file name and path 
created at the successful termination of acquisition. The column is 
automatically filled and cannot be changed. The file name consists of the 
run number, the timestamp at the end of data acquisition and the sample 
ID.

Activating Worklist items
To activate a Worklist item, double-click on the item. The Worklist item is 
then marked by a green arrow in the "Active" column in the Worklist. Settings 
and results associated with the active Worklist item are displayed in the 
Workspace area. If no Workspace file was associated with the Worklist item, 
a default Workspace file is created.

Only one Worklist item can be active at a time.

When acquisition is in progress, the acquired Worklist item is active. 
Activating another Worklist item is not available.

Selecting Worklist items
To edit Worklist items, they need not to be activated but must be selected. 
Selected Worklist items are highlighted in blue.

The following options for selecting Worklist items are available:

 Single click on a Worklist item to select it.

 To select consecutive items, drag the mouse cursor over the Worklist 
rows.

 To select multiple items, hold down the Ctrl key while selecting the items.

 To select all the items in the Worklist, press Ctrl + A.

 To select all items from the currently selected one to the end of the list, 
press Ctrl + Shift + End.

 To select all items from the currently selected one to the beginning of the 
list, press Ctrl + Shift + Home.
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Worklist context menu
Context menus within the Worklist allow for easy access to the most 
commonly used functions. The context menus are disabled during 
acquisition.

If no specific context menu is defined for the region the cursor is placed, the 
general context menu is displayed on right-clicking. In the "Panel", 
"Workspace" and "Instrument Settings" columns of the Worklist, only the 
relevant submenu is displayed.

The functionality of the New, Open, Save and Save as menu items is the 
same as on the File tab of the Ribbon.

The general Worklist context menu contains the following options:

 New: Click the menu item to create a new Worklist or a new Playlist.

 Open: Click the menu item to open an existing Worklist or Playlist.

 Save: Click the menu item to save the current Worklist with the same 
name.

 Save As: Click the menu item to save the current Worklist with a new 
name.

 Insert Panel: To insert a previously saved panel, click the menu item 
and select a panel (XMLPA file) from the Windows Open dialogue. The 
panel is added to the Worklist starting at the selected row. The option is 
only available if the Worklist item is not yet assigned to a panel.

 Replace Workspace: To replace the current Workspace file, click the 
menu item and select a Workspace file (XMLWS file) from the Windows 
Open dialogue. Only a single Workspace file can be opened. If multiple 
Worklist items are selected, the Workspace files for all selected items are 
replaced with the chosen Workspace file, and are automatically grouped 
into a panel. A panel name is created by default

The option is disabled when a compensation setup panel is active.
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 Panel: In this submenu, options are provided to save the panel, to insert 
or replace a panel, to add an item to the panel and to clear the panel, i.e. 
to delete all Worklist items associated with this panel.

When saving a panel, the full path and file extension are stripped and the 
Workspace name is used as an identifier. If there are multiple Workspace 
files present within the panel with the same name, a unique identifier is 
added to the Workspace file name to differentiate the Workspace files.

When replacing a panel, the selected panel in the Worklist will be 
removed, and the chosen panel will be inserted into the Worklist, with the 
first item of the panel at the same position the first item of the previous 
panel was at.

The "Add Item" option will duplicate the last row in the panel. The option 
is only enabled when at least one undefined item is directly below the 
panel.

The "Clear Panel" option is disabled if LMD files are present in any of the 
selected panels. The option will clear the selected panel(s) from the 
Worklist and reset the Worklist items to an undefined state.

 Workspace: In this submenu, options are provided to create a new 
Workspace file, to save the Workspace file, to replace the Workspace file 
or to apply the Workspace file to a panel or to the complete Worklist.

The "New Workspace" option will create a default Workspace file for the 
selected Worklist item. The option is disabled when more than one 
Worklist item is selected or when a compensation setup panel is active.

 Instrument Settings: In this submenu, options are provided to save or 
replace the instrument settings and to apply the instrument settings to the 
panel.

When saving the instrument settings, the threshold, threshold logic, 
voltages and compensation settings will be saved to the target file.

 Stop conditions: In this submenu, the option to apply the selected stop 
conditions to the panel is provided.

 Clear LMD: Click the menu item to clear the listmode data from the 
Worklist item. The check mark in the "Acquired" column is no longer 
displayed indicating that new data can be acquired on this Worklist item. 
This option is only available if data are acquired on this Worklist item.

 Clear Item: The option is only enabled if a single Worklist item is 
selected that is the first or last item of a panel. Click the menu item to 
clear all settings from the Worklist item. This option is only available if no 
data are acquired on this Worklist item.

 Copy: The menu item is only available if the context menu is launched 
from a manual entry field ("Lab #", "Sample ID" or "Stop Value" columns). 
Click the menu item to copy the text from the column of the selected 
Worklist items to the clipboard.
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 Paste: The menu item is only available if the context menu is launched 
from a manual entry field ("Lab #", "Sample ID" or "Stop Value" columns). 
Click the menu item to paste the previously copied text to the column of 
the selected Worklist items. If only one text was copied, it will be pasted 
to all selected Worklist items. If text from several Worklist items was 
copied, select the same number of Worklist items before pasting.

Compensation setup panel
For defining compensation using control samples, a compensation setup 
panel can be created in the Worklist (see chapter  Compensation Settings 
group on page 106 and chapter  Compensation setup panel on page 107).
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12.7 Playlist pane

The Playlist pane is displayed in Playlist mode and by default docked to the 
left of the Workspace, nested with the other panes.

The Playlist pane contains a Playlist. Each row of the Playlist is a Playlist 
item and represents one acquired sample. A Playlist item contains a 
listmode file (FCS file) with associated Workspace and compensation files. 
Up to 400 Playlist items can be provided in the Playlist. The Playlist can be 
used to analyse data and to predefine settings for future measurements by 
editing the Workspaces and compensations associated to the LMD files.

The Playlist pane allows you to create a list of files that you wish to analyse 
and contains controls for navigating through the files. Multiple files can be 
selected for simultaneous analyses. Files can be reordered and Workspace 
and compensation files can be applied to each file as desired.

The Playlist can be saved as a Playlist file.

When loading a Playlist, the Workspace and compensation are read from the 
Playlist (not from their original files). The report is also read from the Playlist.

Playlist title bar
The Playlist title bar displays the name of the Playlist file. When a Playlist 
has not been saved, it displays "Untitled Playlist".

When the Playlist pane is undocked, right-clicking on the Playlist title bar 
displays a context menu providing the following options:

 Move changes the cursor to a move cursor. The Playlist pane can then 
be moved using the arrow keys on the keyboard.

 Size changes the cursor to a size cursor when over the edges of the 
pane. The Playlist pane can then be resized using the arrow keys on the 
keyboard.

 Hide is always disabled.

1 Playlist title bar
2 Playlist toolbar
3 Playlist

2

1

3
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Playlist toolbar
The options in the Playlist toolbar allow you to navigate through a Playlist, to 
reorder or to delete items in the Playlist.

The Playlist toolbar contains the following buttons:

 First File: Click the button to skip to the first file in the Playlist and open 
the file in the Workspace.

 Previous: Click the button to skip to the previous file in the Playlist and 
open the file in the Workspace.

 Next: Click the button to skip to the next file in the Playlist and open the 
file in the Workspace.

 Last File: Click the button to skip to the last file in the Playlist and open 
the file in the Workspace.

 Insert Item: The button is enabled when a single Playlist item is 
selected. Click the button to insert a new blank Playlist item above the 
currently selected item. The newly inserted line will become selected. 
The button is disabled if the maximum number of 400 Playlist items in the 
Playlist is reached.

 Remove Item: The button is enabled when one or more Playlist items 
are selected in the Playlist. Click the button to remove the selected 
Playlist items from the Playlist. Removing an item removes the item’s 
results from the results table and invalidates any report items for the 
removed Playlist item. If the item is currently open, the Workspace will be 
cleared.

 Move Up: Click the button to move the currently selected items one 
position up in the Playlist. If multiple Playlist items are selected, they will 
be grouped together and then moved.

 Move Down: Click the button to move the currently selected items one 
position down in the Playlist. If multiple Playlist items are selected, they 
will be grouped together and then moved.

 Float/Dock: Clicking the Float button undocks the Playlist pane. The 
Playlist pane can then be relocated as required (see chapter 12.2 Views 
of the software window on page 52). The button changes its name to 
Dock. Clicking the Dock button resets the Playlist pane to the previous 
docked position.

Playlist columns
The rows of the Playlist represent the Playlist items. Each Playlist item 
comprises a listmode file (FCS file) with associated Workspace and 
compensation files.
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The Playlist contains the following columns:

 First column: This column displays a sequential number or the Playlist 
item. A green arrow displayed in this column indicates the active Playlist 
item, i.e. the Playlist item that is currently open in the Workspace.

 Listmode: This column displays the name of the listmode file of the 
Playlist item.

 Workspace: This column displays the name of the Workspace file 
associated with the Playlist item. In the context menu, options are 
provided to replace the Workspace, to assign a new Workspace, to save, 
copy and paste the Workspace file and to apply the Workspace file to the 
Playlist.

 Compensation: This column displays the name of the compensation file 
associated with the Playlist item. In the context menu, options are 
provided to replace, save, copy and paste the compensation file or to use 
the listmode compensation settings.

 FCS Key 1 and FCS Key 2: In these columns, FCS keywords can be 
displayed. Click the arrow to expand a drop-down list and select the 
desired primary or secondary keyword from the list. The drop-down list 
displays all keywords available from the listmode file of the first Playlist 
item in the Playlist. On selection of a keyword, the column title is 
changed to the keyword designation. If a keyword cannot be found in a 
listmode file, the column of the respective Playlist item displays 
"ERROR".

To remove the current keyword selection, select "None" from the 
drop-down list.

If the listmode file of the first Playlist item of the Playlist is cleared, 
replaced, moved or a new Playlist item is inserted, the keyword selection 
is cleared in the Playlist.

The first column is not width adjustable. All other columns are width 
adjustable. To adjust the width, drag the column divider to the right of the 
column. If you double-click a column divider, the column will resize to display 
its contents optimally.

If the column width does not allow the contents of a cell to be displayed in 
full, the text will be truncated and ellipses ("…") will be displayed at the end 
of the text.

Activating Playlist items
To activate a Playlist item, double-click on the item. The Playlist item is then 
marked by a green arrow in the first column of the Playlist. The listmode, 
Workspace and compensation files of the Playlist item are opened in the 
Workspace.

Only one Playlist item can be active at a time.
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Selecting Playlist items
To edit Playlist items, they need not to be activated but must be selected. 
Selected Playlist items are highlighted in blue.

The following options for selecting Playlist items are available:

 Single click on a Playlist item to select it.

 To select multiple items, hold down the Ctrl key or Shift key while 
selecting the items.

 To select all the items in the Playlist, press Ctrl + A.

 To select all items from the currently selected one to the end of the list, 
press Ctrl + Shift + End.

 To select all items from the currently selected one to the beginning of the 
list, press Ctrl + Shift + Home.

 To invert the selection, press Ctrl + Shift + A.

Playlist context menus
Context menus within the Playlist allow for easy access to the most 
commonly used functions.

For editing, context menus are available throughout the Playlist.

By right-clicking on the blank area of the Playlist pane, options for opening a 
new Playlist, opening an existing Playlist and saving the Playlist as are 
provided. The functionality is the same as in the File tab of the Ribbon.

If the cursor is placed in the "Listmode" column, the main context menu 
described here is displayed on right-clicking. In the "Workspace" and 
"Compensation" columns of the Playlist, only the relevant submenu is 
displayed.

The main context menu provides the following options:

 Insert Item: Click the menu item to insert a new Playlist item above the 
currently selected Playlist item.

 Remove Item: Click the menu item to remove the selected Playlist item.

 Replace Listmode: To replace the selected Playlist items, click the 
menu item and select the desired replacement listmode file(s).

 Clear Listmode: Click the menu item to clear the listmode file from the 
Playlist item.

 Workspace: In this submenu, options are provided to replace the 
Workspace, to assign a new Workspace, to save, copy and paste the 
Workspace file. The functionality of these submenu items is the same as 
in the Workspace group in the Playlist tab of the Ribbon (see chapter 
12.4.9 Playlist tab on page 100).

The "Apply to Playlist" option copies the Workspace file of the selected 
Playlist item and pastes it to all Playlist items in the Playlist.
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The "Use Listmode" option is enabled if the listmode file is a CyFlow® file 
with an embedded Workspace. Selecting this option restores the 
embedded Workspace for the selected file.

 Compensation: In this submenu, options are provided to replace, save, 
copy and paste the compensation file or to use the listmode 
compensation settings. The functionality of these submenu items is the 
same as in the Compensation group in the Playlist tab of the Ribbon (see 
chapter 12.4.9 Playlist tab on page 100).

 New Playlist: Click the menu item to create a new Playlist. The 
functionality is the same as in the File tab of the Ribbon.

 Open Playlist: Click the menu item to open an existing Playlist. The 
functionality is the same as in the File tab of the Ribbon.

 Save Playlist As: Click the menu item to save the current Playlist with a 
new name. The functionality is the same as in the File tab of the Ribbon.

Adding files to the Playlist
A listmode file can be opened in many ways including:

 using the Open Listmode button in the Quick Access Toolbar,

 using the Open Listmode button in the Home tab of the Ribbon,

 from the Open menu in the File tab of the Ribbon,

 by pressing Ctrl + O,

 by drag and drop from the Windows Explorer into the Playlist pane.

Each listmode file is added to the end of the Playlist as a new Playlist item 
displaying the listmode file name in the "Listmode" column.

If one or more listmode files are added to the Playlist, the first of the newly 
added listmode files is automatically opened in the Workspace and selected 
in the Playlist.

If a Workspace file is opened, it is added to the currently opened active 
Playlist item.

If a compensation file is opened, it is added to the currently active Playlist 
item.
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Playlist tooltips and error display
When moving the cursor over the "Listmode" column of a Playlist item, a 
tooltip containing the corresponding LMD file path is displayed. On 
"Workspace" or "Compensation" columns, the tooltip contains the 
Workspace or compensation file path if the Playlist is not yet saved. If the 
Playlist is saved, the tooltip contains only the Workspace or compensation 
file name.

If an error occurs, the Playlist item text is coloured, and moving the cursor 
over the text displays a corresponding tooltip. If a Playlist item has multiple 
errors/warnings associated with it, the tooltip only displays one error at a 
time with errors taking precedence over warnings.

The following colours are used:

 Playlist items that have no errors are displayed in black.

 Orange text indicates a Workspace file warning. Playlist items have LMD 
files which do not match their associated Workspace file concerning 
scaling information, number of parameters, region and gate definition or 
zoom settings.

 Red text indicates a listmode file, Workspace file or compensation file 
error. Playlist items are invalid, files are not compatible with the current 
Workspace or compensation coefficients in the LMD file or files cannot 
be accessed.

 Grey text indicates a processing issue. Playlist items are not yet 
processed or unable to process.

Modified file indicators
If a Workspace or compensation file has been modified since its last save, 
an asterisk is displayed in front of the Workspace or compensation name in 
the Playlist indicating that the corresponding file contains unsaved changes.

If you save a modified Workspace file or compensation file and that file 
occurs more than once in the Playlist, a corresponding message is displayed 
and you will have the option to apply the changes to all Playlist items with 
the same Workspace file or compensation file.

Reordering Playlist items
Playlist items can be reordered in the Playlist by dragging them to a new 
position. While a Playlist item is being dragged, a red line appears denoting 
where the item will be relocated when dropped. If multiple Playlist items are 
selected, they will be grouped together and then moved.

Alternatively, use the Move Up and Move Down buttons of the Playlist 
toolbar.
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12.8 Workspace

In the Workspace area of the software window, the Workspace of the 
currently active Playlist item or Worklist item is displayed and can be edited. 
A Workspace includes plots, regions, gates, colour precedence, selected 
statistics and displayed parameters. A Workspace can be saved as a 
Workspace file.

The Workspace contains four tabs:

 The Plots tab contains two areas: Plots and Previews. The Previews area 
automatically displays plots once a listmode file is opened. Plots can be 
added to the Plots area as required for further analysis. The Plots tab is 
open by default. 

 The Results tab displays the statistics selected in the Statistics tab of the 
Ribbon.

 The Overlays tab allows the creation of single and dual parameter 
overlay plots.

 The Reports tab allows you to create and modify reports.

12.8.1 Plots tab of the Workspace

Plots are displayed in the Plots tab of the Workspace. 

The Plots tab of the Workspace consists of two areas:

 Plots area: Selected plots are displayed in the Plots area and can be 
analysed and modified in this area.

 Previews area: When an LMD file is opened, the Previews area of the 
Workspace automatically displays all single parameter histogram plots 
and all dual parameter colour density plots associated with the opened 
LMD file. The axis displays the stain name taken from the FCS header of 
the opened LMD file.
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Types of plots
The software can display four plot types:

 Single Parameter Histogram Plots display the 1024 bin histogram for a 
single parameter. The plot may be gated or ungated.

 Dual Parameter Colour Density Plots are two dimensional 256 x 256 
bin histograms which use colour to represent the level of events within 
each bin. An algorithm is used to calculate the levels based on the 
number of events. The levels have logarithmic intervals.

Six levels of colour are used for the Density Plots: Black for outlier 
singles and, in order of increasing density: blue (lowest density), green, 
yellow, orange and red (highest density).

 Dual Parameter Colour Precedence Plots are two dimensional 256 x 
256 bin dot plots which use colour to represent the gating events that fall 
within specific gates. Where an event may be in multiple gates, the 
precedence order determines which colour is chosen. Where events from 
multiple gates fall within a single bin, the highest precedence gate colour 
is chosen. Ungated events are displayed black. Precedence order can be 
changed via the Precedence order dialogue (see chapter  Gate group on 
page 69).

 Dual Parameter Precedence Density Plots are displayed as colour 
precedence plots but include density information as well as colour 
precedence.

Properties of individual plots, including changing of the plot type, can be 
modified using the Plot Format tab of the Ribbon (see chapter 12.4.14 Plot 
Format tab on page 124).

Adding plots to the Plots area
For adding plots to the Plots area, you can select plots from the Previews 
area or use buttons of the Ribbon.

1 + button

1
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The following options are available:

 To add a single plot from the Previews area to the Plots area, 
double-click the desired plot in the Previews area.

 To add several plots from the Previews area, use the + buttons in the 
Previews area:

To add a row of plots, click the + button at the right of the respective row 
in the Previews area.

To add a column of plots (excluding histograms), click the + button at the 
bottom of the respective column in the Previews area.

To add the upper right triangle or lower left triangle of plots, use the split 
+ button at the bottom right corner of the Previews area.

When the mouse is hovered over any + button, the plots that will be 
added when the button is clicked become highlighted in a blue outline.

 Further possibilities to add a specific selection of plots to the Plots area 
are provided in the Plots group on the Analyze tab of the Ribbon (see 
chapter  Plots group on page 68).

 To add a plot displaying the first parameter(s) of the current listmode file 
or to duplicate plots, use the buttons in the Add Plot group of the Home 
tab of the Ribbon (see chapter  Add Plot group on page 66).

Gallery and hierarchy view
When you add plots to the Plots area, they are added next to each other in a 
gallery plot view. You can change the display to a family tree style hierarchy 
format by clicking the Hierarchy button in the View group of the Analyze tab 
(see chapter  View group on page 73). In this format, the plots are displayed 
in a tree-like structure with a separate branch for each gate. Selecting the 
Gallery button will return you to the gallery plot view.

A plot containing a region which is part of a gate equation is called a 
classifier plot. A plot that has no gating regions on it is called an outcome 
plot. In hierarchy view, a pathway is drawn between each classifier plot and 
between other classifier plots and the subsequent gated outcome plots. 
Ungated plots with no gating regions drawn on them appear outside the 
hierarchy as orphaned plots.
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Selecting plots
Selected plots are surrounded by a blue selection rectangle.

The following options are available:

 To select a single plot within the Plots area, click on the plot.

 To select or deselect multiple plots, hold Ctrl while clicking on plots.

 Plots may also be selected by dragging out a selection rectangle around 
the desired plots. The rectangle selects everything it touches. Ctrl 
dragging a selection area around plots will toggle that selection of the 
plots.

 To select all plots, press the Ctrl + A keys.

 Plot selection options are also available from the Edit group on the 
Analyze tab of the Ribbon (see chapter  Edit group on page 73).

On selecting a plot, the Plot Format tab becomes available on the Ribbon 
providing options to edit type, gating and axis scales of plots and to set 
histogram smoothing (see chapter 12.4.14 Plot Format tab on page 124).

Resizing plots
For resizing plots, select the Resize Plots or Resize Previews button from 
the status bar and use the resize slider on the status bar to adjust the size of 
the plots (see chapter  Resize options on page 186).

If a mouse with a central wheel is used, plots can also be resized by 
selecting plots and pressing the Ctrl key while scrolling the mouse wheel.

Selecting parameters for display
If the Previews area does not display the required parameters, you can 
select or deselect parameters from those present on the Parameters tab of 
the Ribbon (see chapter 12.4.5 Parameters tab on page 76).

Analysing and modifying plots in the Plots area
Plots are selected from the Previews area and added sequentially to the 
Plots area.

An ungated plot displays no colour border and "[Ungated]" as the plot 
heading.

If the Previews area has a gate applied, the plots added to the Plots area will 
also have this gate applied. This process will automatically create a gate if 
required. A gated plot is surrounded by a coloured border which denotes the 
gate colour applied. By default, the gate name is displayed as the plot 
heading.
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The following options for editing plots in the Plots area are provided:

 Editing the Plot Title: To customise the title of a plot, double-click in the 
top margin of the plot and enter a custom title into the edit field. The title 
is added to the heading of the plot.

 Moving Plots: Plots can be rearranged within the Plots area by dragging 
and dropping. A vertical blue insert cursor highlights the new location of 
the plots. When multiple plots are selected and dragged, they are 
grouped together and moved as a group. After they are released, they 
remain together. The plots displayed in the hierarchy view cannot be 
moved.

 Deleting Plots: Plots may be removed from the Plots area by selecting 
them and pressing the Delete key. Selected plots can also be deleted 
using the Delete button in the Edit group on the Analyze tab.

If the deleted plot has a region applied, deleting the plot also deletes the 
region and removes the region from any gating logic. In this case, a 
corresponding warning message is displayed and you will have the 
option to cancel deleting the plot.

Changing parameter properties
To change parameter properties, double-click in the area of the plot 
displaying the parameter name. The Parameter Properties dialogue is 
launched (see chapter  Parameter Properties on page 76).

Changing Plot Parameters
The software provides functionality for changing the parameters of the plots 
in the Plots area.

The following options are available:

 To change the parameter of an axis of a plot, right-click in the area of the 
plot displaying the parameter name. A context menu is displayed that 
contains all the parameters currently selected on the Parameters tab of 
the Ribbon. Select the required parameter to be displayed in the plot.

When a different parameter is selected, the plot is updated to use the 
new parameter. The statistics and report are automatically updated as 
well. The following settings are retained when a parameter is changed: 
Zoom status of the plot, smooth settings for histogram plots, gating of the 
plot, cell cycle options.

If there are regions on the plot, they will be deleted on the plot and in any 
gate equations if parameters are changed. In this case, a corresponding 
warning message will be displayed and you will have the option to cancel 
changing the parameters.

 To flip the axes of a dual parameter plot, right-click in the area of the plot 
displaying the parameter name. From the context menu, select the "Flip 
Axes" option. Any regions on the plot will be retained and flipped as well. 
Statistics and reports will automatically update.
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When flipping a plot containing a quadrant region, the quadrant dividers 
are flipped, but the names of the quadrants are persisted. Any gate 
equations using these quadrant regions will be updated if required.

Any linking of regions will be removed if you flip plot axes. In this case, a 
warning message will be displayed and you will have the option to cancel 
flipping the axes.

 Alternatively, use the "Parameters" options of the Home tab to change 
the parameters of selected plots (see chapter  Parameters group on 
page 66).

Creating regions
Regions can be defined on single or dual parameter plots. The maximum 
number of regions that can be created in a Workspace is 256. Quadrant 
regions are not included in this count.

Regions are created using the buttons in the Region group on the Home tab 
(see chapter  Region group on page 65) or on the Analyze tab (see chapter  
Region group on page 68).

To create a region on a plot, click the required region type button. The button 
is highlighted. Then either click on a plot to set the region at the default size, 
or draw out the required region size on the desired plot.

To cancel the creation of a region, press the Esc key before or during the 
dragging of that region.

Once the maximum number of 256 regions is reached, the buttons in the 
Region group become disabled.

Only one region can be drawn per button selection for the Elliptical, 
Rectangular and Polygonal region types. Linear regions can be applied to 
multiple selected single parameter plots by pressing the Ctrl key while 
clicking to add the region. Quadrant regions can be applied to multiple 
selected dual parameter plots by pressing the Ctrl key while clicking to add 
the region.

To create a region on a plot, first click the required region type button on the 
Home tab or the Analyze tab. Five region types can be created:

 Elliptical Region: Click the region type button. Then either click on a 
dual parameter plot to set an ellipse of the default size, or draw out the 
required ellipse on the desired plot.

 Rectangular Region: Click the region type button. Then either click on a 
dual parameter plot to set a rectangle of the default size, or draw out the 
required rectangle on the desired plot.

 Polygonal Region: Click the region type button. Click onto a dual 
parameter plot to determine the first point of the region. Then click on the 
plot to add additional points to the polygon. The polygon is then 
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completed by clicking on the start point. If there are at least three points, 
the polygon is also completed by right-clicking (which will complete the 
polygon by adding a line from the last to first point). Double-clicking on a 
line inserts a new point which can then be moved to create a modified 
region.

 Linear Region: Click the region type button. Then either click on a single 
parameter plot to set a default sized linear region, centred on the point 
where the plot was clicked. Alternatively click onto a single parameter 
plot and drag out a line to determine the region size. The same linear 
region can be applied to multiple selected single parameter plots by 
pressing the Ctrl key while clicking to add the region.

 Quadrant Region: Quadrant regions are formed from two divider lines 
(one vertical, one horizontal). Click the Quadrant Region button, and then 
click onto a dual parameter plot at the point on the plot where you wish 
the quadrant’s intercept to appear. By hovering the cursor over the 
quadrant intercept, a statistic is displayed for each quadrant. The same 
quadrant region can be applied to multiple selected dual parameter plots 
by pressing the Ctrl key while clicking to add the region.

When a broad distribution of events is observed, you may need to create 
non-linear quadrant dividers. The control point on the right and top can 
be used to move the horizontal and vertical dividers respectively to a 
higher channel than the intercept point, creating a "Bendy Quad" region. 
If the "Bent" divider is moved to a lower value than the intercept point, the 
divider returns to its straight form.

Editing regions
On selecting a region, the Region Format tab becomes available on the 
Ribbon providing options to edit region name and colour, region type and 
position and to link regions (see chapter 12.4.15 Region Format tab on 
page 128).

Additionally, the region orientation, size and position can be edited by 
selecting a region on a plot and dragging the handles displayed on the 
selected region, as indicated by the cursor.

The region can be moved by selecting between the handles, as indicated by 
the move cursor, then dragging the region to a new position.

If you change the region size or position unintentionally, click the Undo 
button in the Quick Access Toolbar to restore the previous size or position.

The options for the different region types are:

 Ellipse: Elliptical regions have four control points that will be displayed 
when you click on a region to select it. You can use these control points 
to resize, rotate and move the elliptical region. While an elliptical region is 
being moved or resized, the coordinates of the centre, the axes length 
and the rotation angle in degrees are displayed.

 Rectangle: Rectangular regions have eight control points that will be 
displayed when you click on a region to select it. You can use these 
166 CyFlow® Cube 8 | Operating Manual | May 2018 | Revision 032



12 Software description
control points to resize and move the rectangular region. While a 
rectangular region is being moved or resized, the coordinates of the top 
left and bottom right corners are displayed.

 Polygon: The polygonal region cannot be rotated and cannot be moved 
outside the plot axes. Each vertex of the polygon is a control point. 
Dragging the vertex will move that vertex only within the polygon. 
Dragging a line of the polygon will move the region whilst maintaining the 
shape of the region. While the vertex of a polygonal region is being 
moved or resized, its coordinates are displayed.

 Linear: Linear regions have control points situated at each end of the 
region. You can drag the control points to resize the region. Dragging the 
line allows you to move the region. While a linear region is being moved 
or resized, its coordinates are displayed.

 Quadrant: Quadrant regions have five control points, one situated at the 
divider intercept point and one situated at each end of the two dividers. 
Each of the control points can be used to modify the quadrant region. 
The quadrant region cannot be moved outside the plot axes. While a 
control point is moved, the channels of the intercept point are displayed 
in the status bar.

When a broad distribution of events is observed, you may need to create 
non-linear quadrant dividers. The control point on the right and top can 
be used to move the horizontal and vertical dividers respectively to a 
higher channel than the intercept point, creating a "Bendy Quad" region. 
If the "Bent" divider is moved to a lower value than the intercept point, the 
divider returns to its straight form.

Deleting regions
To delete a region, select it and press the Delete key or the Delete button in 
the Edit group on the Analyze tab. If deleting a region affects gating logic, a 
warning message will be displayed and you will have the option to cancel 
deleting the region.

Region names
Once a region has been created, a unique name for the region is 
automatically generated. The region name and associated statistic are 
displayed adjacent to the region on the plot. The size of the text is 
auto-adjusted. The associated statistic is not displayed if there is not enough 
space. If the name is too long to fit on the plot, it is not displayed. By 
hovering the cursor over the region, a tooltip is displayed stating the name 
and the statistic associated with that region.

If a statistical value cannot be calculated, "ERROR" will be displayed instead 
of a numerical value.

To change the automatically assigned name, select the region and 
double-click on the region name on the plot. An edit field appears. Enter a 
name or select a name from the drop-down list. The drop-down list is 
populated with the names provided on the Region page in the software 
options (see chapter  Region page on page 188).
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®

The region name can also be changed from the Appearance group of the 
Region Format tab (see chapter  Appearance group on page 128).

The region name can be repositioned but cannot be dragged outside the 
plot.

Region colour
When a region is created (except for quadrant regions), it is automatically 
assigned a colour. There is a set of ten predefined region colours within the 
software.

The region colour can be changed in the Region group of the Home tab (see 
chapter  Region group on page 65) or from the Region Format tab (see 
chapter  Appearance group on page 128).

Regions and gates
Any existing plot can be gated by selecting the required region or gate from 
the "Gate" drop-down list on the Home tab (see chapter  Gate group on 
page 67).

When a region on a plot is selected, the plots in the Previews area are gated 
on the selected region. The heading of the Previews area displays the name 
of the region and is highlighted with its colour. 

If a plot gated on a region is added to the Plots area, a gate associated with 
this region is automatically created with the same name and colour as the 
region. The plot in the Plots area is marked with this colour.

If a region is added to one of the gated plots and then selected, plots in the 
Previews area will become gated on the new region. If you now add a new 
plot to the Plots area, it will be gated on a compound gate consisting of both 
the original gate of the plot (the parent gate) and the newly added region.

The gate name and colour can be changed in the Edit Gates dialogue of the 
Analyze tab (see chapter  Gate group on page 69).

Scaling
For high-resolution data files, a parameter can be displayed in three different 
formats: linear, logarithmic and V-Log. This is selectable from the Home tab 
(see chapter  Parameters group on page 66) or from the Plot Format tab 
(see chapter  X-Axis group on page 125).

The scaling of parameters can be customised in a number of ways using the 
scaling and zoom options available in the Scales group of the Parameters 
tab (see chapter  Scales group on page 80).

If you change the zoom status on a plot with a region, the region position 
does not change. You may need to reposition any regions set on zoomed 
parameters.
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Plots added to the Plots area will display their scales on the X and Y axes. 
Fluorescence parameters default to Log scaling. Scatter or other parameters 
default to Lin scaling.

The scaling options are:

 Linear Scales: Linear scaled parameters display linear tick marks and 
numbering. The default values are determined from information in the 
LMD file. Linear scaled data always starts at 0. The minimum and 
maximum values are always displayed at the ends of the scale.

 Log Scales: Logarithmic scaled parameters display logarithmic tick 
marks and numbering. The default values are determined from 
information in the LMD file. When no scaling information is available in 
the opened LMD file nor in the Workspace, the scaling is determined by 
the values found in the Scaling page of the software options (see chapter  
Scaling page on page 189).

 V-Log Scales: V-Log scaled parameters display a combination of linear 
and logarithmic sections. Linear tick marks are displayed around the 
origin and logarithmic tick marks are displayed towards the end of a 
scale. When V-Log is selected, the full range of data is displayed.

To toggle between zoomed and unzoomed displays:

 If one or more of the parameters associated with the plot have 
non-default zoom settings, a Plot Zoom Toggle button is displayed on 
the top left corner of the plot. Click the button to toggle between the 
zoomed and unzoomed view of the plot.

 Alternatively, use the Display zoomed button on the Parameters tab of 
the Ribbon.

DNA cell cycle plots
You can perform DNA cell cycle analysis of single parameter linear data 
plots. To display DNA cell cycle information, first select one or more 
histograms and then press the Cell Cycle button on the Plot Format tab of 
the Ribbon (see chapter  Plot Type group on page 124). 

If there are regions on any of the selected histograms, cell cycle cannot be 
activated and the Cell Cycle button is disabled. You have to delete the 
regions or deselect the plots containing them before cell cycle can be 
activated. The DNA cell cycle plots are saved as part of the Workspace. 
Each cell cycle plot is identified numerically with the title "Cell Cycle n", 
where "n" is a number.

When hovering the cursor over a cell cycle plot, a tooltip is displayed listing 
the cell cycle number, statistics and the error message associated with the 
plot.
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The three phases of the DNA cell cycle are coloured on the cell cycle plot as 
follows:

 Red: Denotes the G0/G1 phase,

 Blue: Denotes the S phase,

 Green: Denotes the G2/M phase.

Additional regions cannot be applied to the cell cycle plot.

The following markers are displayed on the plot:

 Blue Markers are debris markers allowing to set noise thresholds and to 
exclude cellular debris. Events that occur below or above these noise 
markers will be presented on the plot, but not analysed by the software.

 The Red Marker marks the estimated mean channel of the G0/G1 peak.

 The Green Marker marks the estimated mean channel of the G2/M 
peak.

If the calculated phases are not as expected, the G0/G1 and/or G2/M 
estimates can be adjusted by clicking on the marker and dragging/dropping it 
to the desired position to generate a successful fit for the DNA cycle. The 
estimate markers cannot be crossed over. The markers can only be moved 
to within 10 channels (based on a 1024 channel histogram) from each other. 
Noise markers cannot be moved outside the limits of the histogram.

Moving any of the markers triggers recalculation on the DNA cell cycle plot. 
When the noise markers are moved, the automatically estimated G1/G0 and 
G2/M peak values will be used. When the G0/G1 and/or G2/M are moved, 
the adjusted values of these markers will be used.

Following a manual adjustment of the estimates, you can return the 
calculated estimates to their original calculated positions. Click the Reset 
Cell Cycle button on the Plot Format tab of the Ribbon to reset the cell cycle 
with the automatically calculated G0/G1 and G2/M position estimates.
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12.8.2 Results tab of the Workspace

In the Results tab of the Workspace, a results table is displayed. Here, you 
can view statistics associated with the current Playlist or the current Worklist 
pane. You can copy statistics for use in other applications, export statistics to 
CSV and XML files and print statistics using the options on the File tab of the 
Ribbon.

When you switch to the Results tab of the Workspace, the Ribbon 
automatically switches to its Statistics tab providing the options to select the 
statistics for the results table.

Results table rows and columns
A results table generates result rows based on regions, plot gates (if 
selected) and derived gates from all items in a Playlist or from all items in the 
current panel of a Worklist which have a listmode file. Each region created in 
the Workspace generates a row in the results table. For a quadrant region, 
four rows are created, one for each quadrant. Each DNA cell cycle plot also 
generates a results row in the table.

The columns in the results table represent the individual statistics as 
selected from the Statistics tab of the Ribbon (see chapter 12.4.7 Statistics 
tab on page 92). For a cell cycle plot, an additional "Error Message" column 
is added to the results table. The message reported by the cell cycle 
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analysis, denoting whether the algorithm experienced any problems, is 
displayed in this column.

When background calculation has completed, results for all valid Playlist 
items will be available to be displayed in the results table. For a Worklist, the 
results for all items of the current panel with a listmode file are available to 
be displayed in the results table.

If a statistical value cannot be calculated, "ERROR" will be displayed instead 
of a numerical value.

If a value is not applicable to the row, it is left blank. Not applicable items 
are:

 DNA statistics for non-cell cycle regions,

 Y statistics for linear regions,

 Events, intensity and variation group statistics for cell cycle plots,

 X and Y parameter, region, plot title, intensity group, variation group and 
DNA statistics group statistics for derived gates.

Columns will default to automatically adjust their width to fit the widest text in 
the column. The width of a column can be manually changed by dragging 
the column divider at the right of the column to be adjusted. Double clicking 
the column divider at the right of a column will set that column back to 
automatically adjust its width.

The following options for editing the results table are available:

 Reordering columns:To reorder the columns, drag and drop their 
headers.

 Adding columns: To add a column, select its check box in the Statistics 
tab of the Ribbon. Alternatively, click a column header to display a 
drop-down list of all statistics and select the desired statistics.

 Removing columns: To remove a column, deselect its check box in the 
Statistics tab of the Ribbon or drag the column header off the column 
header area. Alternatively, click a column header to display a drop-down 
list of all statistics and deselect the desired statistics.

 Sorting by columns: The table can be sorted by any column in an 
ascending or descending order by clicking the column title.

Selecting table rows
Selected rows are highlighted in blue. Selected rows can then be copied for 
pasting in to other applications, e.g. Microsoft® Excel.

The following options for selecting rows are available:

 Click on a results row to select it.

 To select multiple rows, hold down the Ctrl or Shift key while selecting 
the rows.

 To select all rows, press Ctrl + A.
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 To select all rows from the currently selected one to the end of the table, 
press Ctrl + Shift + End.

 To select all rows from the currently selected one to the beginning of the 
table, press Ctrl + Shift + Home.

Grouping results by column headers
Results can be grouped by the values displayed in the column headers. You 
can do this by dragging a column header from the results table onto the grey 
field above the table labeled "Drag a column header here to group by that 
column". When the header is dragged, two red arrows indicate where the 
column header will be placed on the field.

The following options are available:

 To group by a column and remove the column from the results table, 
drag the desired column header into the grey field.

 To group by a column without removing the column from the results 
table, hold the Ctrl key while dragging the desired column header into 
the grey field.

 To group by more than one column, drag the desired column headers 
into the grey field. Drag and drop the headers in the field to sort them in 
the desired sort order.
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The information displayed in the groups can be collapsed and expanded by 
clicking the +/- buttons.

A column header can be removed from the grouping by dragging it back to 
its position in the results table. When a column header is dragged back to 
the results table, two red arrows indicate where the header will be placed. 
The header can also be dragged off the table and it will be removed from the 
group control.

12.8.3 Overlays tab of the Workspace

In the Overlays tab of the Workspace, you can create overlay plots of single 
or dual parameter plots. Overlay plots can be used to compare plots.

In Playlist mode, there is an overlay Workspace per Playlist. In Worklist 
mode, there is an overlay Workspace per panel.

On selecting the Overlays tab in the Workspace, a blank area is displayed. 
The Overlay tab of the Ribbon automatically becomes active providing 
options to edit the overlay Workspace (see chapter 12.4.11 Overlay tab on 
page 109).

Overlay plots are created by sending plots from the Plots tab of the 
Workspace to the Overlays tab.

In Playlist mode, you can also use the Overlay Wizard on the Overlay tab of 
the Ribbon to create overlay plots.

Each overlay consists of an overlay plot and an associated gallery of its 
source plots. An overlay can contain a maximum of 400 source plots.

The Overlays tab of the Workspace consists of two areas:

 The Overlays area displays a 2D or 3D view of available overlay plots.

 The Galleries area displays the individual source plots that make up the 
overlay plots. For each overlay plot, a gallery of individual plots is 
displayed with the name of the overlay plot as a title.
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Creating overlay plots
A new overlay plot is created by sending plots from the Plots tab of the 
Workspace to the Overlays tab. Select the required plot(s) in the Plots area 
of the Workspace. Right-click to open a context menu and select "Send 
selected Plot(s) to Overlay Plot". A context submenu is displayed.

From the submenu, select the desired option:

 To add the plots to a new overlay plot, select "New". An overlay plot 
cannot contain both single and dual parameter plots. If you have selected 
both types of plot, a new overlay plot will be created for each type.

 To add new plots to an existing overlay plot, select the desired overlay 
plot in the context submenu. More than one instance of a plot cannot 
exist in an overlay plot, therefore if the currently selected plot(s) already 
exist in an overlay plot, that plot is disabled in the context submenu. An 
overlay plot cannot contain both single and dual parameter plots. Any 
overlay plots to which the currently selected plots cannot be copied are 
disabled in the context submenu.

Plots can also be added to a selected overlay plot by using the Insert Plot 
button on the Overlay tab of the Ribbon (see chapter  Plots group on 
page 113).

Plot views
If zoom and scale settings exist in the plot from the Plots area, these will be 
persisted in the overlay plots.

If any of the source plots are unavailable after the associated item has been 
processed, an exclamation mark will be displayed on the overlay plot in front 
of all other successfully calculated data sources within the overlay.

If background calculation is turned off, a warning icon will be displayed in the 
bottom right-hand corner of any overlay plot that contains a source plot in an 
unknown state. Hovering over it will display a tooltip indicating that 
background calculation needs to be turned on.

Overlay plots can be displayed in 3D using the 3D Mode button on the 
Overlay Format tab of the Ribbon (see chapter  Overlays group on 
page 133). In 3D mode, plots are displayed as three-dimensional at a 
specified angle and will be equally distributed. The plot can be rotated using 
the Angle (deg.) button on the Overlay Format tab of the Ribbon.
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Selecting plots
Selected plots are surrounded by a blue selection rectangle.

If an overlay plot is selected in the Overlays area, the associated title in the 
Galleries area is also highlighted.

In the Galleries area, plots from only one gallery can be selected at a time.

The following options are available:

 To select a single plot within the Overlays area or Galleries area, click on 
the plot.

 To select or deselect multiple plots, hold Ctrl while clicking on plots.

 Plots may also be selected by dragging out a selection rectangle around 
the desired plots. The rectangle selects everything it touches. Ctrl 
dragging a selection area around plots will toggle that selection of the 
plots.

 To select all plots, press the Ctrl + A keys.

On selecting an overlay plot, the Overlay Format tab becomes available on 
the Ribbon providing options to change the format of all plots that are 
available to that overlay plot (see chapter 12.4.16 Overlay Format tab on 
page 131).

Reordering plots
Selected plots can be reordered within the Overlays area or the Galleries 
area by drag and drop. Changing the order of the overlay plots will also 
change the order of the associated galleries.

When changing the order of individual plots in the Galleries area, the plots 
will be displayed on the overlay plot in that new order.

Resizing plots in the Overlays or Galleries area
For resizing plots, select the Resize Overlays or Resize Galleries button 
from the status bar and use the resize slider on the status bar to adjust the 
size of the plots (see chapter  Resize options on page 186).

If a mouse with a central wheel is used, plots can also be resized by 
selecting plots and pressing the Ctrl key while scrolling the mouse wheel.
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Editing plot titles, legend  and axis labels
The following options are available:

 Plot title: Each overlay plot has a plot title which defaults to the overlay 
number, e.g. "Overlay 1". To change a plot title, double-click on the 
current plot title and enter a custom plot title into the edit field. Gallery 
plot titles can be edited in the same way.

 Legend: A legend can be optionally displayed on an overlay plot using 
the Legend button on the Overlay Format tab. The legend can be edited 
by double-clicking a label in it. A warning icon containing a tooltip is 
displayed below the legend area of the plot if all the legends cannot be 
displayed.

 Overlay axis label: Axis labels are displayed on an overlay plot if all 
parameter names of the individual plots have the same label. Otherwise, 
no axis label will be displayed for the overlay plot. To change the axis 
label, double-click on the axis and enter a label into the edit field. To 
return the label to the default setting, press the Reset to Default button 
of the edit field. The default setting is the file name from the listmode file.

 Gallery axis label: Each gallery plot can have an axis label displayed, by 
default this label is the parameter name from the listmode file. To change 
the axis label, double-click on the axis label and enter a label into the edit 
field.

The Keywords button of the edit field allows you to select from a list of 
available FCS keywords present in the file header to display as the axis 
label. You may combine multiple FCS headers and text to create a 
customised axis label.

The Apply To All button applies the current axis label to all of the plots in 
the gallery for the current overlay plot. If the plot is a dual parameter plot, 
this button only sets the current axis (X or Y). Press the Reset to Default 
button to return the label to the default setting.

Regions on overlay plots
Regions can be defined on overlay plots using the Region group on the 
Overlay tab of the Ribbon (see chapter  Region group on page 112) and will 
be rendered black. When a region is moved or resized on any plot in the 
overlay, it is updated accordingly in all the rest of the plots in this overlay. 
Regions on the Overlays tab of the Workspace do not affect the source plots 
on the Plots tab of the Workspace. Statistics for regions are only displayed in 
gallery plots. Hovering the cursor over a region on a gallery plot displays a 
tooltip stating the name and the statistic associated with that region.

Regions are created and edited the same way as on plots in the Plots tab of 
the Workspace (see chapter  Creating regions on page 165).
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Sending plots to the report
To send plots to the report, select the desired plots in the Overlays area or 
the Galleries area, right-click and select the "Send selected Plot(s) to Report" 
option. The currently selected plots are sent to a new page at the end of the 
current report. For information on reports, see chapter 12.8.4 Reports tab of 
the Workspace on page 179.

Using control plots
Single parameter gallery plots can be selected to be control plots. A control 
plot is displayed on all the plots in its gallery.

To define a control plot, select the plot from the Galleries area and right-click 
to open the context menu.

The following options are available:

 Set as Control Plot is available when a single gallery plot is selected. 
Select the option to display the plot as a control on all gallery plots of the 
current overlay plot. The gallery plot set as a control displays a dashed 
border.

If a control plot is already set, selecting another plot as a control will 
replace the currently set control with the new selection on all plots within 
the gallery.

 Remove Control Plot is available when a plot is set as a control for the 
gallery. This option removes the control plot from all plots in the gallery.

 Control in Front is available when a plot is set as a control for the 
current gallery. Select this option to display the control plot in front of the 
plot data. Deselect the option to display the control plot in the 
background of the plot data.

Alternatively, the buttons in the Controls group of the Overlay Format tab of 
the Ribbon can be used (see chapter  Controls group on page 134).

Moving and copying plots from the Galleries area to an overlay plot
To add plots to an overlay plot from the Galleries area, select the plot(s) from 
the Galleries area and right-click to open the context menu.

The following options are available:

 Move selected Plot(s) to Overlay Plot moves the currently selected 
plots to a new selected overlay plot. If all of the selected plots already 
exist in an overlay plot, that overlay plot is greyed out in the list. If some 
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of the selected plots already exist in the target overlay plot, any new plots 
will be added but all selected plots will be removed from the current plot.

 Copy selected Plot(s) to Overlay Plot takes a copy of the selected 
plots and adds them to a new selected overlay plot. If all of the selected 
plots already exist in an overlay plot, that overlay plot is greyed out in the 
list. If some of the selected plots already exist in the target overlay plot, 
any new plots will be added but existing plots will not be added to the 
target overlay plot.

12.8.4 Reports tab of the Workspace

In the Reports tab of the Workspace, you can create page-based reports 
from a Playlist or from a panel of a Worklist. Reports can be used to create a 
customised page-based summary of plots, statistics and other information. A 
report can comprise up to 800 pages.

In Playlist mode, there is a single report per Playlist. In Worklist mode, there 
is a single report per panel of the Worklist.

On selecting the Reports tab in the Workspace, a blank report page is 
displayed. The Report tab of the Ribbon automatically becomes active 
providing options to edit the report (see chapter 12.4.12 Report tab on 
page 114).

Reports are created by inserting objects into the report page. Objects can be 
inserted via the Insert group on the Report tab of the Ribbon or sent to the 
report from the Plots tab of the Workspace.

In Playlist mode, you can also use the Report Wizard on the Report tab of 
the Ribbon to create reports.

1 Header of a report page
2 Body of a report page
3 Footer of a report page

2

3

1
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The following objects can be inserted into reports:

 plots,

 statistics boxes,

 compensation matrices,

 fields (objects containing derived contents such as file names, file paths, 
etc.),

 images,

 text boxes (boxes provided for entering free text),

 lines.

Each report page consists of three separate sections: header, body and 
footer. All elements of the header and footer sections are repeated on all 
pages of the report.

If the source information for an inserted object is unavailable, a red 
exclamation mark will be displayed on the report. If the source information of 
the associated Playlist item is unknown, a blue question mark will be 
displayed on the report. If a field has been inserted and the value is not 
present in the file or if a file is not present, "ERROR" will be displayed 
instead of the value.

Inserting objects into a report
In Playlist mode, objects from any item of the current Playlist can be inserted 
into a report. In Worklist mode, objects from the current panel of the Worklist 
can be inserted.

There are several possibilities to insert objects into a report:

 From the Insert group of the Report tab of the Ribbon, click the desired 
button to display a drop-down list and select the desired object.

To insert this object in a default size, click into the desired page section 
(i.e. header, footer or body) of the report. The object is bounds checked 
to the section and resized and/or repositioned as necessary.

To insert the object in a custom size, drag out an insertion rectangle to 
the required size of the object and then release to insert the object at the 
desired size. Starting a drag in a particular page section (i.e. header, 
footer or body) restricts the insertion rectangle to the bounds of that 
section.

An object can be inserted into a report if the cursor is displayed as a 
crosshair when moved over a reports page. If an object cannot be 
inserted, a "no entry" sign is displayed. The cursor remains a "no entry" 
sign until the object is inserted in a valid location or the Esc key is 
pressed.

 Plots and statistics can also be inserted into a report by sending them 
from the Plots area of the Workspace. For this purpose, select one or 
more plots in the Plots area of the Workspace. Right-click to display a 
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context menu and select whether to send the selected plot(s) and/or their 
associated statistics to the report. If the last page of the report contains 
any objects, sent objects start on a new blank page in the report. If the 
last page is blank, sent objects start on this page.

 Results tables from the Results tab of the Workspace can be inserted by 
clicking the Send Table To button on the Statistics tab of the Ribbon.

 FCS file information can be inserted from the FCS File Information pane 
using the Send To Report... button.

Ensure objects do not obscure each other when inserted to a report.

Make sure statistics boxes contain enough information to clearly identify 
which files the results come from. You may need to add file name or gate 
name to ensure this. You should also make sure that enough space has 
been allocated for the statistics box so that the full results are visible.

When inserting a compensation file name, the name of the compensation file 
present in the Playlist will be displayed even if you have cleared 
compensation, manually modified the compensation or loaded compensation 
from header.

Selecting objects on the report page
The options for selecting objects on a page are:

 To select a single object, click on it.

 To select multiple objects, hold the Ctrl key while selecting the objects.

 To select objects on a per page basis, draw a blue selection rectangle 
around the desired objects. The rectangle can only be drawn when the 
cursor displays the selection arrow (i.e. the cursor is not selecting an 
object). The rectangle selects everything it touches. Objects on multiple 
pages cannot be selected via a selection rectangle.

To select objects inserted into the header and footer regions with the 
rectangle, start drawing the rectangle in the header or footer regions as 
desired.

 To select all body section objects within a report, press Ctrl + A.

 To select all body section objects of the same type within a report, press 
Ctrl + Shift + A.
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Moving objects
Moving the cursor over an object on a report page will change the cursor to a 
move icon. The object can then be dragged and dropped to new locations 
within the pages of a report. If objects are selected within different sections 
(header, footer, body) or different pages, the move cursor is not displayed 
and objects cannot be moved.

Objects can be moved between the header, footer and body sections of a 
page and are subject to bounds checks. If an object (or group of objects) is 
too big to fit in the new section, a "no entry" sign is displayed. Trying to drop 
the object will move the object back to its original position on the page.

Resizing objects
When an object is selected on a report page, it can be resized using the 
resize handles. When resizing an object, it is bounds checked to its current 
section on the page and cannot be resized outside of these bounds.

The options for resizing objects are:

 Moving the cursor over one of the handles will change the cursor to a 
double-headed arrow indicating which way the object will be resized.

 The aspect ratio of a plot is fixed and is always square.

 When moving corners of images, their aspect ratio is maintained.

 When moving corners, the aspect ratio of the statistics box, 
compensation matrix, text box and field is not fixed, i.e. it can be 
stretched horizontally or vertically.

 For all objects, holding Shift whilst resizing using a corner handle will 
maintain the aspect ratio.

 When moving the top or bottom centre of the statistics box, 
compensation matrix, text box, field and image, its height can be resized.

 When moving the right or left middle of the statistics box, compensation 
matrix, text box, field and image, its width can be resized.

The options for resizing lines are:

 Moving the cursor over either handle will change the cursor to a 
crosshair, indicating the handle can be moved in any direction.

 To resize or change orientation of the line, drag either of the handles. 
The line can be dragged to any size and orientation around 360 degrees. 
The line is limited to the current section on the page.

 To fix the position of a line to horizontal and vertical positions, hold the 
Shift key and drag the handle. To relocate the line to its new position, 
first release the mouse and then let go of the Shift key.
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Resizing headers and footers
To resize a header or footer, click and drag the divider of the header or 
footer up or down as required. The size of the header and footer is applied to 
all pages in the report.

If the header or footer contains an object, the divider cannot be dragged 
beyond the border of that object.

If the body section contains an object close to the header or footer boundary, 
you can still drag and drop the divider as required. Upon releasing the drag, 
the object will be bounds checked, moved and, if necessary, resized to 
accommodate the new header or footer size.

Editing inserted text
To edit text, double-click the desired text box and edit the text as required.

Deleting objects
To delete an object from the report, select it and press the Delete key or the 
Delete button in the Edit group of the Report tab of the Ribbon.

Using the report context menu
Right-click on the report page brings up a context menu allowing to paste, 
cut or copy selected items in the report. When pasting, objects are pasted 
cascaded (down and to the left) from their original position on the page.
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12.9 Status bar

The status bar is located at the bottom of the software window. The status 
bar displays the current status of calculations, of the current measurement 
and of compensation settings. When regions are modified, it displays the 
coordinates. The status bar also provides a resize slider for plots and 
overlays.

Calculation indicator
The Calculation indicator indicates if the processing of results has been 
completed:

 When all items are up to date, a green icon is displayed.

 When background calculation is in progress, an orange icon is displayed.

 When background calculation is off and some items have not been 
calculated, a red icon is displayed. This icon acts as a button. Clicking it 
is equivalent to clicking the Calculate Now button of the Playlist tab of 
the Ribbon and will recalculate all results.

Miscellaneous messages
In this area of the status bar, the following messages are displayed:

 Ribbon controls: For each Ribbon control, a status bar message is 
displayed describing the function of the control.

 Window controls: For the Quick Access Toolbar icons and the File menu 
options, a status bar message is displayed describing the function of the 
option.

 Print preview: When the print preview is displayed, the status bar will 
show the current displayed page or page range.

 Region coordinates display: When a control point of a region on a plot is 
moved, the coordinates of the region are displayed.

 Cell cycle analysis: While a noise threshold estimate marker is being 
repositioned, information regarding the noise threshold, G1 and G2 
estimates and the upper noise threshold is displayed.

 Device functions or fluid level errors: During a device function, a status 
bar message stating the name of the function currently being performed 
will be displayed. If a fluid level error occurs, the appropriate error 
message is displayed.

1 Calculation indicator
2 Miscellaneous messages
3 Status of acquisition
4 Sample level indicator

5 Sheath fluid and waste level indicator
6 Status of the device
7 Status of compensation settings
8 Resize options

3 874 5 61 2
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Status of acquisition
During acquiring, the current status of the acquisition process is displayed:

 Part displays the absolute number of particles recorded.

 Part/S displays the rate of measurement in particles per second.

 µL displays the absolute volume.

 Sec displays the absolute time.

If a stop condition is in use, a progress bar under the relevant counter(s) will 
be displayed.

Fluid level indicators
The icons indicate the fluid level of a tube on the manual sample probe and 
that of the sheath and waste bottles as detected by the respective 
electrodes:

 Sample level: The icon is green when the sample is full or low. The icon 
is red if there is no sample tube attached or the sample is below both 
electrodes. Hover over the icon to display a corresponding tooltip on the 
sample level.

 Sheath and waste level: The icon is green when the sheath and waste 
levels are sufficient. The left part of the icon is red if the sheath level is 
too low. The right part of the icon is red if the waste level is too high. 
Hover over the icon to display a corresponding tooltip on the levels.

On change of fluid level status, a warning balloon will be displayed above the 
status bar icon. When the sheath fluid bottle is empty or the waste bottle is 
full, a warning balloon pops up automatically, to signalise the critical fluid 
level. If the device is measuring a sample when a fluid level error occurs, a 
timer will start, and you will be allowed to continue acquiring the current 
sample for up to 10 minutes. If the error condition is not corrected, the 
warning balloon will be redisplayed at 5 minutes remaining, 3 minutes, 
2 minutes and 1 minute remaining. After that, acquisition will automatically 
be stopped and the appropriate fluid level error message displayed

If an instrument function is not taking place and a sheath or waste level error 
is detected, the fluid level error message is displayed immediately. If any 
other instrument function is taking place, that function will be allowed to 
complete and the error displayed at completion.
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Status of the device
This symbol indicates the status of the device.

 Green: The device is operational.

 Yellow: Maintenance is necessary.

 Red: A problem occurred.

 Caution symbol: The DLI is not connected.

Status of compensation settings
The status of the compensation settings of the current file is displayed 
indicating if the file is not compensable, if the compensation is unaltered or if 
the compensation has been modified.

If the Manual Compensation button on the Compensation tab of the Ribbon 
is active, a warning icon and the text "Manual Compensation" is displayed.

Resize options

To resize plots displayed in the Workspace, first select the type of plots to 
resize using the plot type buttons:

 Resize Plots (enabled in the Plots tab of the Workspace),

 Resize Previews (enabled in the Plots tab of the Workspace),

 Resize Overlays (enabled in the Overlays tab of the Workspace),

 Resize Galleries (enabled in the Overlays tab of the Workspace).

Then use the resize slider to adjust the size of items as required. Move the 
slider to the desired position or click to the left or right of the slider to 
decrease or increase the size of the selected plot type, respectively.

1 Resize Plots button
2 Resize Previews button
3 Resize Overlays button

4 Resize Galleries button
5 Resize slider

4

5

321
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12.10 CyFlow Options

The CyFlow Options dialogue contains controls to set various default options 
for the software. It is launched from the CyFlow Options button on the File 
tab of the Ribbon (see chapter 12.4.1 File tab on page 58). 

The CyFlow Options dialogue has several pages accessed by selecting the 
options in the list to the left of the dialogue. The button for the currently 
selected page is highlighted in the list.

General page
The General page contains options to specify how statistics displayed on 
plots are to be rounded and to set the default colours used for regions, 
gates, overlay plot histograms and histogram plots.

The page contains the following options:

 Statistic Decimal Places: This control allows you to set the number of 
decimal places to which the statistics displayed on the plots and results 
table are rounded. The default is 2 decimal places. To edit, enter a value 
or use the up/down arrows to select a number. The acceptable range is 
between 0 and 10 decimal places.

 KS Statistic Decimal Places: This control allows you to set the number 
of decimal places to which the statistics displayed on gallery  plots of 
overlays and results are rounded. The default is 6 decimal places. To 
edit, enter a value or use the up/down arrows to select a number. The 
acceptable range is between 0 and 10 decimal places.

 Region/gate and overlay data colors: The ten-colour index displayed 
here controls the default order in which colours are used when creating 
regions, gates and overlay plots. To modify a colour used in this default 
index, click the corresponding arrow button to display a colour control 
and select the desired colour. The colour assigned to the existing regions 
is not changed.

Click the Reset to Default button to return the region colours to their 
default settings.
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 Quadrant Color: The box displays the default colour for the quadrant 
divider lines and is used when quadrant regions are created. This will not 
affect the colour of quadrant gates. The default colour is Grey-40%. To 
edit, click the arrow and select a colour. The colours of previously 
created quadrant divider lines are not changed.

Click the Reset to Default button to return the quadrant region colour to 
its default setting.

 Histogram Color: The box displays the colour for histograms displayed 
in the Plots area. The default colour is coloured Gray-25%. To edit, click 
the arrow and select a colour.

Click the Reset to Default button to return the histogram colour to its 
default setting.

 Precedence Ungated Event Color: The box displays the colour for 
ungated events on precedence plots. The default colour is black. To edit, 
click the arrow and select a colour.

Click the Reset to Default button to return the ungated event colour to its 
default setting.

 Use small plot gate color indicator: This option is checked by default. 
When checked, the gate colour indication present on the plot is reduced 
to a 3D colour circle in the top right-hand corner of the plot. When 
unchecked, the plot border will be a gradient fill based on the plot gate 
colour.

 Display Ungated Plot Stats: This option is unchecked by default. 
Selecting the check box will display plot gate statistics in all results 
tables.

Region page
The Region page contains options to specify the available default region 
names.
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The page contains the following options:

 Quick select region names: By default, the software offers three region 
names that can be designated to regions: Lymphs, Grans, Monos. To 
edit, double-click on a region name. To add new region names, click the 
New button or double-click below the last name in the list. To delete, 
select the name and click the Delete button. Regions can be reordered 
using the arrow buttons.

The region names listed here can be applied to a selected region by 
clicking the "Region Name" drop-down list in the Region Format tab (see 
chapter  Appearance group on page 128).

Scaling page
The Scaling page contains options to specify the default options used for 
Log and V-Log scaling. The setting here is only used if there is no 
Workspace file or if the open Workspace file and the current listmode file do 
not contain any defined scaling. As soon as a Workspace or listmode file 
which contains scaling values is opened, those values are used instead of 
the default values.

The page contains the following options:

 Log Decades: The value set here determines the number of decades 
shown when logarithmic data is displayed and is used for scaling all 
relevant plots and statistics. Click the arrow to display a drop-down list 
and select the desired value (4 decades, 5 decades or full range) or enter 
a value.

When full range is selected, the data for all logarithmic scaled 
parameters in the Workspace defaults to the full range of data in the 
listmode file. This is the default selection.

The accepted range for log decades is between 0 and 10.00. The 
number that you enter here should match the number of decades 
provided by your device. If you enter a value that is higher than the 
maximum range in the listmode file, the data will be offset from its correct 
position on the scale. The number of decades selection has no effect on 
low-resolution files with less than 12 bit data resolution.
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 V-Log Linearity (%) and V-Log Negative Section (%): These options 
allow you to select the default values for scaling of V-Log parameters. 
The accepted range is between 0 and 100%. To edit, enter a value or 
use the up/down arrows. 

The values entered here will be the default values displayed in the 
Default Scaling tab of the Scales Properties dialogue (see chapter  
Scales Properties dialogue on page 81). The V-Log group is disabled for 
low-resolution data (i.e. less than 12 bits).

 Reset to Default: Click the button to return the scaling options to their 
default settings.

 Export page
The Export page contains options to specify how results are to be exported 
to CSV files and to specify default options used when images are exported.

The page contains the following options:

 Result Export Format: Select the "Single row per file, result types are 
grouped together" option to display all the results from the results table, 
grouped together and exported in a single line. If multiple files are 
exported, a new line is created for each file. When using Microsoft® Excel 
2003 the maximum number of columns is limited to 256. If you need to 
generate tables with more than 256 columns, you should upgrade to 
Excel 2007.

Select the "One row per result, columns are result type" option to display 
all the results from the results table, exported in the order they appear in 
the table

 ChartJunk on Exported Images: This option allows you to select the 
detail displayed on plot images when copied and pasted to other 
applications (e.g. Microsoft® PowerPoint). Uncheck any item that is not 
required for the pasted plot images.

 Default Plot Image File Format: This option sets the default file format 
for the "Save Plot(s) as…" menu item. Options include BMP, JPEG, GIF, 
TIFF and PNG. The default setting is BMP.
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Instrument Configuration page
The Instrument Configuration page contains options to set the configuration of 
your device when using an offline PC to create a Worklist.

The page contains the following options:

 ICF: The ICF (instrument capabilities file) drop-down list contains the title 
tag from each of the ICF’s held in the InstrumentConfigurations.xml file in 
addition to the default configuration option which appears at the top of the 
list. Select an ICF to use the ICF configuration when a new Worklist is 
created.

The ICF information contains the type of device, autoloader type, manual 
port availability, sorter availability and lasers. The lasers defined in the ICF 
will determine the laser options displayed in the Acquire pane. The 
sources defined in the ICF will determine the available options in the 
Source Selection dialogue when creating a new Worklist.

 Delete: Click the button to delete the currently selected ICF (and 
associated SCF’s) from the InstrumentConfigurations.xml file and from the 
ICF drop-down list. The default configuration will be automatically selected 
in the drop-down list.

 Export: Click the button to save the currently selected ICF (and 
associated SCF’s).

 Import: The button is only enabled when the workstation has not been 
connected to a DLI (device layer interface) before. Click the button to 
import an ICF (and associated SCF’s) into the 
InstrumentConfigurations.xml file. The ICF will be present and 
automatically selected in the ICF drop-down list.

 SCF: The SCF (system configuration file) drop-down list contains the title 
tag from each of the SCF’s (of which there will be one or more) defined 
under the currently selected ICF. The SCF information contains the 
parameters and tray types.

At the point of opening a Worklist or connecting to a DLI, a validation process 
is started checking the configuration of the Worklist against the ICF and SCF 
contents. Also, when loading a Workspace file into a Worklist, the Workspace 
file is checked against the ICF and SCF contents that are held within the 
Worklist. If validation fails, an error message is displayed.
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Font pages
There are six Font pages containing options to select the default font 
typeface and size of text displayed in the Workspace. On the right of each 
page, a preview plot is displayed.

The following pages are available:

 Font - Region Labels to select the font typeface and size for region 
labels in plots and overlays.

 Font - Plot Titles to select the font typeface and size for plot titles in 
plots and overlays.

 Font - Cell Cycle Names to select the font typeface and size for cell 
cycle names in plots.

 Font - Parameter Names to select the font typeface and size for 
parameter names in plots and overlays.

 Font - Legend/Stats Text to select the font typeface and size for the 
legend and gallery statistics text in overlays.

 Font - Scale Labels to select the font size of scale labels in plots and 
overlays. On this page, only three options are available: small (4 pt), 
medium (5 pt) and large (6 pt) font size.

The pages contain the following options:

 Reset to Default: Click the button to reset the font typeface to its default 
setting, which is Arial.

 Automatic sizing: Select the check box to achieve automatic sizing of 
texts. This is the default setting. The check box is not available for cell 
cycle names.
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Resources page
The Resources page contains options to access license and software 
version information.

The page contains the following options:

 License: Click the button to access the license information and update 
your user license.

 About: Click the About button to view software information, version 
number and copyright details.

12.11
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	3. In the "Threshold" column, adapt the threshold values to reduce background for each parameter triggered. Increase or decrease the threshold settings if the background is still too high or if the cell population of interest is cut off.

	Creating a region
	1. Select the Home tab of the Ribbon (see chapter 12.4.2 Home tab on page 65).
	2. To preselect creating an elliptical region, a rectangular region, a polygonal region, a linear region or a quadrant region, click the corresponding button on the Region group (see chapter 12.4.2 Home tab on page 65).
	3. For elliptical, rectangular or linear regions (on single-parameter plots), draw out the region on the plot.
	4. To assign a name to the region, select the region and double-click the region name on the plot. Enter a region name in the edit field or select a name from the drop-down list.

	Setting a parent gate
	1. In the Plots area of the Workspace, select the desired plot.
	2. On the Home tab of the Ribbon (see chapter 12.4.2 Home tab on page 65) click the arrow on the "Gate" box to expand a drop-down list and select the desired region to be applied as a parent gate.

	Stopping the measurement
	1. On the Acquire pane (see chapter 12.5.4 Acquire pane on page 140) click the Stop button.

	Performing a manual compensation
	1. On the Compensation tab of the Ribbon (see chapter 12.4.6 Compensation tab on page 84) click the Manual Compensation button and the Plot Compensation button.
	2. On the plot, draw the desired population of events into the required area of the plot.

	Saving the Workspace and the instrument settings
	1. To save the Workspace of a Worklist item, select the File tab of the Ribbon (see chapter 12.4.1 File tab on page 58) and select "File > Save > Save Workspace" or "File > Save > Save Workspace As".
	2. To save the instrument settings of a Worklist item, right-click the Worklist item in the Worklist to open the context menu and select "Instrument Settings > Save Instrument Settings".

	Defining the Worklist for remaining samples
	1. In the Worklist, enter a Lab # and sample IDs for the Worklist items as desired.
	2. To apply the Workspace developed from the sample to all Worklist items, right-click the Worklist item to open the context menu and select "Workspace > Apply To".
	3. Select whether to apply the Workspace to the current panel or to the entire Worklist.
	4. If differing instrument settings are to be used, click into the "Instrument Settings" cell of the Worklist item, select "Load from file" and select the desired instrument settings file.
	5. To apply the differing instrument settings to other Worklist items, right-click the "Instrument Settings" cell to open the context menu and select "Apply to Panel".
	6. To define differing stop conditions for the remaining samples, select the desired stop conditions from the Stops pane (see chapter 12.5.6 Stops pane on page 144).

	Saving the Worklist
	1. To save the Worklist, select the File tab of the Ribbon (see chapter 12.4.1 File tab on page 58) and select "File > Save > Save Worklist" or "Save Worklist As".


	6.6.2 Analysing data and creating reports using the Playlist
	Analysing data using the Playlist
	1. To create a new Playlist, select the File tab of the Ribbon (see chapter 12.4.1 File tab on page 58) and select "File > New > New Playlist".
	2. To open a Playlist item in the Playlist, select the File tab of the Ribbon and select "File > Open > Open Listmode".
	3. Plots, regions and gates can be edited in the Plots tab of the Workspace as desired (see chapter 12.8.1 Plots tab of the Workspace on page 160).
	4. Statistics can be displayed and edited in the Results tab of the Workspace (see chapter 12.8.2 Results tab of the Workspace on page 171).
	5. In Playlist mode, for setting compensations, the Compensation Wizard from the Compensation tab of the Ribbon can be used (see chapter 12.4.6 Compensation tab on page 84).
	6. To save the compensation, select the File tab of the Ribbon and select "File > Save > Save Compensation As".
	7. For comparing plots to each other, overlay plots can be created manually (see chapter 12.8.3 Overlays tab of the Workspace on page 174).

	Creating a report
	1. Select the Reports tab of the Workspace.
	2. From the Page Setup group on the Report tab of the Ribbon (see chapter Pages group on page 119), select the desired page orientation (portrait or landscape) and page size (A4 or letter).
	3. From the Insert group on the Report tab of the Ribbon (see chapter Insert group on page 120select the items to be shown in the report.
	4. Click on the desired section of the report page (header, body, footer) to insert the selected item in a default size or draw an insertion rectangle to get a custom size.
	5. Use the options provided in the Report tab of the Ribbon to insert and organise pages, to edit text and other items and to arrange items.




	7 Troubleshooting
	7.1 Performing a de-bubble procedure
	1. On the Cytometer tab of the Ribbon, click the De-bubble button.
	2. Follow the instructions until the finish message is displayed.

	7.2 Performing a de-clog procedure
	1. On the Cytometer tab of the Ribbon, click the De-clog button.
	2. Follow the instructions until the finish message is displayed.

	7.3 Sheath fluid, waste and fluids
	7.4 Calibration and Count Check Beads (low, medium, high)
	7.5 Measurements and data acquisition

	8 Cleaning
	Contaminated sheath fluid bottle
	Using incorrect cleaning solvents
	8.1 Cleaning the device
	Clean the device casing with a soft cloth on a regular basis carefully. Water should not enter the device or peripheral devices or come into contact with electric connections and switches.

	8.2 Performing a cleaning procedure
	1. On the Cytometer tab of the Ribbon, click the Clean button.
	2. Follow the instructions until the finish message is displayed.


	9 Maintenance
	10 Disposal
	Contamination of the environment

	11 Technical data
	Heavy weight

	12 Software description
	12.1 Overview
	In Worklist mode, data can be acquired. The hardware and software settings for each measurement are predefined and organised in a list called Worklist.
	Quick Access Toolbar: The Quick Access Toolbar provides quick access to some of the most commonly used options in the software.

	12.2 Views of the software window
	Displaying and hiding the panes
	Undocking and positioning the panes
	Click the title bar and relocate the pane by dragging and dropping. When a pane is selected, its title bar is highlighted in orange.


	12.3 Quick Access Toolbar
	Adding a button to the Quick Access Toolbar
	Removing a button from the Quick Access Toolbar
	Showing the Quick Access Toolbar below the Ribbon
	Minimising the Ribbon

	12.4 Ribbon
	12.4.1 File tab
	Recent documents
	New
	New Playlist: Click the menu item to create a new Playlist. Selecting this option will clear the current Playlist or Worklist, and a new blank Playlist will be displayed in the Playlist pane.

	Open
	Open Worklist…: Click the menu item to open a Worklist file (XMLWL file). Only one Worklist file can be open at a time.

	Save
	Save Worklist: Click the menu item to save the current Worklist with the current Worklist file name.
	Save Workspace: Click the menu item to save the current Workspace with the current Workspace file name. A Workspace includes plots, regions, gates, colour precedence, selected statistics and displayed parameters. The Workspace file is always saved wi...

	Print
	Print…: Click the menu item to print plots, statistics or reports. A dialogue box appears. Select the printer, define the print range and the number of copies and select what to print (plots and statistics for the current Workspace or the current r...

	Export
	Export Statistics to CSV: This menu item is only enabled when there are results present in the results table. The results exported to a CSV file are the columns displayed in the results table in the Results tab of the Workspace. The format of the exp...

	Tools
	User Management
	Create: Click the button to create a new user account.
	Log In Attempts: Click the item to define the number of login attempts before the account will be locked (1 to 10 attempts).

	Log Out
	CyFlow Options
	Exit CyFlow Software

	12.4.2 Home tab
	Load group
	Open Listmode: The button is only enabled in Playlist mode. Click the button to open one or more listmode files (LMD or FCS files) and select the desired files to add them to the Playlist. The Playlist item of the first added listmode file will be ac...

	Region group
	Elliptical Region: Click the button to preselect creating an elliptical region on a dual parameter plot.

	Add Plot group
	Density Plot: Click the button to add a dual parameter density plot displaying the first two parameters of the current listmode file. This will normally display a plot showing Forward Scatter against Side Scatter.

	Parameters group
	X and Y Parameter Selection:

	Gate group

	12.4.3 Analyze tab
	Region group
	Elliptical Region: Click the button to preselect creating an elliptical region on a dual parameter plot.

	Plots group
	Histograms: Click the button to add all the single parameter histogram plots displayed in the Previews area of the Workspace to the Plots area. The plots are gated with the same gate as the preview plots. All the added plots are colour-coded to illus...

	Gate group
	Move to top, Move up, Move down, Move to: Select a gate and use these buttons to move the selected gate to the desired position within the gates list.
	The "Gate name" column displays the name of the gate. The colour of the font is the colour of the gate.
	The "Gate name" column displays the name of the gate. The colour of the font is the colour of the gate.
	New Gate: Click the button to add a new gate. A gate with a default name is added to the bottom of the gate list.

	View group
	Gallery: Click the button to choose the Gallery plot view. The plots in the Plots area are displayed next to each other.

	Edit group
	Paste: Click the button to paste previously copied or cut report items back into the report. The button is only enabled on the Reports tab of the Workspace, after a report item has been copied or cut.


	12.4.4 Preview tab
	Preview group
	Show Previews: By default the button is selected, and previews of all parameters are displayed in the Previews area. Clicking the button switches between hiding and showing the previews. The setting of this button will be persisted between sessions.

	Scaling group
	Display as Log: The parameters displayed in the Previews area can be shown with either linear or logarithmic scaling. Click the arrow to expand a drop-down list and select the parameters to be displayed as logarithmic.

	View group

	12.4.5 Parameters tab
	Parameter Properties
	On the Customize tab, you can select which parameters are displayed in the Previews area. You can also choose a display name and assign custom names to individual parameters.
	The "In Use" column contains check boxes. Select a check box to display the corresponding parameter in the Previews area or deselect it to hide the parameter. Selecting and deselecting parameters here does not affect plots already present in the Plot...
	Select All: Click the button to select all parameters.
	The "Parameter" column displays the parameter name for each of the parameters available in the currently loaded listmode file.

	View group
	Area (Integral): The button toggles the selection of all Area / Integral parameters, i.e. parameters that represent the area under the curve from a pulse.

	Scatter group, Fluorescence group and Other group
	Scales group
	The Scaling button opens the Scales Properties dialogue that is used for presetting scaling of parameters for display in the Workspace (see chapter Scales Properties dialogue on page 81).

	Scales Properties dialogue
	In the Default Scaling tab, you can modify the Linear, Logarithmic and V-Log scaling options for parameters in the Workspace
	Full Range: Select this option to scale all linear parameters in the Workspace and reports to the full range of data.
	The "Parameter" column contains the display name for each parameter in the listmode file. This column has a tooltip detailing the acceptable range for the Scale Min and Scale Max with respect to the scale type selected.
	Reset Selected Parameters: Click the button to reset the values for the currently selected parameters to their defaults.


	12.4.6 Compensation tab
	Wizard group
	Configuration Page

	Compensation Wizard: Configuration Page
	Parameters: The list displays all the parameters from the first LMD file in the Playlist in the format parameter name ($PnN) - stain name ($PnS). Parameters identified as fluorescence are automatically selected. You can deselect the ones you do not w...

	Compensation Wizard: Background Fluorescent Page
	Negative control file: The field displays the name of the negative control LMD file that will be used for the background fluorescence computation.

	Compensation Wizard: Compensation Pages
	Stain for compensation: The field displays the stain that is being currently compensated.

	Compensation Wizard: Review Page
	Compensation matrix: The matrix displays the completed matrix of compensation values.

	Plot Compensation group
	Plot Compensation: To enable plot compensation, select a plot in the Plots area that contains the parameters required for compensation and then click the button. The button is highlighted, and the arrow buttons and manual dragging of populations on p...

	Preview Details group
	Compensation group
	Show Matrix: Click the button to display the Compensation Matrix dialogue. The dialogue shows the compensation matrix associated with the current file.


	12.4.7 Statistics tab
	When in the Plots tab of the Workspace, only one statistic can be selected at any time. The currently selected statistic is displayed adjacent to the region for all regions on all plots in the Plots area. If you select a new statistic, the previously...
	Results Tables group
	Add Table: Click the button to create a new results table.

	General group
	X Parameter displays the X parameter of the plot containing the region.

	Events group
	Count displays the number of events in the region.

	Intensity group
	X Peak displays the peak channel (mode) for the X-axis histogram of a region.

	Variation group
	X Var displays the variance for the X-axis histogram of a region.

	DNA Statistics group
	DNA Stats: Select the check box to display all DNA statistics for all regions in the results table.


	12.4.8 Worklist tab
	General group
	New Worklist: Click the button to create a new Worklist

	Panel group
	Save: Click the button to save the panel with the same name.

	Workspace group
	New Workspace: Click the button to create a new Workspace file. The option will create a default Workspace file for the selected Worklist item. The option is disabled when more than one Worklist item is selected or when a compensation setup panel is ...

	Instrument Settings group
	Save: Click the button to save the instrument settings file with the same name. The threshold, threshold logic, voltages and compensation settings will be saved to the target file.

	Calculation group
	Background Calculation: Select the check box to turn on the automatic background calculation. All statistics in the Results tab and objects in the Reports tab of the Workspace are calculated in the background as the active panel is modified. This app...


	12.4.9 Playlist tab
	Listmode group
	Replace: The button is enabled when one or more Playlist items are selected in the Playlist. To replace the selected Playlist items, click the button and select the desired replacement listmode file(s).
	Parameter Mismatch: A parameter mismatch can occur between the listmode file and the Workspace file of an item. To successfully replace the listmode file, the parameter mismatch must be resolved. If the mismatch is not resolved, the listmode file is ...

	Workspace group
	Replace: The button is enabled when one or more Playlist items are selected in the Playlist. To replace the Workspace for the selected Playlist items, click the button and select the desired replacement Workspace.

	Compensation group
	Replace: The button is enabled when one or more Playlist items are selected in the Playlist and at least one of the selected Playlist items is compensable. To replace the compensation file(s) of the selected items, click the button and select the des...

	Calculation group
	Background Calculation: Select the check box to turn on the automatic background calculation. All statistics in the Results and Reports tabs of the Workspace are updated constantly in the background as the Playlist is modified. Whilst the software ca...


	12.4.10 Cytometer tab
	Cleaning group
	Script Selection: In this box, the intensity of the cleaning procedure to be performed can be preselected. Click the arrow to expand a drop-down list containing the scripts specified for the level of cleaning functions and select the desired intensit...

	Sort group
	Compensation Settings group
	Select Parameters for Gating: Click the buttons to display drop-down lists and select the desired X and Y parameters for gating. These parameters will be used for the X-axis and Y-axis of gating plots within the negative control sample (if selected),...
	Panel: <prefix name>-SetupPanel.xml

	Compensation setup panel
	Voltage adjust Workspace (always present):


	12.4.11 Overlay tab
	Wizard group
	Welcome Page,

	Overlay Wizard: Welcome Page
	Overlay Wizard: Plot Selection Page
	Plot Order: Plots appear in the created overlay plot in the order they appear in the plot list. To change the order, click the up/down arrows to move selected plots up and down in the list. To reset the plot order, use the Reset button.

	Overlay Wizard: Overlay Layout Page
	Display all plots from all files together: Select the option to display all the selected plots from all the files in the Playlist on one overlay plot. If you have selected both single and dual parameter plots, these are arranged on separate overlay p...

	Overlay Wizard: Overlay Labels Page
	Overlay Title: Enter a title for the overlay plot.

	Region group
	Elliptical Region: Click the button to preselect creating an elliptical region on a dual parameter plot.

	Plots group
	Galleries View group
	Edit group
	Copy: Click the button to copy an image of the currently selected plot(s) onto the clipboard. You can then paste them into other applications (Microsoft® Word, PowerPoint, etc.).


	12.4.12 Report tab
	Wizard group
	Welcome Page,

	Report Wizard: Welcome page
	Report Wizard: Plots Selection page
	Plot Order: Plots appear in the report in the order they appear in the plot list. To change the order, click the up/down arrows to move selected plots up and down in the list. To reset the plot order, use the Reset button.

	Report Wizard: Statistics Layout page
	Display Statistics on Report: Select the check box to display statistics on the generated report.

	Report Wizard: Statistics Selection page
	Select statistics types from: By default, all statistics are available for selection. Use the box to view a reduced group of statistics.

	Report Wizard: Report Layout page
	Plots per page: Use the drop-down list to specify the number of plots per page in the report. When not reporting statistics or when statistics are aggregated at the end of the report, you can have 1, 4, 9 or 20 plots per page. When reporting statisti...

	Edit group
	Delete: Click the button or press the Delete key on the keyboard to delete all currently selected objects.

	Pages group
	Add New Page: Click the button to add a new blank page to the end of the report. All new pages are assigned a unique number, which is displayed at the top left-hand corner. All new pages display a "Page X of Y" in the bottom right-hand corner. Up to ...

	Page Setup group
	Orientation: Click the button to display a drop-down list and select the desired page orientation (portrait or landscape). The page orientation to all pages in the report is changed. All header, footer and body objects that lie outside the bounds of ...

	Insert group
	Plot: Click the Plot button to display a drop-down gallery of all the plots currently open in the Workspace. The order in which the plots appear matches the order they appear in the Workspace when in Gallery view. To select a plot for insertion into ...

	Text group
	Format group
	Line End Cap: The box is enabled when one or more line objects are selected in the report. Click the arrow to expand a drop-down list and select the desired option for the line end (uncapped, solid arrowhead or line arrowhead).

	Arrange group
	Bring To Front: The button is enabled when one or more objects are selected on the same page and section (header, footer, body). Click the button to move the selected objects to the front of the view, making them appear on top of non-selected objects.

	Zoom

	12.4.13 Views tab
	Acquire pane,

	12.4.14 Plot Format tab
	Plot Type group
	Density: Select one or more dual parameter plots and click the button to display the selected plots as density plots. The dual parameter plots in the Plots area are density plots by default.

	Gate group
	X-Axis group
	Y-Axis group
	Histogram Scaling group
	Histogram Smoothing group
	Histogram Smoothing: The button is enabled when one or more single parameter plots are selected. The button displays the currently active smoothing method. To change the smoothing method, click the arrow to open the drop-down list and select the desi...

	Histogram Styles group
	Histogram Color: Click the button and select the desired colour to modify the line and fill colour of the selected histogram(s) in the Plots area.


	12.4.15 Region Format tab
	Appearance group
	Region Name: The box displays the name of the currently selected region. To change the region name, enter a name or select a name from the drop-down list. The region name on the plot and in the box will update.

	Type group
	Position group
	Ellipse: To position the centre of the elliptical region, use the "Center X" and "Center Y" input fields. A lower value positions the centre to the left or down, respectively. The values must be between -1500 and 1500.

	Tracking group
	Only regions that are on plots that display the same parameters can be linked.


	12.4.16 Overlay Format tab
	Format group
	Background: Select this option to choose a background colour for all selected plots. If overlay plots are selected, this option also affects the corresponding gallery plots.

	Overlays group
	Overlay Mode: Click the button to change all selected overlay plots to display in overlay mode.

	Histogram Scaling group
	Scale to 100%: The option scales all selected plots to their maximum values. If a control plot is present in the Galleries area, the control and test histograms are each scaled to their maximum values.

	Controls group
	Set Control: The button is available when a single gallery plot is selected. Click the button to display the plot as a control on all gallery plots of the current overlay plot. The gallery plot set as a control displays a dashed border.

	Calculations group
	None: The button is highlighted by default indicating that no calculation is being displayed for the current plot.

	Histogram Smoothing group
	3D group


	12.5 Panes
	FCS File Information pane,
	12.5.1 FCS File Information pane
	12.5.2 Results Hierarchy pane
	12.5.3 Settings pane
	Parameter: The column displays the default parameter name for each parameter.

	12.5.4 Acquire pane
	Play: Click the button to start measuring a sample.
	Prime: Click the button to start a priming procedure. Once started, the software guides you through the process.
	Above the flow rate slider, the acquisition flow rate (events per second) and the absolute event count are displayed during acquisition.

	12.5.5 Setup pane
	Setup Mode: Select the check box to store only the latest events in the buffer. Only these events are displayed in the Workspace.

	12.5.6 Stops pane
	The sample analysis automatically stops when the sample is empty (the stop electrode is reached) even if the selected stop condition is not yet realised.
	Event count: Select the check box to measure a defined number of events. In the "Stop Condition" box, click the arrow to expand a drop-down list and select the desired condition (ungated or the required gate) to base the stop event count on. The defa...


	12.6 Worklist pane
	Worklist title bar
	Worklist buttons
	New: Click the button to create a new Worklist or a new Playlist.

	Worklist rows and columns
	Active: A green arrow displayed in this column indicates the currently active Worklist item.

	Activating Worklist items
	Selecting Worklist items
	Single click on a Worklist item to select it.

	Worklist context menu
	New: Click the menu item to create a new Worklist or a new Playlist.

	Compensation setup panel

	12.7 Playlist pane
	Playlist title bar
	Move changes the cursor to a move cursor. The Playlist pane can then be moved using the arrow keys on the keyboard.

	Playlist toolbar
	First File: Click the button to skip to the first file in the Playlist and open the file in the Workspace.

	Playlist columns
	First column: This column displays a sequential number or the Playlist item. A green arrow displayed in this column indicates the active Playlist item, i.e. the Playlist item that is currently open in the Workspace.

	Activating Playlist items
	Selecting Playlist items
	Single click on a Playlist item to select it.

	Playlist context menus
	Insert Item: Click the menu item to insert a new Playlist item above the currently selected Playlist item.

	Adding files to the Playlist
	using the Open Listmode button in the Quick Access Toolbar,

	Playlist tooltips and error display
	Playlist items that have no errors are displayed in black.

	Modified file indicators
	Reordering Playlist items

	12.8 Workspace
	The Plots tab contains two areas: Plots and Previews. The Previews area automatically displays plots once a listmode file is opened. Plots can be added to the Plots area as required for further analysis. The Plots tab is open by default.
	12.8.1 Plots tab of the Workspace
	Plots area: Selected plots are displayed in the Plots area and can be analysed and modified in this area.
	Types of plots
	Single Parameter Histogram Plots display the 1024 bin histogram for a single parameter. The plot may be gated or ungated.

	Adding plots to the Plots area
	To add a single plot from the Previews area to the Plots area, double-click the desired plot in the Previews area.

	Gallery and hierarchy view
	Selecting plots
	To select a single plot within the Plots area, click on the plot.

	Resizing plots
	Selecting parameters for display
	Analysing and modifying plots in the Plots area
	Editing the Plot Title: To customise the title of a plot, double-click in the top margin of the plot and enter a custom title into the edit field. The title is added to the heading of the plot.

	Changing parameter properties
	Changing Plot Parameters
	To change the parameter of an axis of a plot, right-click in the area of the plot displaying the parameter name. A context menu is displayed that contains all the parameters currently selected on the Parameters tab of the Ribbon. Select the required ...

	Creating regions
	Elliptical Region: Click the region type button. Then either click on a dual parameter plot to set an ellipse of the default size, or draw out the required ellipse on the desired plot.

	Editing regions
	Ellipse: Elliptical regions have four control points that will be displayed when you click on a region to select it. You can use these control points to resize, rotate and move the elliptical region. While an elliptical region is being moved or resiz...

	Deleting regions
	Region names
	Region colour
	Regions and gates
	Scaling
	Linear Scales: Linear scaled parameters display linear tick marks and numbering. The default values are determined from information in the LMD file. Linear scaled data always starts at 0. The minimum and maximum values are always displayed at the end...
	If one or more of the parameters associated with the plot have non-default zoom settings, a Plot Zoom Toggle button is displayed on the top left corner of the plot. Click the button to toggle between the zoomed and unzoomed view of the plot.

	DNA cell cycle plots
	Red: Denotes the G0/G1 phase,
	Blue Markers are debris markers allowing to set noise thresholds and to exclude cellular debris. Events that occur below or above these noise markers will be presented on the plot, but not analysed by the software.


	12.8.2 Results tab of the Workspace
	Results table rows and columns
	DNA statistics for non-cell cycle regions,
	Reordering columns:To reorder the columns, drag and drop their headers.

	Selecting table rows
	Click on a results row to select it.

	Grouping results by column headers
	To group by a column and remove the column from the results table, drag the desired column header into the grey field.


	12.8.3 Overlays tab of the Workspace
	The Overlays area displays a 2D or 3D view of available overlay plots.
	Creating overlay plots
	To add the plots to a new overlay plot, select "New". An overlay plot cannot contain both single and dual parameter plots. If you have selected both types of plot, a new overlay plot will be created for each type.

	Plot views
	Selecting plots
	To select a single plot within the Overlays area or Galleries area, click on the plot.

	Reordering plots
	Resizing plots in the Overlays or Galleries area
	Editing plot titles, legend and axis labels
	Plot title: Each overlay plot has a plot title which defaults to the overlay number, e.g. "Overlay 1". To change a plot title, double-click on the current plot title and enter a custom plot title into the edit field. Gallery plot titles can be edited...

	Regions on overlay plots
	Sending plots to the report
	Using control plots
	Set as Control Plot is available when a single gallery plot is selected. Select the option to display the plot as a control on all gallery plots of the current overlay plot. The gallery plot set as a control displays a dashed border.

	Moving and copying plots from the Galleries area to an overlay plot
	Move selected Plot(s) to Overlay Plot moves the currently selected plots to a new selected overlay plot. If all of the selected plots already exist in an overlay plot, that overlay plot is greyed out in the list. If some of the selected plots already...


	12.8.4 Reports tab of the Workspace
	plots,
	Inserting objects into a report
	From the Insert group of the Report tab of the Ribbon, click the desired button to display a drop-down list and select the desired object.

	Selecting objects on the report page
	To select a single object, click on it.

	Moving objects
	Resizing objects
	Moving the cursor over one of the handles will change the cursor to a double-headed arrow indicating which way the object will be resized.
	Moving the cursor over either handle will change the cursor to a crosshair, indicating the handle can be moved in any direction.

	Resizing headers and footers
	Editing inserted text
	Deleting objects
	Using the report context menu


	12.9 Status bar
	Calculation indicator
	When all items are up to date, a green icon is displayed.

	Miscellaneous messages
	Ribbon controls: For each Ribbon control, a status bar message is displayed describing the function of the control.

	Status of acquisition
	Part displays the absolute number of particles recorded.

	Fluid level indicators
	Sample level: The icon is green when the sample is full or low. The icon is red if there is no sample tube attached or the sample is below both electrodes. Hover over the icon to display a corresponding tooltip on the sample level.

	Status of the device
	Green: The device is operational.

	Status of compensation settings
	Resize options
	Resize Plots (enabled in the Plots tab of the Workspace),


	12.10 CyFlow Options
	General page
	Statistic Decimal Places: This control allows you to set the number of decimal places to which the statistics displayed on the plots and results table are rounded. The default is 2 decimal places. To edit, enter a value or use the up/down arrows to s...

	Region page
	Scaling page
	Log Decades: The value set here determines the number of decades shown when logarithmic data is displayed and is used for scaling all relevant plots and statistics. Click the arrow to display a drop-down list and select the desired value (4 decades, ...

	Export page
	Result Export Format: Select the "Single row per file, result types are grouped together" option to display all the results from the results table, grouped together and exported in a single line. If multiple files are exported, a new line is created ...

	Instrument Configuration page
	ICF: The ICF (instrument capabilities file) drop-down list contains the title tag from each of the ICF’s held in the InstrumentConfigurations.xml file in addition to the default configuration option which appears at the top of the list. Select an I...

	Font pages
	Font - Region Labels to select the font typeface and size for region labels in plots and overlays.
	Reset to Default: Click the button to reset the font typeface to its default setting, which is Arial.

	Resources page
	License: Click the button to access the license information and update your user license.
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